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Related documentation

The following Syntech documentation contains information to which you may need to
refer:

® [FuelMaster Installation Guide
® Sjte Operations Manual

® A/M Installation and Site Operations Manuals

Conventions used in this guide

A Glossary of terms and acronyms are also included.

To help you find important information, this guide uses the following conventions:

This convention Indicates

Bold text The names of elements of the user interface, such as menus,
buttons, and options

[talic text Code, file name, directory paths, and on-screen computer
output.

NOTE Notes that contain additional explanation.

Information related to when you should call the Syntech

Customer Satisfaction Center (CSC).

About the User Manual

This manual provides information and instructions for the FMPIlus application that is
used to create, configure, and view system generated data.

Audience

The FMPIlus User Manual is directed at those personnel that are granted system access
for the purpose of performing system functions.
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Certifications

Certifications have been awarded by the following organizations.

US and Canadian equipment certifications through the following:
o FCC (Federal Communications Commission),
o Intertek (ETL, cETL),
o CAN/CSA (Canadian Standards Association),

o National Conference on Weights and Measures (National Type Evaluation
Program: NTEP),

o Payment Card Industry (PCI) Security Standards Council (PA-DSS
compliance),

European equipment certification through the following:
o TUV SUD, FM Approvals
o ATEC Certification

Microsoft Gold Partner

Recommended PC or Server Requirements

Intel Core i3 Processor or greater
4GB of RAM
DVD-ROM

12GB free Hard Drive space - Additional space required if running full MS SQL
Server for large databases.

56K Baud Analog Modem
1024x768 Screen Resolution
Network Connection

USB for Key Encoding, if needed
Solid State Drive (S§5D)

Supported OSes

Windows 10 64-bit
Windows Server 2008/R2 64-bit
Windows Server 2016 64-bit

Microsoft versions above these listed will also be supported.

1/8/2024 © Syntech Systems, Inc. 2014-2024 12



Minimum PC Requirements
® 3.0 GHz Pentium 4 Processor 64-bit

2GB of RAM for 64-bit

12x CD-ROM

6 GB free Hard Drive space

33.6K Baud Analog Modem or Network Internet Connection
1024x768 Screen Resolution

USB for Key Encoding if needed

Windows 10 64-bit

NOTE FMPIlus is not compatible with Microsoft HOME editions or Windows 10
or 11 running in S-mode.
1/8/2024 © Syntech Systems, Inc. 2014-2024 13
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Chapter 1 Introduction

About FuelMaster Plus (FMPIlus)

FMPIlus is a fuel management system comprised of a software application and
subsystems, which cooperate for data entry, collection, display, and reporting of
system generated fueling/inventory transactions and vehicle telematics.

FMPIlus software collects data produced by the following:

» Fuel Management Units (FMUs)

» Remote Data Collection Units (RDCUSs)
» Automotive Information Modules (AIMs)
» Tank Monitoring Units (TMUs)

System generated data is captured and stored in the software, providing users with
system status, a view of fuel inventories, transactions and vehicle telematics.

System Components

Central Controller

The term Central Controller denotes two things in this manual. First, the Central
Controller can refer to an individual who manages FMPlus and equipment. Second,
the term can be used for any computer that executes FMPlus.

FMU

The Fuel Management Unit (FMU) is the FuelMaster system that controls fueling at
the fuel island dispenser(s). The FMU controls access to the fuel records. This data is
then downloaded by the Central Controller software where it is used for accounting
or fleet management purposes.

TMU

A Tank Monitor Unit (TMU) is used to record the status of fuel tanks. The FMU can
interact with the TMU for generating Tank Reports; the FMU can only read
information from the TMU. TMUs are third party devices that FuelMaster can interact
with for report generation only. Examples are Veeder-Root, Pneumercator, Ronan,
and Red Jacket.

1/8/2024 © Syntech Systems, Inc. 2014-2024 14
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Access Devices

FuelMaster has several types of devices that allow the user to gain access to the fuel
via the FMU.

Prokee

The Prokee is a proprietary, electronic, programmable chip embedded in a hard-
plastic casing.

Smart Card

The Smart Card is the size of a credit card with a smart chip embedded on the back.
It works essentially the same as a Prokee but uses different readers on the FMU and
Central Controller.

AIM

The Automotive Information Module (AIM) is used to authorize fueling without
requiring user interaction with the FMU (passive fueling) and interfaces with the OBD
[l port on the vehicle accessing readable information from the vehicle’s computer.
This allows information to be recorded by the FMU from the vehicle such as vehicle
ID, odometer, current mileage, date, time, fuel quantity, fuel type, engine hours, PTO
hours and much more.

Credit Card

Retail customers can provide credit card processing capability at the FMU. Multiple
credit card networks are supported; for a full list of credit card networks and to
determine which best fits your needs, contact your sales representative directly or
sales/marketing through corporate headquarters at (800) 888-9136.

Proximity Card

HID Thinline Il Proximity Reader can be interfaced with the FMU. Wiegand format
Proximity Cards cannot be purchased from FuelMaster but can interface with the
system to acknowledge input as a User ID. The proximity card is only compatible
with VMN and Keyless Systems.

1/8/2024 © Syntech Systems, Inc. 2014-2024 15
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Communication Options

There are two methods of communication to use for daily operations; analog modem
and network card or on-board LAN.

Analog Modem

The analog phone method requires a dedicated analog phone line wired to the FMU
and a modem for the Central Controller. Serial USRobotics® external modems, or
MultiTech® external modems, are recommended for use with FuelMaster Systems.
There are a variety of ways to implement this feature including wireless phone line
extenders and phone line simulators.

Network Connection

The network option uses existing network infrastructure for communication between
the Central Controller and FMU. This option requires that CAT-5 cable be run to the
FMU no longer than 150 ft. from the nearest switch/router for best connectivity. The
Central Controller also needs to be on the same network infrastructure.

System Types

Verified Miscellaneous Number (VMN)

VMN systems have a Prokee or Smart Card encoded with a Vehicle ID to access
fueling and require verified User ID keypad entry prior to authorization.

Verified Vehicle ID (VVI)

VVI systems encode the User ID on the Prokee or Smart Card and require a verified
Vehicle ID keypad entry prior to authorization.

Commercial Vehicle Key Only (VKO)

VKO systems require an encoded Vehicle Key followed by User ID keypad entry. The
difference between this and VMN is that the User ID is not verified and can be
alphanumeric.

Commercial User Key Only (UKO)

UKO systems require an encoded User Key followed by Vehicle ID keypad entry. The
difference between this and VVI is that the Vehicle ID is not verified and can be
alphanumeric.

1/8/2024 © Syntech Systems, Inc. 2014-2024 16
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Commercial Either Key (EK)

EK system allows for the encoding and use of either Vehicle or User keys depending
on fueler needs. The system prompts for a User ID if a Vehicle key is inserted and a
Vehicle ID if a User key is inserted. Neither IDs entered at the keypad are verified and
can therefore be alphanumeric.

Commercial Both Key (2K)

2K systems behave like the VMN/VVI systems with one exception; the fueler is not
prompted for a User or Vehicle ID and must use a second key before authorization
will take place. The fueler uses this system by inserting their Vehicle key and then
inserting a User key, or vice versa. Both are required for authorization.

Keyless (Keyless)

Keyless does not require keys and supports alphanumeric values for IDs. The Vehicle
and User IDs are prompted and entered on the keypad. The Keyless system can be
setup multiple ways and needs to be configured by a Syntech Field Service
Representative, Syntech CSC Technician, or a Syntech Authorized Service
Representative.

Over the Road (OTR)

OTR systems allow for the recording of fuel for refrigerated trailers. OTR is based on
the VMN system but has the option for a reefer identifier to be recorded while only
using one Vehicle key. The fueler enters the key, is prompted to enter a User ID, then
prompted “ARE YOU FUELING A REEFER” (Y/N). If the user enters 'Yes’, they are
prompted for the Reefer ID. The transaction is recorded for the trailer, not the
Vehicle, and the reefer ID is verified. If the user enters ‘No’, the Vehicle transaction
progresses normally. The Reefer IDs are created and stored in the Vehicle List.

1/8/2024 © Syntech Systems, Inc. 2014-2024 17
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Chapter 2 Getting Started

Initial Startup

Before starting up FMPIlus, determine your System Type; see Systems Types in Chapter
1. To begin the software launch, double click the FMPIlus icon located on the desktop.

.
FuelMaster
Plus

If a database exists, acknowledge the need to take a backup by selecting OK.

Fuelmaster® Plus X

Last backup was taken more than 7 days ago, it is
! recommended that you take another backup.

If no database exists, click on Create New Database. The database screen will open.

iﬁﬁ Fuelmaster® Plus Database b4
Fuelmaster® Plus Current Database Name Doesn't Exist!

Do you want to create a new Fuelmaster Plus database or use an existing database?

| Create New Database | Use Existing Database |

A MS SQL database can be created with SQL Auth (recommended) or Windows Auth.
Click on Create Database.

'Eﬁ Fuelmaster Database X

Fuelmaster® Plus DB Entry Name:* | |

Fuelmaster Plus DB Type - (* M5 s50L

Fuelmaster® Plus DB Path: | Browse...

SQL Server Name: |

" Windows Auth * s0L Auth

SQL Server Login: |

SQL Server Password: |

Entry Comment: |

1/8/2024 © Syntech Systems, Inc. 2014-2024 18
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See Creating a New or Using an Existing SQL Database for FuelMaster in the
FuelMaster Installation Guide for further instructions.

Fuelmaster® Plus X

Last backup was taken more than 7 days ago, it is
' \  recommended that you take another backup.

At the end of the database creation, the logon screen launches with the default Admin
user. Click OK. The software prompts the user to set a password for the Admin

account.

Welcome to Syn-Tech Systems Fuelmaster® Plus ? pod

<+
S EUELMASTER

EMGIMNEERED BY EJ cech

Login Fuelmaster® Pluz Databaze Mame: OHDOT
Operatar Mame: |.-'1'-.DMIN j

Pazzword: |

ok | Cancel | Switch... |

Copyright & 1997-2021 by Syn-Tech Spstems, Inc.
Thiz computer program iz protected by .5, and International copyright law.

Logging into FMPlus for the first time

When logging into the application for the first time and/or after a password
reset/expiration, create a new password; click OK. When the password change screen
appears, enter and confirm the new password; click OK.

Remember the password as it will be needed each time for logging into
FMPIlus.

NOTE

1/8/2024 © Syntech Systems, Inc. 2014-2024

19



FMPIlus User Manual Chapter 2 Getting Started
Document Version: 9.0

Fuelmaster® Plus w Legin Mame: ADMIMZ

(B Please enter the NEW password here:
EIEI

(= |

>
Cancel

l . You must change your password to continue.

Please confirm the NEW password here:

Creating a Password

® Password requirements and restrictions are defined in Security Configuration.
See Chapter 13.

3

® The following special characters are not allowed in passwords: < > * : ;

1/8/2024 © Syntech Systems, Inc. 2014-2024 20
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Select System Type

Select the System Type. See System Types in Chapter 1.

Select Systemn Type x
% Select Spstem Type, Key Configuration and Category
b2
EEL Systern Type:  |KEYLES Kep Configuation: [VEHICLE KEY

Category: ||#a]y]= ~

(].4 | Cancel ‘

The Category option allows aviation sites to have Vehicle verbiage replaced with
Aircraft verbiage.

After completing the System Type, choose a Passive System Type, if applicable. The
Passive System types are NONE or AIM. If AIMs are not being used, select NONE; click
OK.

Selg Passive System Type x
R,
E@ Sps
MOME if you are not using AIM devices.

OO - o< | cence |

Ok 1 Cancel |

Choose AIM if you are using AIM devices or choose EY :I
-

NOTE You may change the Passive System Type option later from the System >
Configuration > System tab.

Next, enter the Site Signature, a key that uniquely identifies and distinguishes one
FuelMaster customer from another. The Site Signature Key is a twelve-digit string that
can be found on the packing slip.

Enter the key into the field, including hyphens or dashes; click OK.

Change Site Signature >

,

B

i
L5

=
=
oo

Enter Site Signature Key:

o]

Cancel
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Select a folder for saving downloads and log files. Any users running the Central
Controller and the user Download Service “runs as” must have access to the location
selected. Browse to a network location, and select a Shared folder, or enter a UNC
path to the Shared folder. Click OK.

Specify Download Folder X

Select Folder
Choose folder for saving downloaded files and log files

| | Browse

The last screen before the software window is the Download Service. If the Central
Controller will run an FM Download Service, select Yes.

Download Service Is Mot Running

*

FM Download Service is not running,  Would you like to try starting it now? Yes

E

[~ Newver ask me again

Report Configuration

The Crystal Reports in FMPlus require ODBC connectivity to SQL Server. To run
the Crystal Reports provided with FMPlus, an ODBC Data Source Name (DSN)
configured to connect to the FMPIlus database must be created on each
machine running FMPIlus. The DSN must also be set correctly for each
corresponding entry in FMPlus > System > Database Manager. See ODBC
Connections for Reports.

Encoder Driver Installation

Prokees and Smart Cards require the encoder drivers be installed on the
Central Controller machines. The drivers are included in \\Program Files
(x86)\Syntech\FuelMaster\USB Encoder Install Disk.
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Insert the USB connector from the ARM7 USB Prokee Encoder into a USB port
on the Central Controller. Open Device Manager and locate SYNTECH EN-PR

200.

=4 Device Manager
File  Action View Help

= | m HmElE

~ = ENG_TEST26
4 Audic inputs and outputs
[ Computer
e Disk drives
@ Display adapters
- DVD/CD-ROM drives
5’?‘1 Human Intefface Devices
g |DE ATA/ATAPI controllers
&2 Keyboards
ﬂ Mice and other pointing devices
=1 Monitors
& Network adapters
v 5 Other devices
i SYN-TECHEN-PR 200
= Print queues
D Processors
2% Security devices
| Software devices
% Sound, video and game controllers
<, Storage controllers
[ System devices
¢ Universal Serial Bus controllers

Double-click to open the device Properties. Select update drivers; then select
Browse my computer for driver software. Browse to the FuelMaster directory

and highlight USB Encoder Install Disk.

Select the folder that contains drivers for your hardware.

InstallScripts ~

RefDatabase

Reports

SglSeripts

SSRS

v USB Encoder Install Disk

amuded
i386

Folder: UUSE Encoder Install Disk

Carce

Browse For Folder *
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With Include subfolders checked, click Next.

Chapter 2 Getting Started

«

[l Update Driver Software - SYN-TECH EN-PR 200

Browse for driver software on your computer

Search for driver software in this location:

gram Files (x86)\5ynTech\FuelMasterPlus\USE Encoder Install Disk e

] Include subfolders

—» Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver

software in the same category as the device.

Click Install to trust software from Syntech Systems, Inc. When the drivers are
successfully installed, they appear in Device Manager under Universal Serial

Bus Controllers.

s Device Manager

File  Action View Help

= @B HE

8| @ o 05

@ Display adapters
L DVD/CD-ROM drives
E’ﬁ Hurman Interface Devices
g |DE ATA/ATAPI controllers
& Keyboards
ﬂ Mice and other pointing devices
1 Monitors
3 Network adapters
™ Print queues
D Processors
42 Security devices
[l Software devices
% Sound, video and game controllers
< Storage controllers
[ System devices
~ § Universal Serial Bus controllers
§ Generic USE Hub
i Generic USB Hub
Intel(R) 8 Series/C220 Series USB EHCI #1 - 8C26
Intel(R) 8 Series/C220 Series USE EHCI #2 - 3C2D

USE Root Hub
USE Root Hub
USE Root Hub (xHCI)

)
)
§
i Syn-Tech Prokee® Encoder V2
§
§
L)

Intel(R) USE 3.0 eXtensible Host Controller - 1.0 (Microsoft)
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Chapter 3 System Configuration

FuelMaster is designed to meet a large range of end user requirements and
configuration possibilities. These options are all based upon a foundation of options
and configuration settings that need to be established before proceeding. Some of the
options can be easily changed later; others will require you to contact the Syntech
Systems, Inc.’s CSC for further assistance.

System Configuration

Access the System Configuration option by selecting Config on the toolbar. This
option can also be found under System > Configuration or by the hot key combination
CTRL + G.

=» £ B & & W | 33 G BO?7

Vehicle User Site Truck Super Cust Online  Prokee Config Consale About Exit

Info Tab

The first tab of the Configuration window is the Central Controller information. Enter
information about your company. This information is included in reports and invoices
and appears as contact information.

Hi Configuration =] e
Info | System | Hardware | Encoder | DL Service | Fimware | AIM |
Comparny info
Name: |STS TESTING Cancel
Address1: [100 FOUR POINTS WAY

Address2: ||
City, State, Zip: | TALLAHASSEE FL 32311

Status Logging Level
= Al

" Debug

* Info

" BEmor
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The Status Logger lists the system tasks as they occur. The Status Logging Level on the
Configuration window allows you to select the level to which you want system tasks to be

recorded.

System Tab

Chapter 3 System Configuration

5 Status Logger

Select Sites To Filter | 7] Seject Al ~ ‘ oW %

Timestamp

12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM
12/15/2022 2:06:00 PM

Site Id

ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHANM
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHANM
ENG-DEVSHANM
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHAN
ENG-DEVSHANM
ENG-DEVSHANM

Status

Entering CFMDownloadServiceApp::SetDatabase()
CFMDownloadServiceApp::SetDatabase() - Reading DB Path from con
CFMDownloadServiceApp::SetDatabase() - Setting up service logger
Entering CFMDownloadServiceApp::CreateServiceLogger()

Local Time: 12/15/2022 14:06:04 Server Time: 12/15/2022 14:06:0!
Server offset time is: 0 days, 0 hours, 0 minutes, 1 seconds

Service starting on ENG-DEVSHANE

Exiting CFMDownloadServiceApp: :CreateServiceLogger()

Exiting CFMDownloadServiceApp: :SetDatabase()
CFMDownloadServiceApp:: CanGetDownloadInformation() - Creating €
CFMDownloadServiceApp:: CanGetDownloadInformation() - Getting D«
Exiting CFMDownloadServiceApp: :CanGetDownloadInformation()
CFMDownloadServiceApp::InitializeService() - Setting up CFieldTableC
CFMDownloadServiceApp::InitializeService() - Setting up CCSynRPCD.
CFMDownloadServiceApp::InitializeService() - Setting up CSynRPCMe.
CFMBaseThread: :SetDatabase() successful

CFMBaseThread: :SetDatabase() successful

Entering CFMWorkerThread: :Run()

Entering CFMCancelThread: :Run()

Master eal73f59-03a8-4013-8¢5f-fc159c3de336 is not alive

The System tab is used to configure various system options.

Eﬁ} Configuration

=)o e

Info  System |Hardware| Encoder| DL Servicel Flrmware] Archive] AlM I

Misc 1: | QES

Vehicle Prokee Options Defautts

Mee? W
Misc 3: |Misc3—
Misc 4: W
Misc 5: lMiscSi

System Key Information:

VEHICLE KEY 'I

System Type: |KEYLESS

Allow transaction export [V

Require Customer ID

Allow TMU Deliveries
Allow TMU Quantities

¥ Added

v

W Retry Transaction Fies |2 (1-10) Times.

Use old method for transaction list W

Patch List Timeout |90 (10-1000) Sec.

Odometer W UserlD ~ Cancel |
PIN ™ Receipt [
User Prokee Options Defaults
r elD ™
N r i r
7 Digit Odometer Passive Sys Type

Enabled [ AlM -

Comm timeout |5 (0-6) Sec.

Remote Start Price Level |1 VI

Misc Fields 1-5

The miscellaneous fields are used to provide extra levels of reporting for Prokee/Smart

Card or AIM fueling (e.g,, to track the vehicles that fuel by VIN#, set miscellaneous 1
field as VIN# and enter each individual VIN# in the Vehicle Record; you may then run

reports based on those VIN#’s).

1/8/2024
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System Key Information & System Type

The System Key Information and System Type display the options selected when you
first setup FMPIlus. To read about system types, see System Types in Chapter 1. The
example in Chapter 3 shows a Keyless system where the System Key Information is
Vehicle Key. This setting controls whether Vehicle Option Defaults or User Option
Defaults are active.

Vehicle and User Prokee Option Defaults for Global Configuration

Options checked here will prepopulate the vehicle or user record options when adding
new ones.

® Odometer requires an odometer reading keypad entry upon fueling.

® PIN (Prokee Internal Number) option requires PIN keypad entry upon fueling.
The Prokee Internal Number cannot be modified; this number is hard coded on
each key.

® Receipt prompts the user/customer if they would like a receipt at the FMU.

® Vehicle/User ID requires a Vehicle/User ID keypad entry before fueling; this
option may be modified depending on the System Type.

7 Digit Odometer

Requires user/customer to enter 7-digit odometers at the FMU. This option is not
reversible, so choose with care.

Passive System Type

If you are using AIM units for fueling, select AIM in the dropdown list. If not, select
NONE.

Patch List Timeout

Configures the amount of time the software waits for the FMU to apply a patch or list.
Time is entered in seconds and defaults to 90. If the customer has small lists,
downloads can be sped up potentially with a smaller value. For large lists, the timeout
can be increased to give the FMU enough time to finish (should only be done with a
CSC tech helping).

Added Comm Timeout

Configures the amount of time the software adds for SW and FMU communications.
This feature supports Satellite Cellular Modems, most often used with Passive Mobile
Units, but impacts all communication timeouts. See Communication Timeout.

Allow transaction export

Determines whether the system allows transaction exports.

NOTE Transactions will be copied to ExportTrans. this takes up disk space, so enable
it only if you intend to export.
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Require Customer ID

Prompts users/customers for their Customer ID. It also ties Customer ID to the
Vehicle/User records.

Allow TMU Deliveries

If checked and the FMU is connected to your TMU, the FMU updates the inventory
maintained by FMPlus when a delivery is made or stick reading reveals inventory is
required.

Allow TMU Quantities

If checked and the FMU is connected to your TMU, the FMU adds TMU quantities to
the inventory maintained by FMPlus.

Retry Transaction Files

When enabled, the Central Controller can retry downloading transaction files from the
FMU multiple times in the same online session.

Use Old Method for Transactions List

If checked, the method utilizing NLST obtains the list of transaction files to download.
If not checked (default), the method utilized by the FMU Diagnostics obtains the file
list.

TIP Upon upgrade to FMPlus 5.33.3.0, users will rely on a new method of obtaining
the list of transaction files for download. If this method breaks down after
upgrading, we recommend selecting the Use Old Method for Transactions
List.

Remote Start Price Level

In special cases (e.g., when a User has lost their key), the selected option determines
the price level of a transaction started through the FMU Console.

Hardware Tab

To access the hardware configuration options for your modem, select the Hardware
tab from the configuration interface. If your system uses a Network option for
communicating with the FMU, please skip to Reconnect on Failure option. These
settings are global for all sites created in your software. To restrict baud rate per site,
call the Syntech Systems, Inc.’s CSC at 1-800-888-9136 ext. 2.

1/8/2024 © Syntech Systems, Inc. 2014-2024 28



FMPlus User Manual Chapter 3 System Configuration
Document Version: 9.0

& Configuration = @
Info | System Hardware | Encoder | DL Service | Firmware | AIM |

Modem 0K
Select Modem: -

Cancel
Comm. Port: [ Override Comm. Port
Baud Rate 19200 ~ | [ Use My Own Initialization String

Additional Setup String |
Dial Time Out 40 (30-255 Sec) - Wait for Tone

Default Modem 10 (2-20 Sec) C Yes @ No

[ Disable Modem Reset During Initialization

Dial Method
@ Tone ( Pulse

[v" Reconnect on Failure

Number of 1 * | times

Between tries wait 10 w | seconds

Modem Options

Syntech recommends US Robotics® external full duplex modems for all FuelMaster
systems.

The FM Download Service reads the configuration settings before every connection,
not just at startup. When the modem field is populated, the SW dynamically finds the
COM port before each connection. When Override Comm. Port is checked, the modem
field is blanked and greyed out and FMPIlus exclusively uses the Comm Port as set.

Set up Modem
1. Select your modem from the dropdown unless using the Override.

2. Ensure CSC sets the Baud Rate; they will typically start at 19200 and change to
a lower baud rate if connection problems occur.

3. Unless directed by the Syntech Systems, Inc.’s CSC, leave the Additional Setup
String blank, and the Use My Own Initialization String check box to the right
unchecked.

4. Set the Dial Timeout to the appropriate length (it will need to be longer if
dialing through a switch or accessing an outside line.)

5. Set the Default Modem Timeout to the appropriate length.
Wait for Tone Option

Select whether you want the modem to wait on tone to dial. The most common setting
is Yes.

Dial Method Options
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If your phone system is pulse, select Pulse. Otherwise leave it as Tone.

Reconnect on Failure Options

Chapter 3 System Configuration

Set the number of times you want the system to redial and the amount of time to wait

between each att

Encoder Tab

empt.

Select Prokee or Smart Cards in Encoder Type.

If the encoder drivers have not been installed, see Chapter 2 Getting Started.

ﬁ Configuration

=0 =

Info | System | Hardware

Encoder Type
@ Proked

" Smart Card

Encoder | DL Service | Firmware | AIM |

ok
Cancel

1/8/2024
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DL Service Tab

The FM Download Services have several configuration options. This tab also allows the
Download path to be reset and defines the location to save the Data Logger files.

NOTE Stop the Download Service before changing the Download Path. Download
Path Options may also be reset from the System > Reset Download Path
menu.

& Configuration =] @ ﬂ

Info | System| Hardware | Encoder DL Senice |Fimware| AIM |
[ o |

Cancel

Always start FM Download Service when loading FuelMaster [
Display autodownload polling report on this computer |

Force starting Download Service as normal .exe | |

Download Path Options

Browse [\\ENG_TESTZG\FMP Downloads

Data Logger Options

Save Data Logger Files To

Folder: |C:\ProgramData\Syntech\FuelMasterPlus\downloadFiles

Browse.

Always start FM Download Service when loading FuelMaster
If not running, start the FM Download Service when launching FMPlus.
Display autodownloaded polling report on this computer

Check this option to display the Polling Report on this Central Controller for Auto
Downloads.

Force starting Download Service as a normal.exe

If selected, this option runs the FM Download Service as an executable. In most
circumstances, it should run as a service. Only select this option if advised to do so by
Syntech Systems, Inc.’s CSC.

Start .exe now / Stop .exe now

These buttons are only enabled when the FM Download Service is running as an
executable. Click to start or stop the Download Service.

Download Path Options

When resetting the Download Path, the FM Download Service must be stopped.
Browse to select the new location. Restart the FM Download Service when set.
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Data Logger Options

Browse to specify the location to save Data Logger files.

Firmware Tab

In support of automated FMU upgrades, the Firmware version can be selected and set
on the Firmware tab.

Once set, the FMU FW image name displays by the Choose Image button. Having the
image on the FMU when the automatic upgrade begins decreases the total upgrade
time. Contact Syntech Systems, Inc.’s CSC for more information or to request an
automatic upgrade.

AIM Firmware images may also be selected for upload.

%Configuration | = ‘ &) ﬂ

Info | System | Hardware | Encoder | DL Service Firmware [AIM |

FMU Firmware Image

FUELMASTER FMU2500+ v4.07 (10/29/19) ﬂ‘

Maximum number sites to upload image per online session 0

0

AIM Firmware Images

AlM 2: I . Choose Image _ | notsst

AIM 2.4: | Choose Image ‘ not set

AIM Titanium: | Choose Image ‘ not set
Maximum number sites to upload image per online session 0

Enter the number of sites to update in each online session for FMU FW and AIM FW as
applicable.
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Archive Tab

The Archive tab allows the Central Controller to configure settings related to the
archival process.

Hal Configuration EI = @

Info ] System] Hardware] Encoder] DL Service | Fimware Archive ]AIM ]

oK
_Coreel |

Cancel

Backup Reminder 7 A

Enable Archiving

When enabled, Operators will be able to archive records in the database. Upon login, a
warning may appear reminding them to archive records located in the database.

Disable Archive Warning

If Operators do not desire to see the Archive Warning, they may disable it above or
when it appears during the login process by selecting Never ask me again. If disabled
by mistake during the login process, a Central Controller may reactivate the option on
the Archive tab as shown above.

Create Archive Database pod

Would you like to create the archive database now?

[ Mever ask me again

Upon confirming the desire to create an archive database, Operators that do not have
permission, will see the following dialog message, “The system needs to create the
archive database but doesn’t have permission. Please run the application as a user that
has CREATE ANY DATABASE permission.”
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Fuelmaster® Plus X

The system needs to create the archive database, but doesn't
have permission. Please run the application as a user that
b has CREATE ANY DATABASE permission.

Backup Reminder

Upon login, Operators are reminded to backup their database as often as the number
of days is specified in the Backup Reminder dropdown box. Operators can configure
the backup reminder’s number of days to be Never, 7 days, or 30 days. Operators may
click the Open DB Maintenance button to be taken to the DB Maintenance screen to
execute a database backup. Operators may click the Change Reminder button to
change the number of days configured for the Backup Reminder.

Database Backup Reminder

ast backup was taken more than 7 days ago, it is recommended that you take another badkup.

i Open DB Maintenance Change Reminder Close
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AIM Tab

AIM Option Defaults are set in FMPlus and sent via the AIM Programming List to
update the AlMs. Select the options desired. See Appendix C - SW Confiquration for
AIM Options.

EConﬁgutation | = ‘ =] ﬁ

Info | System | Hardware | Encoder | DL Service | Firmware AIM

Require U ) [ Disable Timeouts Errar
[ Fuel With Engine On [~ Enable FOIOS
[~ Use Metric Units
[ Enable Analog Counter

[ Enable FOSS
[ Disable SVT

[~ Print Receipt
[v" Mandatory AIM Completed List Download
[v" Retrieve AIM Vehicle Interface Info Log during online session

[v" Retrieve OBD Data Logs during online session

Mandatory AIM Completed List Download

Downloads the AIM Completed List for every online session. This option should always
be selected.

Retrieve AIM Vehicle Interface Info Log during online session

Downloads the AIM Vehicle Interface Info Log for every online session even when
Download OBD Data Logs is not selected in the Online Client.

Retrieve OBD Logs during online session

Downloads the OBD logs for every online session. Uncheck if OBD logs are not desired.
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Chapter 4 Products and Pricing

Products and pricing are central to the function of the FuelMaster system.
Prokees/Smart Cards are only allowed to get products they are authorized to
dispense. This configuration is especially critical for credit card systems since pricing
is finalized when the transaction completes.

Products
To access the Products List, select the Products option from the Tables menu.

Use this feature to setup products and modify pricing as needed. This is also where
pricing adjustments are applied.

NOTE All prices must be uploaded to the FMU before they will have any effect on
transaction pricing.

Tables Operations System Reports

= \ehicle... Ctrl+F5
£ User... Ctrl+F6
B Site... Ctrl+F7
@ Tanker Truck... Ctrl+F9
& Supervisor...
Manual Issue...
¥ Customer... Ctrl+F8
Products...

AIM Programmer...
Agency...
Department...

Organization...
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Pre-Programmed Products

Chapter 4 Products and Pricing

The FMPlus database comes preprogrammed with three products: Unleaded, Diesel,

and OilCheck.

' &
ﬁ Product List

Product(s) \

Product ID

Description

Max Prod Allot

1

Unleaded

100

2

Diesel

100

63

OilCheck

18

Add

Close

dii

If you have these products, double click on the product, or highlight a product and

click Open, to modify as desired. If not, you may highlight the product and click the
Delete button to remove it from the Products List.

NOTE Product 63, OilCheck, is used with FMU oil check transactions and, as such,
should not be deleted.

Creating/Editing a Product

To create a new product, click the Add button from the Product List. This displays
the product configuration interface. To edit, double click the Product or highlight it

and choose Open.

01/08/2024
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For a new product the Product field is defaulted to one number higher than the

highest existing Product ID.

Chapter 4 Products and Pricing

@ Product ID 64 - () [NEW]

r=r] O

AT = e Lev?ﬂltdjustmenf Total
Description: | Level 1 ‘0 [SO-U
Max. Prod Allot: | 100 Level 2 |0 ‘
Units: [+ =1 Level 3 ‘U {
Base Cost:  §|0 Level 4 |0 {
Trans. Limit: [50 Level 5 |0 |

Map To Level 6 |0 [
Unknown 2| vl 7 |U ‘

Level 8 [0 [
ok | : | Cancel |

Description

Used in the Product List and will be listed in the Tank ID Product dropdown when
setting up your Site(s).

Maximum Product Allotment

Sets the global amount for Vehicle/User/Tanker Truck authorized Products. An
exception appears on the Polling Report if the product is dispensed over the daily
allotment. This does not lock users out from fueling over the daily limit; it is for

monitoring and reporting purposes only.

& Product ID 64 - () [NEW]

=] e

Product: | 64

Description:

‘ Dyed Diesel

Max. Prod Allot: | 100

Units: [*"‘*

Base Cost: $| 3.09

Price Level
Adjustmen ~ Total
Level 1 [-10 [$3-1900
Level 2 [~10  [$2.9900
| Level3 Im% [53.3990

Level 4 I -10% | $2.7810

Trans. Limit: |50 evels |0 |53.0900
Map To Level 6 |0 [$3.0900
|Off-Road Diesel | e |0 | %3.0000
Level 8 I a ’ $3.0900

OK ‘ ’m Cancel ‘

Base Cost
01/08/2024
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Purchase price of the fuel per gallon, before any adjustments.

Transaction Limit

Set this limit to the maximum capacity of the largest tank in your fleet for this
product. When you add a new vehicle record, the Transaction Limit in that record
cannot exceed this amount.

Map To

Used for credit card customers only and is used to correlate the FuelMaster’s product
code to the code that needs to be sent to the credit card network for processing. As
shown above, your company may view the product as Dyed Diesel, but the credit
card network views the product as Off-Road Diesel.

Price Level

There are eight levels of pricing that can be applied for discounts/markups. These
levels adjust the total unit costs using a calculation from the Base Cost and
Adjustment fields.

NOTE Prices are calculated and attached to Prokee/Smart Card transactions after
the transactions are downloaded from the FMU into FMPlus.

Adjustments

The Adjustment field is a factor in the Total price per gallon. The field can containa O
if no modification to the Total price per gallon is required, and can use
positive/negative currency or a positive/negative percentage. For example, a retailer
wanting a $0.10 markup would enter .10 as shown above; this will ensure that all
Level 1 users will pay 10 cents per unit above cost. Any combination of the base cost
and adjustments can be used to meet your needs. All prices must be sent to the FMU
before they can be used.
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Chapter 5 Site Configuration

At the core of the FuelMaster system is the FuelMaster FMU, located on the fueling
island and used to control and provide access to fuel. Each master FMU can control
up to eight satellite FMU's. Each instance of a master FMU and its satellites (if any) is
referred to as a Site.

Sites using credit card networks must have a dedicated line (phone or network) per
FMU and can only use master FMUs.

Each Site is correlated to a set of configuration data in FMPlus and is managed as
one group.

Access the Site List by clicking on the Site icon on the FMPIlus toolbar, from the
Tables > Site menu, or hot keys CTRL + F7.

The Site List displays the Site(s) ID, Name and Type. Each site can be accessed by
double-clicking the Site name or by highlighting and clicking Open.

To create a new site, click Add.

[ site List B [
Site(s) |
ID | Fuel Site Name Type Add
0001 [Main Depot Fixed-LAN ]

Close

i
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Site Configuration

Site information

Chapter 5 Site Configuration

Contains Site ID, Name and contact information for the physical site location. Site ID
and FMU type are required before proceeding to the next section. A Site ID can
contain up to 4 alphanumeric characters; if fewer, it will be padded with leading

zeroes.
@sne 1D 0001 =] B
Site ID:* | 0001 Contact: Local Authorization Options
Site Name: | Main Depot phoneNo: | @® Lock-in List
Address1: [—
| Fax No: € Lock-out List
Address2: ‘ [—
E-Mail:
City:
State: Zip Code: Last Download: 3/19/2020 2:42:34 PM Time Synchronization
Location Code [ Comment: H [¥ Synchronize Time
Tank(s) | Offset |0
T... | Product Quantity|  Reorder Limit Capacity| Type Add
1 |Unleaded 49000.00 GL| 500000 GL|  50000.00 GL|pure
2 |0|ICheck 2500.00 QT| 500.00 QT| 5000.00 QT|pure
FMU(s) ‘ Connection Type  Configure
F. | FMU Name ‘ Wersion | Add AN =
0 |mD1 |FUELMASTER FMU2500. | [ =
Tank Monitor
NO TANK MONITOR UNIT =
Type: F - Fixed hd
Online FMU{FMU 2500 Plus AIM 1T Prog = Cancel

Tank Listing

Displays the Tank(s) configured for the site. See Tank Configuration for more

information.

FMU Listing

Displays the FMU(s) configured for this site. See FMU Configuration for more

information.
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Connection type

There are two types of connections supported by FuelMaster: Phone, and LAN.

Chapter 5 Site Configuration

Select the appropriate connection type from the dropdown box and click

£ - ’
Configure’.
[ Site 1D 0001 ==EoE X"
Site ID:* Contact Local Authorization Options
Site Name: | Main Depot Phone No: @ Lodcin List
Address1:
Fax No: Lock-out List
Address2:
- E-Mail:
Gity:
State: Zip Code: Last Download: 3/19/2020 2:42:34 PM Time Synchronization
Location Code / Comment: v Svnrhr—omle Time
Tank(s) Offset |0
[T_[Product | Quantty| Reorderimt| _ Copaoty[ Type [ Add
1 |Unieaded | 49000.00 GL 500000 GL| 50000.00 GL|pure
{2 [oicheck | 2500.00QT 500.00QT|  5000.00 QT|pure
) Connection Tybe  Configure |
|F.|FMUName |Verson |  Add 7
0 [MD1 FUELMASTER FMU2500. —— ! %
Tank Monitor
NO TANK MONITOR UNIT +
Type: |F - Fixed A |
onine | | FMuFMU 2500 Plus AIM 11 Prog v | Cancel |

Tank Monitor

The FMU can communicate directly with your TMU and bring back a wide variety of
details. TMUs communicate serially with the FMU and are queried for information,
which is returned to the software upon download.

Type

The Type option refers to the type of unit the site represents. Fixed units are FMU's
installed at the fueling island. Select F - Fixed. Mobile units are mounted on fueling
trucks. Select P - Passive Mobile.

FMU

Set the type of FMU installed at your fueling island or Mobile vehicle: Classic, Plus,
Plus with AIM units, or Plus with AIM Prog FMU type.

Local Authorization Options

Controls whether the site receives a lock-in or lock-out list for authorizing Local
Authorization Credit Cards. A lock-in list holds all credit cards that are authorized to
receive fuel; any card not listed will not be authorized for fuel. A lock-out list
authorizes all cards unless a card is listed as unauthorized for fuel.

Time Synchronization - with offset
01/08/2024
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Utilized to synch the FMU time with the PC time; can be set per site. Offsets can be O
to 23 (used for time zone differences). If checked, every time the software goes
online with the FMU, synchronizes the time at the FMU to the PC time (plus or minus
the offset).

Advanced - FMU Settings

Enable FMU Settings to manage the FMU configuration. See ‘Managing FMU Settings.

Connection Configuration

Phone Connection

FuelMaster customers can use an analog phone line to communicate with their FMU.
There are also options available for remote sites to utilize cell phone modems and/or
phone line extenders. Enter the FMU phone number and click OK.

Phone Config Dialog X

Site ID: [0001 oK |
FMU Modem # || Cancel

[ Override Default Modem Init String

LAN Connection

Uses your existing network to communicate with the FMU via TCP/IP. Enter the static
IP address assigned to the FMU by your IT Dept. (A static address is a fixed address
dedicated for the FMU to minimize errors in communications.)
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Chapter 5 Site Configuration

Passive and Active FTP Toggle

When a LAN connection is used to communicate with FMUs, the software can be
configured to use either Active or Passive FTP on a per site basis.

LAN Connection Config Dialog X

Site ID: | 0001

IP Address

B . 16 . 95 . 51

Port Number: 23

FTP Connection

" Active @® Passive

OK | Cancel

Tank Configuration

Tanks provide product for FMU's to dispense. The configuration items and options

are described below.

01/08/2024

& Tank ID 1 Site 0001

(=] 5 -

Site ID: 0001 Tank Number: ’17
Site Name | Main Depot

Tank Capacity: IW GL Product:*

Reorder Limit: IW GL |Un|(\aded _,

[ Enable Pricing Per Tank [ Blended | % of Tank

| ,— % of Tank v

Vendor:
[ [ Maintain Inventory

‘ Inventory Editor |

Tank Information

Current Quantity: | 49000.00 GL
Last Delivery: 49000.00GL 3/19/2020 2:21:11 PM

Last Stick Reading:
Last TMU Quantity:

Last Adjustment:
Last Download:

Last Transfer:

OK Cancel
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Tank Capacity
The maximum fuel capacity of the tank.
Reorder Limit

This triggers the FMU to notify the user when the tank has reached or fallen below
the reorder limit. A message displays on the Polling Report notifying the Central
Controller to order more fuel after a download has taken place.

Product
Select the product to associate with this tank.
Blended

A blended tank represents a mixture of two tanks that are combined at fueling.
Before creating a blended tank, configure two non-blended tanks. This is only
available if using electronic dispensers at the FMU.

Maintain Inventory

If checked, maintains a running calculation of tank inventory based on deliveries,
adjustments, transfers, stick readings, TMU readings, and fueling transactions.

Enable Pricing Per Tank

Check this flag to set site/tank specific pricing versus system-wide pricing. Pricing
configuration is handled like the Product Pricing described in Chapter 4.

Vendor

This represents the company that provides fuel for this tank. It is used for reporting
purposes.

Tank Information

Displays the latest of each type of inventory transaction: delivery, adjustment,
transfer, stick reading, and TMU reading, as well as the current quantity read at the
last download.
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Inventory Editor

Deliveries, Adjustments, Transfers, and Stick Reads are all handled through the
inventory editor interface which allows you to enter/edit inventory related records.

The Inventory Editor is used to enter, edit, or delete inventory transaction records.
Check the box to Show Running Balances. To add or edit a record, select the Site
and Tank desired, and choose the transaction type. Click Add to create a new entry.
Highlight the desired record and click Edit to change an existing record. This opens
several different inventory adjustment dialogs that vary slightly for each transaction

type.

& Inventory Editor v @ ]
Site: | v|  Tank: [A ~] [ Show Running Balances
StartDate: | 3/23/2020 | End Date: 4/22/200
Type - |site [Tank [ Date & Time | Quantity|  Closeout| Balance |
Please choose a site
Add... | Edt.. | Delete | print | Close

Use the Inventory Adjustment dialogs to enter the date/time and quantity of each
inventory transaction. Some, like the Edit Delivery Dialog, have fields specific to
that delivery type. You can also enter the unit price paid for the delivery. This, in turn,
is used in the Fuel Costing report to track fuel cost versus what it is sold for. Enter in
all pertinent information and click OK to save.

B Edt Delivery Dialog X
Site ID: [ooo1 oK |
Site Mame | Main Depot Cancel
Tank Number: lli
Current Inventory: | 0 GL Product: | Unleaded
Tank Capacity: [50000

Delivery Amount: | 30000 GL
Unit Price: 2.04]

Date: ["4/22/2020 ]

Time: [10:51:04 AM =

Comment: [
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FMU Configuration

The FMU Configuration window allows you to establish FMU settings, timers, and
hose configuration.

& Unit ID 0 Site 0001 b= B

Site Name: IMain Depot

FMU: Master -0 ¥ | FMU Name: | MD1

Hose(s) |

P... |H... | Type Tank | Prod | NPT |PHL |PFT [UI Div/Ratio
A MECHANICAL |1 1 30 |none (10 GL 10:1
B |2 |MECHANICAL (2 63 |30 ([none |10 QT 10:1

Add | |

Modem Hours

Begin: |0 Totalizer digits: |8 |3 Decimal Digits for Onsite | 2

: Valid Key Timeout: ero Quantity Shutdown
End: | 24 lid Key T 30 Zero Q Shutdown [ 10
Creepage: | 0.00 Message Duration: |4 Julian Date Rollover Hour: | 0

| onine | [ ok | | | Cancel |

FMU Name
Enter the FMU Name.
Modem Hours

Represents the hours during which the FMU modem answers incoming calls from the
software.

Totalizer Digits

Sets the number of digits that can be used to represent totalizer readings: the left
edit field shows number of digits to the left of the decimal and the right edit field
shows number of digits to the right of the decimal.

Valid Key Timeout

Length of time in seconds the user/customer must complete the transaction
authorization after inserting a key in the FMU.

Message Duration

Length of time in seconds a message prompt is displayed on the FMU's LCD before
timing out and returning to the previous prompt.

Decimal Digits for Onsite
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Specifies the number of digits printed on the onsite printer for transaction quantity
information.

Zero Quantity Shutdown

The number of zero quantity transactions a hose can execute consecutively before
the hose is shut down. This prevents fuel being dispensed when no quantity is
recorded, perhaps because the pulser in the dispenser is failing, or has failed, and
needs to be replaced.

Julian Date Rollover Hour

Specifies the time at which the day end/begins for accounting purposes. Example:
Download takes place every day at 8:00 am and the Julian Date Rollover is set to 8.
This setting will change the date and time of the transactions by 8 hours using 8:00
am as midnight to start a new day of transactions. If someone fuels at 7:30 am and
then a download takes place at 8:00 am with the current setting 8, the 7:30 am
transaction will have a date/time as 11:30 pm the previous day.

Each FMU at your Site(s) needs to be configured separately under the Site
Configuration. This includes the master FMU and any satellite FMUs.

Online

When an FMU configuration is complete, click Online > Upload to send the
information to the FMU.

If the FMU has already been configured or to activate Site FMU Settings, click Online
> Download to send configuration information to FMPlus.
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Hose Configuration

Hoses are tied to pump positions in the FMU pedestal. Each FMU can control up to
eight physical pump positions and can therefore have eight hoses.

T Hose 1 Site 0001 | = | =l |ﬂ|

Site: ‘ Main Depot
MD1

Unit:

Type
Pumpm huad " MPD
Configure
Hose | 1 ® Mech
PHL ‘none ﬂ pIE{O UI|GL
Div .
Ratio | 10 ‘L npT |30 pFr |10

Grade Position(s)

Num | Tank | Product
1 1 Unleaded

ok | | Concel

Multi-Product Dispensers (MPD) can be interfaced with the FMU using an Omega
Jr./PIE box. The PIE box is essentially a translator that allows the FMU to issue
commands to the Electronic Dispensers’ computer modules. In this scenario, fuel
control is not handled mechanically, but instead done electronically.

Hose Types:
Mech - Mechanical Hoses

Configure one hose at a time for mechanical dispensers and mechanically controlled
electronic dispensers.

MPD/Electronic Hoses

MPD’s and Electronic Dispensers using PIE boxes use all the Mechanical settings but
also use the PIE setting. This is the electronic address that correlates to the fueling
position being controlled. For MPD the hose position is one side of the dispenser or
fueling position. Each FMU can control up to eight fueling positions.

PHL (Pump Handle Sensing)

Pump Handle Sensing can be used for starting and/or ending transactions. This
MUST be set to how the position is wired in the dispenser.
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Div Ratio

Divide Ratio correlates to the pulser divide rate - the number of pulses generated for
each integral unit of issue dispensed. Common settings are 100:1 or 10:1.

NPT (No Pulse Timeout)

Amount of time allowed from the transaction authorization until the transaction is
stopped because dispensing did not occur.

PFT (Pump Finish Timeout)
Amount of time after pulses cease before the FMU completes the transaction.
Type - Configure

For a "Mech” hose, Configure opens the Mechanical Grade Positions dialog box. For
an "MPD" hose, Configure opens the MPD Grade Positions dialog box.

Mechanical Grade Positions

For Mechanical Hoses, there can only be one grade per hose position. To configure
the grade, select the appropriate tank from the dropdown box.

Verify that the Product automatically displayed when the tank is selected is the
correct one or correct any issue in the tank configuration interface. Click OK.

& Grade Positions - 1 | = | =] &l
Site: |I‘»1ain Depot
Unit: | MD1
Hose # ’1— Pump Iﬂ\_

Pos Tank Product PIE ANID
1 [Unleaded o
2[ =] | o
3[ =1 HE
4 [=] | o
5| = | o
6| I | o
/| IEA| IE
8| =l | o

OK Cancel ‘

01/08/2024 © Syntech Systems, Inc. 2014-2023 50



FMPlus User Manual Chapter 5 Site Configuration
Document Version: 9.0

MPD Grade Positions

For MPDs, you can configure up to eight grade positions for each individual hose or
fueling position. To clarify, the hose position is the side of the dispenser you wish to
control, and the grade positions represent the different products available through
that dispenser.

& Grade Positions - 4 ‘i| (=] &1

Site: |p1F1

Unit: | PIE

Hose # ’1— Pump IA_
Pos Tank Product PIE ANID
1 |1 L, | Unleaded | 1 |27|
2[ 1] 2o
3l | IC
al < | o
e | | o
6l <l C
7[ ] | o
8| ]| | o

’Tl Cancel ‘

To configure the grade positions, select the tank for each position and then configure
the PIE addresses for each. When a position is filled, the next position becomes
available. The PIE addresses are established by the dispenser and are usually
sequential from 1to 8. Verify the Product box is correct when selecting tanks.

NOTE The AIM Nozzle ID (ANID) identifies the fueling hose tag for the AIM module.

01/08/2024 © Syntech Systems, Inc. 2014-2023 51



FMPlus User Manual Chapter 6 Customers, Vehicles, & Users
Document Version: 9.0

Chapter 6 Customers, Vehicles, & Users

FMPIlus has three primary ways to gain access to fueling data for billing purposes: by
Customer, Vehicle, or User. Of these, Vehicles and Users can be encoded on keys or
cards and used to access the FMU.

There are several more layers of authorization and billing ability in FMPlus, such as
Agency, Department and Usage. Customizable fields (Miscellaneous fields covered in
Chapter 3) can also be used to break out accounting data in even more detail.

Customers

Access the Customer list by clicking the Cust icon on the FMPlus toolbar, by
selecting Tables > Customer, or by hot keys CTRL + F8.

T Customer List = B I

Customer(s)

[ customer 1ID: [ Customer Name. | Phone No. [ Add
000000001 |Fuelers R Us |555-555-5555 |

Close

Customer records are the top billing level of the FuelMaster package. The Customer
List displays the Customer ID, Name, and Phone number.

Customer information can be accessed by double-clicking or by highlighting and
clicking the Open button.

Click Add to add a new customer and its detailed information.
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Customer ID

The Customer ID window is used to enter all information pertinent to a customer.

Gl

Bl Customer ID - [MEW] = =R

Custamer 107

Customer Mame: |
Addresz]: |
Address2: |
City: |
Shate: |
|
|
|
|
|

|

LCancel

Zip Code:
Phaone Mo:
Fax Mo
E-Hail
Caontact:

Price Lewvel: 1

Carmment; |

Autharization|z)
[ [
-
-

Customer ID

The Customer ID contains up to 9 alphanumeric characters and will be automatically
padded with zeroes (to the left). This field identifies which Vehicles and Users
correspond to a specific customer. If you do not wish to use this option, you can turn
off the Require Customer ID setting as shown in Chapter 3, System Tab.

Customer Information

The Customer ID is a unique 9-character identifier for the customer in FMPlus. Use
the Customer Name field to more completely identify the customer for users of the
system.

Price Level

The Price Level can be set for each customer for their vehicles/users. This is a global
setting for each customer but can still be adjusted per vehicle/user if needed. For
more info on Price Levels, see Chapter 4.
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Vehicles

The list of Vehicles can be accessed by clicking the Vehicle icon on the FMPlus (Fig
3.1) toolbar, by selecting Tables > Vehicle, or by hot keys CTRL + F5.

T Vehicle List =] @ EI
Vehicle |
Vehicle ID | Agency | Description | Cust ID | Prokee Encoded | Prokee... | Add J
00000001 F-150 A 000000001 NO YES
00000002 F-1508 000000001  NO YES
Close

Once Customer records have been created, or the option turned off, Vehicle records
can be created. The Vehicle record contains information about the vehicle, the
Customer, and products authorized for the vehicle. Each vehicle can be accessed by

double-clicking or by highlighting and clicking the Open button. New Vehicles can be
added by clicking Add.

Vehicle Record

The Vehicle Record contains five tabs unless the system is configured as a Passive
System (AIM). Passive Systems are covered in Chapter 9.

If the system is VVI or UKO, the Vehicle tabs will not have Products or Prokee/Smart
Card tabs and you will not be able to encode Prokees or Smart Cards here.

TR Vehicle D 00000001 =] @
General | Products® | PROKEE | Misc | Odometer |
ok |
Vehicee ID:* 00000001 Agency =]
Vehicle Description: Ford F-150 A —I
Customer ID* 000000001 ¥ | -Customer Name %
Vehicle Year: 2010] The One Update
Vehicle Make: FORD ~| [ Check to Install AIM _ Corcel |
Vehicle Model 150 +]
Encoded YES Authorized

[¥ Prokee
AIM not Enabled - The vehicle record is not enabled as an AIM vehicle.
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Vehicle General Tab
Various fields are available for billing, maintenance, and description.
Vehicle ID

The Vehicle ID is encoded onto the Prokee/Smart Card to identify the vehicle upon
fueling. The ID can be numeric only or alphanumeric depending on the System Type
described in Chapter 1.

Vehicle Description
Describes the vehicle and is primarily used for reporting.
Agency

The Agency field is provided by FuelMaster as a standard accounting category. This
field is encoded on the key, can be up to 5 alphanumeric characters and can also be
prompted for during a fueling transaction.

NOTE The prompt option can only be enabled by a Syntech Certified Technician or
CSC Technician who can be contacted via phone 1-800-888-9136 ext. 2.

Also ties the vehicle to an agency for group authorization purposes.

Encoded

Status of whether this record has been encoded onto a Prokee or Smart Card.
Customer ID

Ties the Vehicle ID to a Customer for billing or reporting purposes.

Customer Name

Automatically filled when a Customer ID is selected from the dropdown list.
Vehicle Information Fields

Use the Vehicle Year, Vehicle Make, and Vehicle Model field to provide additional
information about the vehicle.

Passive Status Box

This box only appears if this is an AIM selected vehicle. It shows the programmed
status of the vehicle record to the AIM. When appropriate, the record also has a box
that denotes the vehicle is not enabled as an AIM vehicle.

Authorized:

e Prokee - if checked and sent to the FMU this vehicle record’s
corresponding Prokee is authorized; if unchecked and sent to FMU the
Prokee is unauthorized at the FMU.
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e AIM - Only shows if AIM is enabled. If checked and sent to the FMU this
vehicle record’s corresponding AlIM is authorized; if unchecked and sent to
FMU the AIM is unauthorized at the FMU.

e Keypad - Only shows if the system type is Keyless. If checked, the ID is
authorized to start Keyless transactions at the keypad.

NOTE Removing authorization by unchecking the Prokee or AIM box preserves
reporting ability on vehicle transactions. Deleting, and potentially reusing
the Vehicle ID, can lead to problems and inaccurate information in the
database.

Vehicle Products Tab

One of the benefits of having a FuelMaster System is to make sure vehicles only
dispense the products assigned to the vehicle to protect the vehicle from damage
and the vender from theft.

"ﬁ'ﬁ\.fehiclem 00003337 ===l
Genersl Products™ | PROKEE | Misc | Odometer | "
P Bunatet D b Feng | el
& |2 | |Diesel R =] & %
B [62 +| [DiCheck [ 6 [17 =] T Dekete
Clo ~f [ua [ o [T =] I Deletef Cancel
o.Jo =] [Na o o [ =] ¢ J
Efo = na 0 [0 =] T Dekte| | Authorzed
Flo =] na o o [ =] J ¥ Prokes
G o -] [ma [0 [0 =] ¢ J
Hofo =] |ma o o = & J

Product

Select one, or up to eight, Products from the Product dropdown lists to be assigned
to the vehicle.

Product Description

Displays the description of the selected product and is automatically filled when a
product is selected.

Daily Product Allotted

Track a vehicle’s normally expected one day usage. This can be set to twice the
transaction limit if, for example, the vehicle might fuel twice in one day. The option to
cutoff the user from overage can be enabled at the FMU; otherwise, an overage is
tracked using an exception message in the Polling Report.
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Transaction Limit

Maximum amount of fuel allowed per fueling transaction. Typically set to the
vehicle’s fuel tank capacity. The transaction ends at the specified amount per vehicle
per transaction.

Price Level

Level at which the vehicle fuel is billed; set from the dropdown list. The Price Level is
applied to the quantity upon a download from the FMU to arrive at the total price.

Match Customer Price Level

If checked, this record will be linked to its corresponding Customers Price Level.
Delete

Allows the operator to click Delete to remove a product from the vehicle record.
Vehicle Prokee/Smart Card Tab

Configures the Prokee/Smart Card options at the FMU when a key is used, and
shows the most recent status and encoding information for the vehicle.

B Wehicle ID 00003337 (o] = [ =]
General | Products® FROKEE | Misc | Odameter |
Prokee
[~ Odameter =3 Encode
[~ FIN [ Receipt
Key Type: Vehicle
Reissue Count: 1] 4
Date Reissued: 2/5/2012 1:55:58 FM Cagcel
Encoded: Mo
Date Encoded: 2/5/2012 1:55:58 PM Authorized
Authorized: es ¥ Prokee
Date Authorized: 8/13/212 7:44:22 PM
Internal Key Mumber:
PIN Mumnber: A

Odometer

When checked, the Prokee/Smart Card prompts for an odometer reading at the FMU
keypad to complete fueling.

PIN

When checked, the Prokee/Smart Card prompts for a PIN at the FMU keypad. The
PIN is the last four digits of the Prokee Internal Number. You may use the Read
Prokee button on the toolbar to see the Prokee Internal Number. The Prokee tab also
shows the Prokee Internal Number for a Vehicle or User if available.
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User ID

When checked, the Prokee/Smart Card prompts for a User ID. For some system
types, like the VMN system, this is automatically required and cannot be disabled.

Receipt

Like the other Prokee/Smart Card options when checked, the user is asked if they
would like a receipt of the transaction. Credit card transactions provide a receipt
regardless of this setting.

Status Fields

e Key Type - Vehicle, User, Tanker Truck, Supervisor, Manual Issue

e Reissue Count - Number of times the record has been issued to a new key
e Date Reissued - Date key was last re-encoded

e Encoded - Status of record being encoded or not

e Date Encoded - Date key was initially encoded

e Authorized - Vehicle Key/Smart Card is authorized or unauthorized

e Date Authorized - Date the key/Smart Card was last authorized

PIN & Internal Key Number

The internal key number is assigned when the key is encoded. The last four digits of
the internal key number are the PIN. It cannot be chosen by the Central Controller as
it is automatically assigned when the Prokee is encoded.

Vehicle Misc Tab

Define the labels for the miscellaneous fields in Configuration > System. These fields
can be used in reporting and Custom Exports.

i o | B[
General| Products® | PROKEE Misc | Odometer | :

o] 3
Organization: 4
Usage [ Reissue
Date Service Began 8/ 212016 J Update
Misc 1 Cancel
Misc 2
Misc 3 Authorized
Misc 4 ¥ Prokes
Misc 5
Comment: [
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Organization

This accounting field is not encoded on the key; can be three alphanumeric
characters.

Usage

Also not encoded on the key; can be six alphanumeric characters.
Date Service Began

Displays the date the key record was created.

Miscellaneous Fields

The five potential miscellaneous fields can be used for additional accounting
information. These fields can be up to 20 alphanumeric characters.

Vehicle Odometer Tab

Information regarding the Odometer and PM Maintenance are created and stored in
this tab.

'ﬁﬁ Wehicle ID 00003337 == =]
General | Praducts” | PROKEE | Mise Odometer |
ot o] |
Current Ddometer: 1] Encode
Drate Odometer Read: 2/5/2012 1:55:58 PM
Fuel Range: 350 Expected Efficiency |50
LCancel
[~ Preventive Maintenance
Pt Range: 3000 Pk Motification 250 Autharized
Mest PM Reading [0 ' Prokes

Current Odometer

Displays the current mileage of the vehicle if entered while fueling.
Date Odometer Read

The date of the last odometer reading if entered when fueling.
Fuel Range

Distance the vehicle can travel on one full tank. An exception displays on the Polling
Report if the vehicle goes outside the range. The message is also invoked if the
vehicle has fueled offsite causing the odometer to be out of range. If a vehicle is
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often transient, setting this range higher is suggested since offsite fueling will be
taking place.

Expected Efficiency
Expected miles per gallon (MPG) for the venhicle.
Preventative Maintenance

Checking this box allows you to track Preventative Maintenance for this vehicle or
equipment.

PM Range

Number of miles the vehicle can go between preventative maintenance servicing
such as oil changes.

PM Notification
Sets the number of miles prior to reaching the PM Range for notification.

Reports > Preventative Maintenance > PM Over Due or PM Over Notice shows
when vehicles are due for preventative maintenance and need to be serviced.

Next PM Reading

Set when the record is created to flag for servicing; also reset when the vehicle has
completed servicing.

Users

The list of Users can be accessed by clicking the User icon on the FMPIlus toolbar, by
selecting Tables > User, or by hot keys CTRL + F6.

% User List =) E I

User(s) |

User ID: | User Name Cust ID: Prokee Auth Add
000000001 Preston, Robin 000000001 YES
000000025 Dial, Robin 000000001 YES

Close

The User List operates similarly to the Vehicle List, showing Users who are authorized
to fuel vehicles and general information on each user.
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User ID

The User dialog in this example contains one tab as the system type is VMN. Other
System Types may display additional tabs that operate similarly to the tabs in the
Vehicle ID section.

4

T User ID [NEW] = @

General |

useris |
lastName: |  FistName: [
mise | Middemita [
agency. | =]
Department [ <] CustomerName:
Customer ID:* [ ;‘ | Cancel
Employee No: (—
Phone to Authorized
FAXNo: | .

E-Mail: [

i

Comment: ‘
Date Authorized ~ 4/2/2020 3:01:30 PM

Users General Tab
Basic information fields describe the Users information.
User ID

The User ID is either a manual entry at the FMU or can be encoded onto a
Prokee/Smart Card or Proximity card. This depends on the System Types as
described in Chapter 1.

Last, First, MISC, Middle Initial

Used to describe the User; used for reporting.

Agency & Department

Associate an Agency or Department to the User for group authorization purposes.
Customer ID & Customer Name

When you select Customer ID from the dropdown box, the Customer Name auto-fills.
This must be selected before entering other fields.
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Agencies, Departments, and Organization

Vehicles, Users, and Utility Keys can be grouped for authorization and billing by
Agency, Department, and Organization, as well as by Customer.

Tables = Operations System Reports

= Vehicle... Ctrl+F5
05 User. Ctrl+F6
&= Site.. Ctrl+F7
¢8 Tanker Truck... Ctrl+F9
gd"  Supervisor...
Manual Issue...
ﬁ Customer... Ctrl+F8
Products...

AlM Programmer...
Agency...
Department...

Organization...

Agency, Department, and Organization can be accessed through the Tables menu.

Agencies

Agency List
Select Tables > Agency... from the menu to access the Agency List.
Use the list to Add, Delete, or Open Agency records.

Access Agency information by double-clicking on a record or highlighting it and
clicking Open.

T Agency Lit S=2Ee
Agencyls) |
= o —r —
ALPHA Alpha Auto Vehicle 4
ET
[ Do |
NOTE An Agency cannot be deleted from the system if it is associated with any

vehicle or user.
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Agency New
Each agency must have an agency Type and Name. Description is optional.

The name field supports up to 5 characters.

(T4 agency: - [NEW] =] = =]
Type: e 'E oK
Mame: |
Description: | Cancel

Agency Types

Each Agency value must be unique and can only be associated with one record type;
User, Vehicle, or Utility.

Bt Agency: - [NEW] E=8 =l
Type: |\-'ehicle hd oK
Mame: Dzer Apply
Description: LJElit: Cancel
[ 3

Different Authorization checkboxes display depending on the System Type and
Agency Type selected.

Once added, Agencies are available via a dropdown box for Vehicles, Users, and
Utility Keys.
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Departments
Department List
Select Tables > Department... from the menu to access the Department List.

Use the list to Add, Delete, or Open Department records.

IEiiD:[:mrtment ol ® @I

Department

Name: I Description: [
MOTOR |Motor Vehicles |

Access Department information by double-clicking on a record, or highlighting it and
clicking Open.

NOTE A Department cannot be deleted from the system if it is associated with any
user.

Department Entry
Each department must have a Name, up to 6 characters. Description is optional.

Different Authorization checkboxes display depending on the System Type.

F5 Dept: MOTOR =] ® =]
Marme: [ moToR
Description: | fotor Yehicles

Cancel

Autharization(s)

I User
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Organizations

Organization List

Chapter 6 Customers, Vehicles, & Users

Select Tables > Organization... from the menu to access the Organization list.

i@( Organization

b = s

Organization

N
123

Name:

‘ Description:

Add

Open

L Dekte

Close

Use the list to Add, Delete, or Open Organization records.

Access Organization information by double-clicking on a record or highlighting it and

clicking Open.

any vehicle.

NOTE An Organization cannot be deleted from the system if it is associated with

Organization

Each Organization must have a Name, up to 3 characters. Description is optional.

"B Org ¢ - [NEW] =] @ ==
Marne: ||-\"1 @
Description: | Levell| e |

Cancel
-
I

Different Authorization checkboxes will be displayed depending on the System

Type.

Authorization by Group

Vehicle, Users, Utility Keys, and AIM vehicles can be authorized or de-authorized in
groups by Customer, Agency, Department or Organization.
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Regardless of the group type, group authorization is accomplished in the same way.

Setup associations

For example, to authorize Vehicles by Agency, first create Agency records. To
associate an Agency with Vehicles, set the Agency type to “Vehicle”.

—
B Ageney i =i
Agencyls) |
Name: Description: Type: Add
AB222 Alberts Body Shop User
ALPHA Alpha Auta Vehicle
JOES JoesGarage Wehicle
OVER Overton Vehicle
Close

Next, associate vehicles with agencies by setting the Agency value within the Vehicle
record.

NOTE The Agency has been set to OVER, and the vehicle is authorized.

B3 Vehicle ID 00004363 E=R[EcR =5
General | Products” | PROKEE | Misc | Odometer |
Vehicle ID:” DO004363 Acercy: | T~ Bisas
Encode

“ehicle Description: | Lol

Custamer ID:* 00000MAYH ~| - Customer Mame Q

Vehicle Year 2000 [ R
. X C |

Wehicle Make: TOYOTA v| [T Check to Install A1M2 ﬁ

Wehicle Model: COROLLS, -

Encoded: MO et

¥ Prokee
A2 not Enabled - The vehicle record iz not enabled as an Al 2 vehicle
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Authorize/De-authorize

You may authorize or de-authorize an entire group of records by unchecking the
appropriate box within the group record.

In this example, all vehicles associated with the agency, Overton, will be de-
authorized.

ﬁAgency:OVER EI =1 @I
Type: |\-'ehic|e J ok
Marme: | OVER Apply
Descripkion: | Overkon Cancel

Autharization(s)

[ am %

To authorize/de-authorize a group of records, click the appropriate checkbox and
click OK.

Once the change has been applied, you can see the effect by viewing any record

with the associated group type. In this case, the record with the agency OVER has
been de-authorized.

5 Wehicle ID 00004353 =] @ |
General | Products” | PROKEE | Misc | Odameter | L\\’
Wehicle 1D:* 00004363 Agency: [OgvER =
Encode
Wehicle Description: || 4
Customer [D:* 00000M&YN |~ Customer Name [Boee |
Wehicle Year: 2000 1 4
] . Cancel
et de TOYOTA > T Check to Install A2 _Coreel |

Wehicle Model: COROLLA hd

Encoded: NO Authorized
[~ Prokes

Al 2 nat Enabled - The wehicle record is not enabled as an AIM2 vehicle.
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Chapter 6 Customers, Vehicles, & Users

It is possible for a record to have multiple associations. For example, in a VMN
system, a vehicle record may have an associated Agency, Customer, and

Organization.

The last change to an authorization will take precedence over any previous change,

regardless of the group associations.

Wehicle Model:

Encoded:

Bs{ Vehicle ID 00004363 ol = =
General | Products® | PROKEE | Misc | Odometer |
Wehicle D2 00004363 Agency: [ oyvER hd
Encode

Wehicle Description: ||

Customer [D:* O0000MAT M 4

Wehicle vear: Q
VehEble [~ Check to Install Al _Loreel |

A2 not Enabled - The vehicle record is not ehabled as an AIM2 vehicle.

Authorized
[~ Prokee

For example, all vehicles within an Agency group will be authorized (or de-
authorized) if the associated Agency was the last to be changed, even if some or all
vehicle records are also associated with Customers.

Allowed Associations - Groups

Not all groups are available for all record types. The specific options available
depend on the System Type setting, and for Agencies, the Agency Type setting.

This is a list of available group types by record type.

Vehicle +AIM Utility (Tankers,
Programmer | AIM Vehicle User Supervisors, Manual Issue)
Agency X X X
Customer X X X
Department X
Organization X X

01/08/2024 © Syntech Systems, Inc. 2014-2023 68



FMPlus User Manual
Document Version: 9.0

Authorization Summary
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In addition to being used to authorize or de-authorize groups of records, the
authorization checkboxes for each group type provide a quick summary of

authorization statuses.

B CustomerID 00000ABLE =] @ [
Customer |D:* 00000sBLE [n]4 |

Cugtomer M ane:

Addressl:

_orb |

Addrezs2:

Cancel

City:

State:

Zip Code:

FPhone Mo:

Fawx Mo

E-Mail:

Contact;

Frice Lewel:

Caomment:

Authanization(z)
[ “ehicle Prokee

[ Al
¥ User

[+ Utility Prokee

The three statuses are:

e Checked - All associated records are authorized.

e Grayed/Checked - Some of the records are authorized, or no associations
exist. This is the default status.

¢ Unchecked - All associated records are unauthorized.
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Chapter 7 Prepaid and Discount Cards

FMPIlus provides the option to offer various discounts for preferred customers based on
either individually encoded prepaid cards or Prokees, or by discounting specific credit
cards.

The Prepaid option is used primarily for those customers who want to pay for fuel
ahead of time instead of being billed afterwards or do not want to use credit cards.

The Discount Card is designed to allow retail sites to reward their most frequent and
high-volume customers by providing a discount with the same high level of
convenience they expect from their credit card. Both transaction types are billed at the
FMU when fueling occurs, so updating the FMU’s pricing is important.

NOTE This option requires customization. Call the Syntech Systems, Inc.’s CSC
Helpdesk at 1-800-888-9136 ext. 2 to enable these options in your software.

Card Owners

To access Card Owners, select Tables > Card Owners from the menu.

uelmaster® Plus

Tables Operations System Reports View Win

= \ehicle... Ctrl+F5
& User... Ctrl+F6
B Site... Ctrl+F7
& Tanker Truck... Ctrl+F9
& Supervisor...
Manual Issue...
" Customer... Ctrl+F8
Products...

AIM Programmer...

Card Owners...

Local Authorization Cards
Local Authorization Accounts
Agency...

Department...

Organization...

Prepaid and Discount Credit Cards are grouped together under Card Owners so the
two record types can be managed at a higher level. For example: a company has 3
pilots with credit cards whom receive a discount and has 2 standby part time pilots
whom use prepaid keys. The discount cards and prepaid cards can be tracked under
the company account and individually.
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Card Owner List

The list displays card owners, card owner names, and the date each account was

created.

Chapter 7 Prepaid and Discount Cards

T Card Owner List
Card Owner(s) |

Card0__| CardOwner Na__| Creaton Date

?‘IEJE

Card Owner Info

Card Owner ID information window is used to enter contact information regarding the

account.

There are two card type tabs: Discount Cards and Prepaid Cards.

& Card Owner ID [NEW] = B
Owner ‘ Zip Code: |
Name ‘ Phone No 1: |
Addressi: | Phone No 2: |
Address2: ‘ Fax No: I
City: \ Email: [
State: ‘ Contact: |
Comment: ‘
[ Discount Cz I Prepaid Prokee(s) |
Discount .. [Parlial D |Price & | Comment l:l
OK Cancel

The information in these records may hold sensitive data, such as credit card numbers.
Even though credit card numbers are encrypted in FuelMaster, restrict access to this

feature to employees who need access.

Card Owners can have multiple discount cards and prepaid keys in any combination

required.
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NOTE Discounts by credit card types, also known as branded discounting, are not
handled through the software. This option must be enabled directly in the FMU
by a FuelMaster Certified Technician or CSC. It is only available for certain card
types and certain credit card networks. Call Syntech Systems, Inc.’s CSC at 1-
800-888-9136 ext. 2 to enable the option if you have purchased the
customization.

Discount Cards

Enter the credit card information.

& Discount Card - Owner 00000001 [NEW)] = @
Properties
Owner ID |00000001 Begining Date |4.'?f2020 12:67:05 PM oK
Please enter DECRYPTED card ID
Cancel
cardiD | Partial 1D

CC Exp Date|04/20 - [ Apply Discount

Cornment U

Price Level |1 -

Brand ‘ Unknown/Other -

Owner ID

Associates the card to a card owner for accounting purposes.
Beginning Date

Date the record was created.

Already Encrypted

Select No if the card number being entered has not been hashed by FMPIlus. Select Yes
when entering data from a FuelMaster onsite printer or database, which displays and
stores credit card numbers in an encrypted format.

Card ID

Enter the credit card number in this field. If the number is already encrypted then it will
not change, otherwise it will be masked immediately upon entry.

CC Expiration Date

This is used for identification purposes only; this information is not required at the FMU
nor sent to the FMU by the software.
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Partial ID

Shows the last four digits of the card number which display on reports and receipts.
This is useful to match receipts from customers with the card record.

Apply Discount

Check to apply a discount to this card.

Price Level

Set price level to the discount you would like to give the card user.
Brand

Lists available card types that can be assigned to the card; select Unknown/Other if
your card is not in the list.

Prepaid Keys

The General tab displays the information about the prepaid key.

lﬁ’F’repaid Prokee [NEW] | =] | =] ‘
General | Balances |
Prokee ID: “— Encode
Price Level ’l—ﬂ Save
PIN[ 0000 Ciose
Authorized [v 4/7/2020 12:58:41 PM
I NA
Internal Key Num 00000000
Owmer |D: 00000001
Creation Date: 4/7/2020 12:58:41 PM
Comment

Create Prepaid Key
1. Create the record.
2. Authorize it.
3. Apply Balance.
4. Encode Key.
5. Send list to FMU.
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Prokee ID

The ID can be 8 alphanumeric characters and is used to identify the key at the FMU
when the list is uploaded.

Price Level
Set the price level to be applied when the key is used.
PIN

If checked, the four-digit PIN number, generated when the Prokee is encoded, will be
prompted for and verified by the FMU.

Authorized

Check/uncheck to authorize/de-authorize the prepaid record for fueling; stamps the
date the key was authorized/de-authorized.

Encoded

Checked when a Prepaid Prokee has been encoded. The date/time the key was
encoded or reissued displays next to the checkbox.

Internal Key Number

Generated when the key is encoded to identify the key at the FMU.
Owner ID

Associates the key to a card owner for accounting purposes.
Creation Date

Date the record was created.

Balances Tab
Prokee Balance in Database

Displays the current balance in the database; you can also add and deduct monies from
the Prokee.
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aPrepaid Prokee [NEW] ‘ =
General Balances |
_Eocode |
Prokee Balance in Database 0.00
J Save ‘
Add to Prokee ‘ Deduct from Prokee. Close

Unclaimed outstanding credit 0.0

Apply credits to Prokee.

Unclaimed outstanding credit

A balance left after a fueling transaction. For example, a user preauthorizes $30 of fuel
but pumps $29.50; the outstanding balance of $0.50 displays in this field after the
transaction downloads. If an outstanding credit resides in the FMU, the credit can be
applied back to the key when the user pumps more fuel. Once the credit has been
downloaded, it can only be credited back to the key through the software.
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Chapter 8 Utility Keys

There are three types of Utility Keys in FMPlus: Tanker Truck, Supervisor, and Manual Issue.
They are referred to as Utility keys because they serve more of a maintenance function than
normal keys. They also share the same list within the software and FMU to conserve space.
Because they are managed in the same list, they cannot have the same ID as any other
Utility Keys in the list.

Tanker Truck Keys

Access the Tanker Truck List by clicking Truck on the FMPlus toolbar, by selecting Tables >
Tanker Truck from the menu, or by hot keys CTRL + F9.

A Tanker Truck key has two purposes: first, to upload transactions to an FMU from a Mobile
Unit for download and to upload lists from the FMU to the Mobile Unit. Secondly, it is used
to transfer fuel from an FMU at a fixed fuel island to the Tanker Truck’'s storage tank.

Tanker Keys should not be used to fuel the tanker truck vehicle itself. A vehicle key should
be issued for fueling the Tanker Truck.

i Tanker Truck List =n| B E

Tanker Truck(s)

Tanker Truck Description: Prokee Encoded. Add

Close

Tanker Truck List

Displays the current keys in the database and whether the record has been encoded to a
key.
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General Tab

Various fields are provided to identify the Tanker. Before a Tanker Truck key can be created
a Passive Mobile Site must be created.

i Tanker Truck ID [NEW] —— E
General | Products* | PROKEE | Misc | _
Tanker Truck ID:* /Ii
Description ‘ I
Truck Year ’\1-7
Site ID:* [ =] Cancel
Site Name [
Customer ID:* [ -] Authorized
Cust Name: ‘ r
Encoded No

Tanker Truck ID

Identifies the Tanker record; can be 8 alphanumeric characters.
Description

Describes the Tanker and is primarily used for reporting.

Truck Year

Year the truck was manufactured.

Site ID

Ties the Tanker to the Passive Mobile Site that was created for transferring fuel.
Site Name

Automatically fills when the Site ID is selected to identify the Mobile Site.
Customer ID

Assigns the Tanker Truck to a Customer for accounting purposes.
Customer Name

Automatically fills when Customer ID is selected.

Encoded

Displays whether the Tanker key has been encoded.
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Authorized

Authorizes or de-authorizes the tanker key for transferring fuel. This area will be grayed out
until the key has been initially encoded.

Tanker Products Tab

One of the benefits of a FuelMaster System is to ensure a Tanker only gets the products
intended for the Tanker. This protects the Tanker from damage to itself, damage to other
vehicles receiving fuel from the Tanker, and the purchaser from theft.

T Tanker Truck ID [NEW] = @ [
General | Products” | PROKEE | Misc |
[ox ]
raet Pokespin Alotes | U Lewi Pooew | %0 |
Ao =] v o f =] o st
o =l T F = I ool
clo =] P =] 1 petet] Gancel
o =] T A=l st
Efp =] A PP =] T peete]|  autorized
W ol el e R | IS
[ =] ] = e
o =] A b =] T et

Product
Select a Product from the dropdown list to assign to the Tanker.
Product Description

Displays the description of the selected product and automatically fills when a product is
selected.

Daily Product Allotted

Tracks when a Tanker exceeds expected distributions in a day’s time. This is usually set to
twice the transaction limit. An option to cut off the user from overage can be enabled;
otherwise, the overage causes an exception message in the Polling Report.

Transaction Limit

Maximum amount of fuel allowed per fueling transaction. Typically set to the tanker
capacity.

Price Level

Select the Level at which the Tanker is billed from the dropdown list. The Price Level is
applied to the quantity upon a download from the FMU to arrive at the total price.
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Match Customer Price Level
If checked, this overrides the Product's Price Level with the Customer’s Price Level.
Tanker Prokee/Smart Card Tab

Configures the Prokee/Smart Card options the user receives at the FMU when the key is
used. Shows status and encoding information for that record.

T Tanker Truck 1D [NEW] = B l
General| Products* [PROKEE | Misc | )
Prokee Options 4'
) I~ _ Q
Prokee Type Tanker Truck
Reissue Count 0 Q
Date Reissued NA Cancel
Encoded No
Date Encoded: NA
Authorized
Authonzed No
Date Authorized NA r
Internal Key Number:
PIN Number: None

User ID

If checked, prompts for a User ID. Depending on the System Type, like VMN, this may be
automatically required and cannot be disabled.

PIN

Sets the Prokee/Smart Card to require the user to enter a PIN number at the FMU. The PIN
number is the last four digits of the Prokee Internal Key Number.

Receipt
When checked, prompts user/customer to print a receipt of the transaction.
Status Fields

e Prokee Type - Vehicle, User, Tanker Truck, Supervisor, Manual Issue
e Date Reissued - Date key was re-encoded

e Encoded - Status of record - encoded or not encoded

e Date Encoded - Date key was first initially encoded

e Authorized - Status of record - authorized or unauthorized

e Date Authorized - Date the key was last authorized

Reissue Count

Records the number of times the record is issued a new key. If a key is reissued, the new
key has a new Internal Key Number; the unavailable key's Internal Key Number is placed on
the unauthorized list. If found or stolen, the original key will not be authorized to receive

fuel.
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PIN Number & Internal Key Number

The internal key number is assigned when the key is encoded. The last four digits of the
internal key number are the PIN.

Tanker Misc Tab

These fields can be used in accounting and reporting for Tanker fueling. The miscellaneous
fields can be defined in Configuration > System.

T Tanker Truck ID [NEW] = @
General | Products” | PROKEE Misc |
o A -
Organization: [ =] Q
Usage: ’7
Date Service Began: 41 712020

Misc 1 [ Cancel I

Misc 2

pascd Authorized
Misc 4 [ I

Misc 5

Comment: ‘

Agency

The Agency field is encoded on the key, can be up to 5 alphanumeric characters, and can
also be prompted during a fueling transaction.

NOTE The prompt option can only be enabled by a FuelMaster Certified Technician or
CSC whom can be contacted via phone 1-800-888-9136 ext. 2.

Organization

This accounting field is not encoded on the key; can be 3 alphanumeric characters.
Usage

An accounting field not encoded on the key; can be 6 alphanumeric characters.
Date Service Began

Displays the date the key record was created.

Miscellaneous Fields

The five miscellaneous fields can be used for added accounting. These fields can be 15
alphanumeric characters.

Supervisor Keys

Access the Supervisor List by clicking the Super icon on the FMPlus toolbar or by selecting
Tables > Supervisor from the menu.
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Displays the keys currently encoded. FMPlus ships an encoded Supervisor Key with the
FMU, so the FuelMaster Certified Technician can initially configure the FMU.

T Supervisor List

=

Supervisor(s)

Supensor ID: | Description

[ Prokee E -DmpKey [

00000001 [This is key that came with the FMU | YES

[no

Add

Gl

}

The Supervisor key is used to configure and troubleshoot at the FMU via the Supervisor

menu.

Supervisor General Tab

Supervisor ID

Enter an ID for the Supervisor; can be 8 alphanumeric characters.

& supervisor ID [NEW]

General ‘ Misc |

Supervisor ID* I]

Description: |

Customer 1D:* |

Prokee Type
Reissue Count
Date Reissued
Encoded:

Date Encoded:
Authorized:

Date Authorized
Internal Key Number

J Cust Name

Supemisor

0

4/7/2020 1:17:55 PM
No

4(7/2020 1:17:55 PM
Yes

4/7/2020 1:17:55 PM

Prokee Options
M
~

PIN Number:  None
-

REELE

Cancel

Authorized
o

Customer ID

Assigns the Supervisor key to a Customer for accounting reports.

Prokee Options

PIN and Receipt can be prompted for by the FMU.

Status Fields

01/08/2024

Key Type - Vehicle, User, Tanker Truck, Supervisor, Manual Issue
Date Reissued - Date key was re-encoded
Encoded - Status of record being encoded or not
Date Encoded - Date key was initially encoded
Authorized - Vehicle Key/Smart Card is authorized or unauthorized
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e Date Authorized - Date the key/Smart Card was last authorized
Authorized

This check box is available after the key is encoded; removing the check mark de-
authorizes the key.

Supervisor Misc Tab

Used to configure miscellaneous settings that can be used to account for Supervisor
Access. The miscellaneous fields can be defined in Configuration > System. Each field listed
below can be used in reports and Custom Exports.

Tt Supervisor ID [NEW] = @
General Misc |

Agency: [ =l —
Organization: l—_l Q
Usage | |
Date Service Began | 41 712020 ‘
Misc 1 | Cancel
Misc 2 |
S Authorized
Misc 4 | -
Misc 5 li
Comment: |

Agency

This field is encoded on the key; can be up to 5 alphanumeric characters, and can also be
prompted during a fueling transaction.

NOTE The prompt option can only be enabled by a FuelMaster Certified Technician or
CSC whom can be contacted via phone 1-800-888-9136 ext. 2.

Organization
An accounting field not encoded on the key; can be 3 alphanumeric characters.
Usage

An accounting field not encoded on the key; can be 6 alphanumeric characters.
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Date Service Began
Displays the date the key record was created.
Miscellaneous Fields

The five miscellaneous fields can be used for added reporting. These fields can be 20
alphanumeric characters.

Manual Issue Keys

Select Tables > Manual Issue from the menu.

Tables Operations System Reports View Wi

# Vehicle... Ctrl+F5
€ User... Ctrl+F6
i Site... Ctrl+F7
& Tanker Truck... Ctrl+F9
g Supervisor...

Manual Issue...
*s Customer... Ctrl+F8

Products...

AIM Programmer...

Card Owners...

Local Authorization Cards
Local Authorization Accounts
Agency...

Department...

QOrganization...

Manual Issue Keys are used in a variety of scenarios where normal fueling operations are
not possible or too time restrictive. This key allows onsite personnel to authorize a
transaction without entering any specific accounting information (although the option to do
so is available).

Manual Issue Keys are typically used when a driver key is unavailable, and it does not make
sense to encode another key. Another example is in an emergency where out of area
vehicles, such as Ambulances or Fire Trucks, can be fueled and the amount of fuel
dispensed can still be tracked.

When a transaction is authorized using a Manual Issue Key, the user is prompted to enter
their User ID and/or Vehicle ID depending on the system type and the option settings in the
FMU. For more information on the way the Manual Issue Key behaves at the FMU, see the
Site Operations Manual.
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Manual Issue List

Displays Manual Issue Keys currently encoded.

'E Manual Issue List (B E

Manual Issue(s) |

%

Manual Issue 1D | Description | Prokee Encoded

Close

Manual Issue General Tab
Manual Issue ID

Enter an ID for the Manual Issue Key; can be 8 alphanumeric characters.

EManual Issue ID [NEW] == &
General |Mlsc ‘
Manual Issue ID* ‘| :l
Description ‘ Q
Customer ID-* ‘ =] CustName: _
Prokee Type Manual Issue Q
Reissue Count 0 Prokee Options Cancel
Date Reissued: 4/7/2020 1:25:03 PM r
Encoded No ~
Date Encoded: 4/7/2020 1:25:03 PM Auhonzed
Authorized Yes PIN Number:  None 4
Date Authorized: 4/7/2020 1:25:03 PM
Internal Key Number

Customer ID
Ties the Manual Issue Key to a Customer for accounting reports.
Prokee Options
PIN and Receipt can be prompted for by the FMU.
Status Fields
® Key Type - Vehicle, User, Tanker Truck, Supervisor, Manual Issue
® Date Reissued - Date key was re-encoded
® Encoded - Status of record being encoded or not
@ Date Encoded - Date key was initially encoded
o

Authorized - Vehicle Key/Smart Card is authorized or unauthorized
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® Date Authorized - Date the key/Smart Card was last authorized
Authorized

This check box is available after the key is encoded; removing the check mark de-
authorizes the key.

Manual Issue Misc Tab

Used to configure miscellaneous settings to account for Manual Issue Key fueling. The
miscellaneous fields can be defined in Configuration > System. Each field listed below, can
be used in reports and Custom Exports.

ﬁManual Issue ID [NEW] /?
General Misc |

Agency ’—I :
Organization: -] |
Usage ’7 Q
Date Service Began: ‘ 4/ 712020 J Q
Misc 1 ’7 ﬂ
Misc 2 ’7
- ’7 Authorized
Misc 4 /7 .
Misc 5 ’7
Comment ‘

Agency This field is encoded on the key; can be up to 5 numeric characters; and can also
be prompted during a fueling transaction.

NOTE The prompt option can be enabled by a FuelMaster Certified Technician or CSC
who can be contacted via phone 1-800-888-9136 ext. 2.

Organization

An accounting field not encoded on the key; can be 3 alphanumeric characters.
Usage

An accounting field not encoded on the key; can be 6 alphanumeric characters.
Date Service Began

Displays the date the key record was created.

Miscellaneous Fields

These five miscellaneous fields can be used for added accounting; can be 15 alphanumeric
characters.
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Chapter 9 AIM Software Operations

The Automotive Interface Module (AIM) system controls access to fuel with RFID
technology that communicates between fuel nozzle and filler neck for a specific vehicle.

AIM also provides data directly from the vehicle’s On-Board Diagnostic (OBD) computer,
accurate odometer and hour meter readings.

NOTE This chapter covers the software portions of our AIM passive fueling system.
Installation and site operations instructions can be referenced in the A/IM
Installation and Site Operations Manuals.

AIM Programming

AIM Programmer List

Access the AIM Programmer list from Tables > AIM Programmer.

The AIM Programmer key allows programming AIM modules at the FMU and should only be

issued to operators allowed to change AIM record data and installations.

Tables Operaticns  Systern  Reports
= Vehicle.. Ctrl+F3
€7 User. Ctrl+F6
B site. Ctrl+F7
a8  Tanker Truck... Ctrl+F9
fa”  Supervisor...

Manual lssue..,
W4 Customer... Ctrl+F2

Products...

AlM Programrner...

Agency...

Departrent...

Organization...

NOTE AIM Programmer Keys may only be used at the FMU when the Plus with AIM Prog

FMU type is set for the Site.
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The AIM Programmer List displays the Programmer ID, Name, and if the key has been
Encoded.

Each record can be accessed by double clicking the desired record or by highlighting the
record and clicking Open.

'i‘é_i AIM Programmer List

AIM Programmer(s) |

AIM Programmer ID: AIM Programmer Name I Encoded |

This key is also used when AIM modules change vehicles and need to be programmed with
a new Vehicle record.

AIM Programmer General Tab

Displays information to identify the operator issued the key.

[l

=

=i AIM Programmer 1D [NEW]

General ] PROKEE ]

[ ]
AMPrgD: T
Last Name: li First Name: '7
Midde sl [ [ B |
Agency:
Cirganization: Cancel
Phone Mo: -
FAX No: '7

Autharized
E-Mail: |

[V PROKEE

Comment: |

Encoded: NO

If Authorized Prokee is checked, the key is authorized. If the check is removed, the key is
unauthorized once the Authorization List is sent to the FMU Sites.
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AIM Programmer PROKEE Tab

Displays the key information such as the Prokee Type, Reissue count (number of times the
key has been replaced), and date of last reissue, date the key was initially Encoded. If the
key is currently Authorized, the date the key was Authorized, Internal Key Number, and
PIN Number will appear (used if the PIN checkbox is checked).

i AIM Programmer ID [MEW] =] & =
General

Prokee Type AIM Programmer Prokee Options
Reissue Count: 0 g
Date Reissued: NA Q
Encoded: Mo
Date Encoded: NA Cancel
Authorized: ‘fes
Date Authorized: 2/8/2018 10:45:42 AM Autharized
Intemal Key Number: V¥ PROKEE
PIN Number: NA

AIM Vehicle Record

To add AIM features with additional options to a vehicle record, enable the AIM checkbox.

55 Vehicle ID 0000A0D1 =] = [
Chrono 2 | Chrono3 | OBD Trouble Codes | OBD Statistics | Interface |
General | Products® | PROKEE | Misc | Odometer | AM | Chrono1 |
Vehicle 1D |::::;_::1 Agency: | j m
Vehicle Description: % - Ford F-150 Reiszue
Customer |D:* 00000000 ~| ~Customer Name
Vehicle Year: 2000 The One Cancel
fecei e FORD ~| ¥ Uncheck to Remove AIM
Vehicle Model: F-150 - Aot
Encoded: NO ¥ Prokes
Passive Status ¥ AlM
\AIM Program Pending - The AIM vehicle record is enabled and ready to be W KEYPAD
programmed.

A Passive Status dialog on the Vehicle General tab shows the status of the AIM module.
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AIM Tab
Contains Info, Options, Notes, and Status information for the AIM module.

Selected Options are sent through FMPlus to the AIMs.

[ Vehicle 1D 00004001 o] & =]
Chrono 2 Chrono 3 OBD Trouble Codes CBD Statistics Interface
General | ]Products' | IlHOKEE | Misc | O]dometer AlM ]l Chrono 1 {
Irfa Encode
AIM 1D: FW Version: ™ Print Receipt Reissue
Authorized: [YeS  Date Authorized: 12772017 11:10:04 AM
Options Q
™ Fuel With Engine On [ Use Metric Units
[~ Disable Timeouts [ Enable FOIOS Pl
[~ Disable SVT
[~ Enable FOSS Authorized
Notes W Prokee
1 - Pending verffication (AIM FW version not recieved) 2 - Option not supported v AlM
Status W KEYPAD

AIM Program Pending - The AIM vehicle record is enabled and ready to be
programmed.

The Status of the module is displayed in the bottom section of the tab. There are three
different AIM status descriptions:

@ AIM not Enabled - the vehicle record is not enabled as an AIM vehicle. This message
displays if the Check to install AIM box on the General tab of the vehicle record is
not checked. Check box and click OK to save; then reselect the record.

® AIM Program Pending - The AIM vehicle record is enabled and ready to be
programmed but is pending programming of the AIM module on the desired vehicle

at the fuel site. The record will not exist at the site until the AIM Programming List
has been sent to the sites.

® AIM Program up to date - The AIM is installed and programmed. No new

programming is pending. The AIM module has been programmed in the specified
vehicle.
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AIM Chronometers Tabs

Use the Chronometers tabs to track Engine Idle Time, Engine Run Time and PTO Time.

IF —
T3 Vehicle ID 0000A001 o] = ==
Chrono 2 | Chrone3 | OBD Trouble Codes | OBD Statistics | Interface |
General | Products® | PROKEE | Misc | Odometer | AIM  Chrona 1
™ Bhvoneneier | et
Type: |Engine Run Time r Channel: |1 Reissue
Curmrent Reading:
Fuel Range: 0 Expected Eficiency 1
LCancel
-
PM Range: 0 PM Netice |10 Update... Autharized
¥ Prokes
Mext PM Reading: |0 ¥ A
W KEYPAD
Comment:

Up to three Chronometers can be configured per AIM in each vehicle record. The
Chronometer interface may be analog and/or OBD. The AIM does not go to sleep when any
configured chronometer is active; and the AIM awakens when any configured chronometer
becomes active. A Preventative Maintenance (PM) option can be configured for each
chronometer. When the PM option is checked, set the PM Range, the PM Notice, and next
PM Reading.

AIM OBD Trouble Codes Tab

OBD trouble codes are read when the vehicle stops in range of an FMU if the engine has
been running at least one hour since the last trouble code report was sent.

(=] & =]

[ Vehicle 1D ooo0A0OT

General | Products® | PROKEE | Misc | Odometer | AIM | Chrono1 |
Chrono 2 ] Chrono 3 OBD Trouble Codes l OBD Statistics ] Interface ]

Index | Serviced | Status | Description m
Beissue
LCancel

Authorized
¥ Prokee

Activate v Al

¥ KEYPAD

< >

Deactivate Al Deactivate |

Run Reports > OBD Data > Active Trouble Codes to track vehicle trouble codes.
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AIM OBD Statistics

This section covers a wide range of different readings from the OBDII port to show the

Tab

statistics of the venhicle.

These fields provide information on how well the vehicle is being maintained.

Chapter 9 AIM Software Operations

T4 Vehicle ID 00D0A0D1 e & ==

General | Products® | PROKEE | Msc | O Chrora 1 |

Chrono 2 ] Chrono 3 ] OBD Trouble Codes Interface ]
Maximum Speeds Maximum Temperatures Mirimum Pressures Encode
Engine: MN/A Coolant: MNAA Engine Qil:  N/A Reissue
Vehicle: N/A Gil: MNAA Transmission MN/A =

Fluid:

Cther Battery Voltage Current Fluid Levels Caeel
Ignition Start Count: ~ N/A Max: MNA& Engine Oil: MN/A
Hard Braking Count: 0 Min:  N/A Transmission:  NAA
Rapid Acceleration: 0 Coolant: MNAA Autharized
Engine Oil Life 0% Washer: N/ ¥ Prokee
Eohag Prefuing  N/A W AIM
AUX Pulses: N/A Level: W KEYPAD

AIM Interface Tab

Records the AIM configuration as reported from the AIM back to FMPlus.

B3 Vehicle D 0D00A0DT =]l B S

General | Products” | PROKEE | Misc | Odometer | AIM

Chrono 2 | Chrono3 | OBD Trouble Codes | OBD Statistics [ox |
Encode

Misc: FW Version:

Interface: Data Format: m

Protocol: Odometer Source:

Odometer Method: Date/Time:

Slope: LCancel

Intercept:

Raw Odometer Data:

Calib Point 1 Vehicle Datar: Authorized

Calib Point 2 Vehicle Data: ¥ Prokee

Calib.Point 1 User Data v &M

Calib Point 2 User Data v KEYPAD

AIM supports a premium feature that detects and automatically captures the vehicle
odometer directly for light duty CAN vehicles. When implemented, this feature collects and
reports the vehicle odometer to FMPlus where it is shown in the Vehicle Record and various
reports. The Dash Odometer feature requires purchase of a customization to FMPlus. See
Dash Odometer for AIM2.4 & AIM Titanium for details.
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AIM Bulk Installation

Install AIMs on Fleet Modal

Access the Install AIMs for Fleet modal from Operations > Install AIMs on Fleet.

The Install AIMs for Fleet modal allows installation and uninstallation of AIMs on the entire

Chapter 9 AIM Software Operations

a3

B

(2N

F® Plus

Operations = System Reports  View Windows Help

Go Online with FMUs... Ctrl+L
Polling Report Query... Ctrl+Q
FMU Console Ctrl+F
Batch Encoding... Ctrl+B
Display a PROKEE Contents Ctrl+K

Manual Entry Transaction...
Inventory Editor...

Archive And Restore Transactions...
Transaction Export...

Archive Transactions History Query...

Adjust Price Level for Transactions...

FMU Diagnostics...

Update Dash Odometer Data Sets
FMLink Export...

Install AlMs on Fleet...

fleet of vehicles. This feature is ideal for situations when installing AIMs one by one via the
Vehicle General tab would be time consuming. AIM Feature and Chronometer Settings may

be toggled prior to install to create a uniform configuration for the Fleet.
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Chapter 10 Communication with the FMU

FMPIlus primarily interacts with the FMUs by uploading site configurations, prices and
authorization lists to said units and downloading transactions from them. In addition,
interaction is required for Prepaid operations, Discount Credit card operations, AIM
programming, TMU interfacing, Credit Card batch reports, and Local Authorization lists.
When any of these items are configured in FMPIlus, they must be sent to the FMU before the
options are active at the fuel island.

Most online communications are handled through the FM Download Service(s). Each
FMPIlus instance can run a FM Download Service. The Service allocates tasks between
Services to increase efficiency and reduce overall download times. It does not include
communication with the FMU via the FMU Console. For more information, see:

® MultiPoint Download Service (MPDS)

® MPDS Online Client Permissions

Online Communications

To access communications, click Online on the FMPlus toolbar, by Operations > Go Online
with FMU'’s, or by hot keys CTRL + L.

Online Client
The Online client opens on the Manual Download tab.

Select Sites in the list box. Select Download Options. Click Connect to begin an online
session.

* FuelMaster(R) Plus Download Service Client - [m] x

L
TS EUELMASTER

ENcINEERED BY SUNCECH
Archived Messages Service Requests Auto Download [YEUNETsRwtitee]

Configure Download Options For Sites

Select Al
[#10001  Rooster
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Disconnect is active during an online session and can be clicked to interrupt the session.
Allow 60 seconds for the disconnection to complete before closing any windows.

The Download Options vary by System Type.

Auto Download

Chapter 10 Communication with the FMU

Auto Download is used to begin communication with the FMU at predefined times using the

options selected on the Auto Download tab. The frequency of the Auto Download can be

done daily, weekly, once, or in periodic time intervals.

To enable an Auto Download, set the schedule options and click Schedule.

Stop will interrupt the online session.

Remove Schedule deletes an Auto Download.

01/08/2024

= FuelMaster(R) Plus Download Service Client

<
S EUELMASTER

enoiNEERED 8y SUNEECH
Archived Messages Service Requests [WGENEIIGEGE Manual Download

Configure Download Options For Sites

] Select Al

[[looo1  Rooster Download Options
[] Download Passive Mobile Transactions ] Download Transactions
] TMU Interface [ Send Pricing
[ Batch Report [ Download OBD Data Logs
] Download Data Logger Files [[] Vehicle Lockout List
[ User Lockin List ] Keyless List
[ AIM Programming List [ AIM Lock List
[ Upload Firmware Image File

Schedule Auto Download

Frequency | One Time  * Start Date [2/8/2018  [13] | startTime | 201 o ]~

Schedule not set

Schedule
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Service Requests

Service Requests shows pending online sessions.

* FuelMaster(R) Plus Download Service Client

S
TS EUELMASTER

eNciNEERED BY SUNEECH
Archived Messages Auto Download Manual Download

Pending Download Service Requests

Request Date Message Type Site Information Status

3/28/2018 82218 AM  MANUAL DOWNLOAD REQUEST SENT TO SERVICE

Sort By

No Sorting ¥

Archived Messages

Once online sessions have completed, they are shown on the Archived Messages tab.

* FuelMaster(R) Plus Download Service Client — O x
S EFUELMASTER
ENnciNEErRED BY SUNEECH
Service Requests  Auto Download Manual Download
. Sart By
Completed Download Service Requests No Sorting *

Request Date Message Type Site Information Status

3/27/2012 439:01 PM MANUAL DOWNLOAD COMPLETED
3/23/2012 3:29:41 PM  MANUAL DOWNLOAD COMPLETED
3/23/2018 3:1419PM  MANUAL DOWNLOAD COMPLETED
3/23/2018 3:14:19PM  UPLOAD SITE CONFIGURATION 0002 COMPLETED
3/27/2012 41626 PM MANUAL DOWNLOAD COMPLETED
3/27/2012 44450 PM  RECURRING AUTO DOWNLOAD COMPLETED
3/27/2018 4:31:21PM  MANUAL DOWNLOAD COMPLETED
3/27/2012 42413 PM  MANUAL DOWNLOAD COMPLETED
3/27/2012 431:21 PM UPLOAD SITE CONFIGURATION 0001 COMPLETED
3/23/2018 3:10:00 PM  MANUAL DOWNLOAD COMPLETED
3/23/2018 3:36:54 PM  MANUAL DOWNLOAD COMPLETED
3/23/2012 3:10:00 PM  UPLOAD SITE CONFIGURATION 0001 COMPLETED

Remove
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Service Configuration for Download Service

To stop or start the Download Service on the Central Controller, click System > Service

Configuration.

Chapter 10 Communication with the FMU

Systern | Reports  View Windows Help
Configuration... Ctrl+G

Reconnect te Dial-Up Server...

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...
Operator Options

Database Utilities
Database Manager...

Command Line Setup & Helper...
Customizations

Pelling Report Configuration
Reset Downlead Path...

Highlight the FM Download Service, then click Run Service to start or Stop Service to stop

the Download Service running on the Central Controller. You will need to do this on each

machine running MultiPoint Download Services (MPDS).

Only use Install Service or Uninstall Service as advised by FuelMaster Customer
Satisfaction Center. The Options on this dialog do not apply to the Download Service.

01/08/2024

ity FM Service Controller *
Service Name Status
FM Download Service Running

Uninstall Service

Run Service

Stop Service

Options...
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To see the current status of all Download Services, click View > List Download Services.
This displays information about the Download Services. For more information, see
MultiPoint Download Service.

i) rvice List BEE
] Service ID ] Service Name I Workstation Name I Status l Last Updated I Version ] Comments
1 lefccaif-7f82-4eec... C:\Program Files (x86... ENG_TEST12 RUNNING 09/17/2019 14:59:22  5.20.0.16 Master Service.
2  ¢3649b16-26ca-4f0... C:\Program Files (x86... ENG-TEST6 RUNNING 09/17/2019 14:59:23  5.20.0.16
3 efé6ff2b6-ccf7-40f2-... C:\Program Files (x86... ENG_TEST26 RUNNING 09/17/2019 14:59:12  5.20.0.16
< >
Global Purge View Comments Close I

Polling Reports

When a manual download occurs, FMPIlus displays a Polling Report showing the results of
the online session. To set the options for the Polling Report, select System > Polling Report
Configuration.

Systern | Reports  View  Windows
¥ Configuration...

Reconnect to Dial-Up Server...

Help
Cirl+G

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...
Operator Options »

Database Utilities >
Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...
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The Polling Report can be set to auto print or be auto-saved in a variety of file types. When
the Polling Report is setup not to display on screen, it is still available from Operations >
Polling Report Query.

ﬁﬁ Polling Report Configuration EIE@
Select the Save as ...Polling Report File Type
File Type : |Text for ASCII |
¥ Show onSceen [ Auto Print IV Message Transaction Report
¥ Print Header [v ©Odometer High/Low Messages
Normal Report ¥ Hose into Auto/Manual Messages
¥ Fuel Site Summary Report [v ©Odometer Update Message
[¥ Costing Errors Report [¥ PM Warning Messages
|¥ Transaction with No Vehide Mumber ¥ Gate Messages
|v Semi-Manual Transaction Report ¥ Semi-Manual Enabled Disabled
[+ Zero Quantity Transaction Report ¥ Mobile Transaction Markers
IV Power Fail Report ¥ Hose shutdown/Re-Enabled
|¥ TMU Alarm Report ¥ Door Messages
W' Pump Prices Report v Car Wash Messages
V' PIE Exceptions ¥ Terminal Shutdown
[¥ AIM Exceptions ¥ Daily Quantity Limit
Cancel

The Polling Report is comprised of a series of smaller reports that can be turned on or off
based on user privileges. The Polling Report Configuration has two sub-report areas: normal
and messages.

Pump Prices Report

This report is used to ensure that the prices stored and used in the FMU are the same as the
current prices set in the software. This makes it an excellent tool to detect incorrect
transactions.

NOTE This only works for the last download.

Message Reports

Message Reports are used to display events that occur at the FMU. One of the most useful
Message Reports is the PM Warning Report which shows when a Vehicle has passed its
mileage for Preventative Maintenance.

Polling Reports for Auto Downloads

To generate Polling Reports for Auto Download sessions, open Config > DL Service, and
check the box to Display autodownloaded polling report on this computer.
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The Polling Report Configuration must also be set to Show on Screen in the Polling Report
Configuration.

ol

[ Configuration

Info | System | Hardware | Encoder DL Service | Firmware | AIM |

‘Always start FM Download Service when loading FuelMaster [

Display autodownload polling report on this computer N

Force starting Download Service as normal .exe I_

Download Path Options

T, |\\ENG_TEST26‘.FMP Downloads top . exe nov

~Data Logger Options

Save Data Logger Files To

Folder: IC:\ProgramData\Smtech\FuelMaslerPlus\dowrloadFles

Browse...
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Chapter 11 FuelMaster Reports

FuelMaster Reports

FMPIlus has the capability to provide a large amount of information on the status and
activity of FMU units at the fuel island. It also brings back a large amount of data
pertinent to the maintenance and status of vehicles fueling. This information is stored in
the database and is made available using the FMPIlus reports package. These reports
are generated using a Crystal Reports engine and have many different sorting and

grouping abilities.

To enable and run Crystal Reports in FMPlus, an ODBC Data Source Name (DSN) must
be configured to connect to the FMPIlus database and be set in System > Database
Manager. For detailed information, see ODBC Connections for Reports.

Report Configuration

FMPIlus’ standard report package is supplemented by the ability to do custom reports
for our customers. If you have a custom report, or are advised someone else’s custom
report will work for you, configure it using the report configuration option.

From the System menu select Report Configuration.

'\ Configuration...

Reconnect te Dial-Up Server...

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...

Operator Options

Systern  Reports  View Windows Help

Ctrl+G

From the Report Configuration interface, select the Report Type, the report it is based
on, and the custom report that meets your needs. If you need advice or assistance,
please call CSC at 1-800-888-9136 ext. 2.

01/08/2024

E FuelMaster® Plus Report Configuration - Version 5.15.3.0

Repart Type Systern Heports
Base On | P activity ~]
Custorn Report |DDD - Standard FuelMaster® Plus Hej

Save

4

Cancel
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FMPlus Standard Reports

FMPIlus has a wide variety of standard reports. A general overview is provided for each
report type.

Standard reports can be accessed using the Reports menu.

Reports  Wiew Windows Help

Report Explorer

System ¥
Transactions ¥
Invoices ¥
Site ¥
Vehicle >
User ¥
Customer ¥
Litility ¥
Prepaid Cards >
OBD Data ¥
Preventative Maintenance ¥

FMU Activity Report

The FMU Activity report displays a month to date and year to date summary of fuel
transactions of each hose per site. It also displays a summary of Tank adjustments for
the site.

Feports View Windows Help
Report Explarer w B
System ¥ FMU Activity .

Transactions ¥

1
| ]
e
=

Inmvoices »
Site 3
Vehicke 3
Liser »
Customer »
Lillity ¥
Prepaid Cards 3
OBD Data »

Preventative Maintenance »
T ————————

01/08/2024 © Syntech Systems, Inc. 2014-2023 101



FMPlus User Manual
Document Version: 9.0

Transaction Reports

Chapter 11 FuelMaster Reports

Each transaction report category may have sub-categories. Reports can run from any

of the sub-categories.

These reports can help you find transactions to review. For example, the Credit Card
Type Report can help locate a Credit Card transaction via the brand of the card, i.e.

Visa, MasterCard, WEX, etc.

Reports  View Windows Help

Report Explorer
System
Transactions
Imvoices

Site

Wehicle

User
Custormer
Uity
Prepaid Cards
OBD Data

Preventative Maintenance

Vehicle

Lizer

Site

Customeer
Transzaction Code
Inactivity
Product

Credit Card Type

Disicnal Fuel Usage

Invoice Reports

Invoice customers for fuel they receive.

The report can display individual transaction details as well as total number of
transactions, total quantity, and total cost in a specified date and time range.

PIE Exceptions

Report Explorer
System
Transactions
Inveices

Site

Vehicle

User
Customer
Utillity
Prepaid Cards
OBD Data

Preventative Maintenance

Reports View Windows Help

F % 2
»  hoole About (=]
LA |

¥ Vehicle

¥ LUser

L] Site

» Customer
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Site Reports

Displays information regarding the site location and inventory status of the tanks.
Inventory and Delivery reports provide a variety of options for inventory management
data retrieval. For example, the Inventory Report displays current tank inventory at the
specified site, such as Last Delivery and Last Stick Reading.

Reports  View ‘Windows Help
Report Explorer ? 5&
System »  psole Fbout Ext
Transacticns »
Inwoioes ¥
Sae ¥ Site
Vehacle ] Inventany
User ¥ Defirvery
Customer ¥ Terminal Shatdosm
Utility ¥
Prepaid Cards E]
080 Data L
Preventative Maintenamce b]

Vehicle Reports

Displays the status and general information for all vehicle records stored in the
database. This includes all data stored on Prokee/Smart Cards for each vehicle.

For example, the Efficiency Report shows gallons fueled and odometer readings to give
approximate MPG readings. AIM Status and History Reports show the current state of
AIM records, historical programming, installing, updating, and other non-transaction
data.

Reports  View Windows Help
Repent Explover B’ ? %
System yocle About Ea
Transactions
Invoices ’
Ste >
Vehacle > Vehicle
Uses > Efficiency
Customer b Authorzed
Utility » Unauthonzed
Prepaid Cards > Vehicle Listing
OBD Data > AIM Status
Preventative Mantenance > AlM Hestory
Ingress / Egress Repont
Dady Quantiey Lienat
Travel Datance
Fuel Usage
Vehicle Odometer Status Report
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Vehicle Odometer Report
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The Vehicle Odometer Report is only available if the Dash Odometer customization has

been implemented. See Appendix D Dash Odometer for AIM2.4 & AIM Titanium.

User Reports

Displays information on the selected Users, including whether the record key has been
encoded, authorized, or unauthorized.

Customer Reports

Displays Customer information, Point of Contact, the Vehicles and Users assigned to

the Customer.

01/08/2024

Reports  View Windows Help

Report Explorer
System
Transactions
Imvoices

Site

Vehicle

User
Custorner
Lrility
Prepaid Cards
QB0 Data

Preventatice Mantenance

B
nesle

2
Rpout

By
Bt

User
Authorized
Unauthonzed

Reports  View

Report Explorer
System
Transactions
Invaices

Site

Vehicle

User
Customer
Ltility
Prepaid Cards
OBD Data

Preventative Maintenance

Windows Help

B | At

By
Bt

Customer
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Utility Key Reports

Generates a listing of the Supervisor, Tanker Truck and Manual Issue keys. The
description, Customer ID, Key Type, etc. identify the key and options.

Reports  View Windows Help
Repaort Explorer ﬁ o i
System »  fsoke About Ext
Transactions ¥
Inngeces »
Site: »
Vehicle »
User »
Customer »
Utility » Key:
Prepaid Cards » Authaorized
OBD Data ¥ Unauthorized
Preventative Maintenance » I

Prepaid Cards

If you have purchased this option these reports provide Unclaimed Credits listing the
Prepaid keys, Owner ID, Amount of outstanding Credit, and the Balance on the Card.
Card History displays all card information, such as date the record was created, date
card was encoded, and any credits or deductions.

Reports  View Windows Help
Repart Explarer
System

L3
=

L]
pscie | About

Transactions
LT

Sate

Vehacle

User
Customer
Uhality
Prepaid Cards
08D Data

Preventatroe Mamntenance ¥ I

w LR W W W W W W W
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OBD Data (AIM Only)
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Generates vehicle information gathered from the on-board computer from active AlMs.

Repoets  View Windowi Halp

Repert Explorer E, g $
Systemn bacle  fbout Exit

Transactions
Imvoices

St

Vehacle

Customer
Lhalaty
Prepaid Cards

0ED Data

Preventative Maintenance

Actnoe Treuble Codet

3
3
3
E
3
User ¥
H
3
3
¥
» Trouble Code History

I Extendied Viehigle Dats Repert

Preventative Maintenance

Retrieves a list of vehicles that are either overdue or over notice based on the current
odometer reading of the vehicle.
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Reports  View Windows Help

Repart Explorer E;
System » pacle

iF

7
Rbout

Transactions »
Irvoices ¥
Site b
Vehicle 2
User »
Customer »
Uity »
Prepaid Cards »
OBD Data ¥

Preventative Maintenance 3 PM Orver Due

| PM Crver Motice
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Chapter 12 Exporting Options

FuelMaster offers the ability to export data from FMPlus to a file that can be imported

into other software. The format and data contained in the export differs depending on
your needs. The standard set of exports are requested by customers on a regular basis
and may meet your needs.

FuelMaster can customize an export if you need something to change or new data to
be added. To request a customization, contact your salesperson.

Export Configuration
Select Export Configuration from the System Menu.

Exports in FMPlus are flat ASCII text files with varying field orders, delimiters, and data
sets. There are common exports used by our customers provided free of charge with
FMPIlus. The format of these exports can be obtained via CSC, 1-800-888-9136 ext. 2. If
none of these formats meet your needs, contact your salesperson about a custom
export order.

System Reports View Windows Help
~ Configuration... Ctrl+G
Reconnect to Dial-Up Server...
APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...

Operator Options b
Database Utilities >
Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...
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Export Configuration Tool

Chapter 12 Exporting Options

Select the export type; then specify the location and name of the export file to

generate. The location and file name can be

left as the default or changed.

The Auto Export option generates an export immediately upon download completion.

For exports using transaction counters, specify the counter minimums and maximums.

% Export Configuration Tool

Selected Export Type:

Delete Export Table |

Export Method:

Test

Automatically Print Export Report
Short exported transactions counter
Minimum Maximum
1.=1| 999999999 - |
L] [ |

Status

Init export config dialog...
Config dialog ready...

Automatically export transactions after transaction download.

X

2500 Plus Standard -
|Fi|e ﬂ
-
=

Total exported transactions counter

Minimum Maximum
1=1] 999999999 - |
-] L]

OK

Cancel

Transaction Export

To export transactions manually, select Transaction Export under the Operations

menu.
Operations System Reports View Windows Help
& Go Online with FMUs... Ctrl+L
Polling Report Query... Ctrl+Q
# FMU Console Ctrl+F
Batch Encoding... Ctrl+B
& Display a PROKEE Contents Ctrl+K
Manual Entry Transaction...
Inventory Editor...
Archive And Restore Transactions...
Transaction Export...
Archive Transactions History Query...
Adijust Price Level for Transactions...
FMU Diagnostics...
Jpdate Dash Odometer Data Sets
FMLi
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Transaction Export Interface

The Export Interface allows you to view and manage transactions that will be written to
the export file. The list shows transactions that meet the criteria selected from the
Show options. Exportable transactions are those that will be written to the file. Detain
transactions to review for possible later export and not include in the file. Delete to
mark transactions deleted and to discard after the export is complete.

lE‘_ﬁ'{ranzactimﬁE)<porl: o (&8

Erpart Transactions Shaw
CC TransH | Export Status | Code | Site Id | Tran Time Userld|  Wehicle | || © &l
" Espartable

" Detained
" Deleted

- 1C

)

Selection

Delete
Detain

Exportable

Stats Status
Tatal: ] Attempt to fil Record array.
Loaded O export tranzactions into memary.
Modity field name array.
Expartable : o Attempt to insert records inta custom export
Moved 0 tranzsactions into custom export table

. Hemave any transtable dupes from export table
Detained : 1} Success.

Config

View Last

m

1

Deleted : 1} = r we Status...

»
(7
W
=
[=]

A report is generated at the time of export to provide a summary of the export.

This report can be configured, and the list can be viewed. When all options have been
configured, click Export to write the file.

Fuelmaster D etailed Export Report
Print Tirae: 0F|1 2|08 10:32:53 PM Page 1 af 1

Trans Time Tank Numher Hose Product Code Vehicle-=0Org  UniiCost Quantity ToialCost
Sibe- > Hawe: WEST Fueling §iation
Eroduct-> Desc: Diesd

Summnary for Frodwo-=Tesc: Diesel Totalfor 1 Tramnes actions 3 56 oo

Suman foxr Sibe->Name WEST Fuding Sia Totalfor 1 T actions 31 56 [T1]
Grand Toiak Quantity ToialCost

Total for 1 Transactions 32.56 0.00

Filter by Transaction Code (TC) in Export View

If the transaction code (TC) is being exported, users can filter records by TC as well as
by Exportable, Detain, Delete, and All. Clicking on the radio button causes the view to
display only transactions with the TC chosen in the combo box. These controls are
hidden if TC is not part of the export definition.
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Chapter 13

FMPIlus security features allow the administrator to control who has access to what

Administration

Chapter 13 Administration

parts of the software and how that access is managed. FMPlus has data and operations
that are sensitive in nature. Security options allow or restrict access to a wide range of

program functions. In addition, the Security Configuration feature lets you define
security record requirements and management settings, like expiration dates, number

of incorrect login attempts allowed, etc.

Security Configuration

The Security Configuration for FMPlus can be accessed via the System menu.

These settings can be made to be as secure or as open as each customer’s
circumstances require. Understand, however, that tight security can be both a benefit
and, in some cases, an inconvenience. Choose a reasonable security configuration for

Systern | Reports  View  Windows Help
> Configuration... Ctrl+G

Reconnect to Dial-Up Server...

APM Product Config
Export Configuration...
Repeort Configuration...
Security Configuration...

Service Configuration...
Operator Options ¥

Databaze Utilities ¥

Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...

your installation and the users of the software.
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Security Settings Tab

'g Security Configuration X
Security Setttings | Log Events |
Login Name [ Restrict Password Reverse
Operator Login Minimum Length: [N _~ 0 ~ | Restricted Password Shift Characters
m Password Fail LockOut
[~ Password Exclude Words ! =] Minimum Longin
o _~ | Minimum Numeric characters
’7 A [‘3 E Minimum Alpha characters
J 0 ~ | Minimum Upper Case Alpha characters
0 ~ | Minimum Special characters
[~ Password Exclude Substiings 0 ¥ | Characters NEW password differs from OLD password
I Never ¥ | pays Until Password Expires
’7 0 ~ | Expiration Wamning Days
0 ¥ | Passwords Unfil able to Repeat
0 ~ | Days Until Password able to Repeat
Jeset ALL Passwnrd4 Save Cancel

Login Name
Establishes the minimum length of the Login Name.
Exclude Words

Sets words that cannot be used for passwords such as company name, location or
admin.

Exclude Substring

Restricts the use of substrings from passwords such as 12345.

Restrict Password Reverse

Keeps users from establishing a new password by reversing their current password.
Restricted Password Shift Characters

Number of characters the password must differ by each time the password changes.
Password Fail Lockout

Number of times you can enter the password incorrectly before the login is locked out
until an administrator unlocks the user login.

Minimum Length

Setting that declares the minimum length of the password.
Minimum Numeric Character

Password requires at least this many numeric characters.
Minimum Alpha Character

Password requires at least this many alpha characters.
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Minimum Special Character

Password requires at least this many special characters. Examples: [ |{@#$%" ]
special characters that may not be used in passwords include: < > “: and;

Characters New Password Differs from Old Password
Distinguishes how many characters must be different from the old password.
Days Until Password Expires

A password change can be set to prompt the user. They will need to establish a new
password before the days expire.

Expiration Warning Days
Warns a user they need to change their password before it expires.
Passwords until able to Repeat

Number of stored historical passwords that rotate until a previous password can be
reused.

Days until Password able to Repeat

Limits number of days before a password can be repeated.

Log Events

Set the events that will be recorded in the database as an audit trail for security
operations, changes, errors, etc.

Select the log events you desire using the Events check boxes. Click Save.

B Security Configuration X

Secuiity Setitings Log Events

[+ Events

¥ Login Attempt Status

[* Opesator LockOut

[+ Opesator Priviege Change
[+ Opesator Authorization

¥ Opesator Unauthonzation
[* Opesator Unlock

[ Opesator Password Change
[¥ Secuity Config Modification

Jeset ALL Passwordy Save Cancel
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Operator Options

Individuals who are allowed access into FMPlus enter a username and password.
Operators can be assigned specific permissions for software operations using the List
Maintenance menu, which raises the Operator List dialog box.

Systern  Feporti View Windows Help

W Configuration Culelz K »
Rbcesnct 1 Dial-Lip Sensr L
AP Produst Config
Expont Cantiguration
Pagecait Coaiagpmalican.
Senaity Configueation
Servioe Configuration
Operaios Options » List Masnienare._.
Databuase Ltilitie ] Charepe Parssweoid
Databuase Masager Re-login
Conmriand Liss Setuns B Hihoer Aamg Dererload Chptaond
Cumibosmiratics
Prling Repeoit Confgunation
Fiprt Download Path

Operator List

Displays current operators with access to the software. The ADMIN operator is set by
FMPlus. Add an operator by entering the name in the Operator field and clicking New.
Enter information about the Operator.

"Bs( Operator List = e s

Total Records: 1

Login: Operator Name:
ADMIN FuelMaster Administrator

Operator: New... | Open... | Close | Search |

The Login column refers to the operator name used to login to FMPlus. Once an
operator name has been established, a dialog displays with a series of tabs to authorize
access to specific parts of the program for each operator.

To create an admin with all privileges, or to remove all privileges from an existing
operator, use the Select All or Deselect All buttons on the bottom of the interface.
Most tabs contain checkboxes for ‘Add’, ‘Edit’, and ‘Delete’. These control whether an
operator can create, modify, or delete the type of record for that field. For example, an
operator with only ‘Edit’ permissions on the Vehicle Tab could not create or delete a
vehicle record, but could open and modify a vehicle record.

General Tab

Identifies basic operator login information.
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il Operator Name: ADMIN X
Site ] Transactions ] Superviser & Manual lssue ] Vehicle ] User ]
Tanker Truck ] Al ] Card Owners ] Service Configuration ] ADOC ]

General Operator & Security ] System & Operations ]
First Name: FuelMaster
Middle Name:
Last Name: Administrator
|This came with FuelMaster
Comment:
¥ Authorized |Aulhorized On: 6/14/2004 12:15:21 PM
m |Un|ocked On: 1/1/1570
Delete | Select Al | Deselect Al | Set Password | OK | Cancel |

The ‘Authorized’ checkbox controls the access of the operator login. A date/time
denotes when the operator was authorized or unauthorized.

The ‘Locked’ check box is used when an operator has entered his/her login sequence
incorrectly too many times. An operator with sufficient privileges can use this
checkbox to re-enable the operator login by removing the check from the box.

Operator & Security Tab

These permissions control who has access to setup other operators and change their
operator permissions.

E_‘ Operator Name: ADMIN

[v Security Corfiguration

[ Edit

[v Delete

v Unlock

W Authorize/Unauthorize

Select Al | Deselect AJI|

Site ] Transactions ] Superviser & Manual lssue ] Vehicle ]
Tanker Truck ] Al ] Card Owners ] Service Configuration
General Operator & Securty System & Operations ]

*

User ]
apoc |

Delete | Select Al | Deselect Al | Set Password| ok |

Cancel |

Security Configuration controls the menu option Security Configuration (first section

in this chapter).
01/08/2024
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System & Operations Tab

Chapter 13 Administration

These permissions control the creation, editing, and deleting of system configurations,

products, and customizations. The list of functions in the lower left provide additional

flexibility.

ﬁ Operator Name: ADMIN

Vehicle | User

¥" Confiquration

[v" System

[¥v" Modem

[v" Encoder

v AIM

[v" Export

[v" Auto Export
[v" Report

[¥" Poliing Report

[v" Read Keys

[~ FMU Console

[¥ Poliing Report Query
[¥" Reports

[v" Import Data
[ Import Card Definitions

Select All Deselect All |

| TankerTruck | AIm

[v" Command Line Setup & Helpe

[ Online

[¥" Normal Download

[v" Auto Download

[v" Send Pricing

[v" Send Authorization

[¥" Credit Card Batch Report
[v" Send Discount List

[v" Send Prepaid List

[¥" TMU Interface

[v" Session Status Options
[ Download Data Logger
J Edit Communication Queue

[~ Send Firmware

| cardOwners | Service Configuration | ADOC |
General | Operator & Security System & Operations |Site ! Transactions | Superviser & Manual Issue |

X

[¥" Products

[v Add

[v Delete

[v Edit

[v" Edit Pricing

[v" Add Features
[v" Delete Features

Delete | Select Al | DeseleclAlII Set Password‘ oK |

Cancel I

The Online permissions authorize operators to perform functions that require
interaction with the FMU. For example, you may authorize an operator to download
transactions from a site, but might not want them to send pricing or price sensitive lists.

Site Tab

Contains permissions pertaining to the creation of Sites and their sub-elements, Tanks

and Units.

01/08/2024

% Operator Name: ADMIN

Vehicle ] User

[~ lsitel
v Add
[v" Delete
v Edit
v ™MU
[ Manage FMU FW

Select All Deselect All l

| Tanker Truck ] AlM
General | Operator & Security | System & Operations Site | Transactions | Supenviser & Manual Issue |

| card owners |

[v" Tank

[v" Add

[v" Delete

[v" Delivery

[v" Adjustment

[¥" Inventory Transfer

[v" Stick Reading

[v" Set Closeout

[v" Enable Pricing Per Tank

X

Service Configuration | ADOC |

[v" Unit
[v" Add
[v" Delete
[v" Edit
[v" Upload/Download Config

Delete l Select All l DeselectAll | Set Password‘ OK |

Cancel
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Includes permissions for control of archiving, exporting, modifying, recovering, and

updating transactions records.

Also controls permissions for Manual Entry and Database Maintenance.

Supervisor and Manual Issue Tab

Sets permissions for the Supervisor and Manual Issue key records.

E_‘ Operator Name: ADMIN

General ]
Tanker Tuck | AIM
Site ] Transactions

v Add
[V Delete
v Edit

Prokee

[V Encode
[v Reissue
[v Authorize/Unauthorize

Select Al | DeselectAII|

Operator & Security ]
] Card Owners ]
Superviser & Manual lssue

Service Configuration
Vehicle

v Manual lssue Record

[ Add
[v Delete

[v Edit

Prokee

[V Encode

[v Reissue

[v Authorize/Unauthorize

System & Operations ]

l
l

*

apoc |
User ]

Delete |

Select Al | Deselect Al

Set Password | OK |

Cancel

01/08/2024
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The Vehicle and User permissions authorize operators to create, modify, or delete
Vehicle/User records. You can also set permissions for the operator to encode, reissue
and authorize or de-authorize the Prokee/Smart Cards or AlMs.

ﬁ Operator Name: ADMIN X E Operator Name: ADMIN X
General ] Operator & Security ] System & Operations General ] Operator & Security ] System & Operations
Tanker Truck ] AlM I Card Owners ] Service Configuration ] ADOC Tanker Truck ] AlM } Card Owners ] Service Corfiguration ] ADOC 1
Site ] Transactions } Superviser & Manual lssue Vehicle User Site ] Transactions ] Superviser & Manual lssue I Vehicle User
¥ Hehicle Record
v Add v Add
[V Delete ¥ Delete
Iv Edt Iv Edit
Frokee Frokee
¥ Encode [¥ Encode
[v Reissue I¥ Reissue
Iv Authorize/Unauthorize Iv Authorize/Unauthorize
Desela Al Dessect A
Delte | SelctAl | DessectAl | SetPasswod|[ oK | cancel | Dekte | SelectAl | DesclectAl | SetPassword|[ 0K | Cancel
Tanker Truck Tab
Authorize operators to manage Tanker Truck records and Prokee/Smart Cards.
i Operator Name: ADMIN x
Site ] Transactions ] Superviser & Manual lssus ] Vehicle ] User ]
General ] Operator & Security ] System & Operations ]
Tanker Truck l Al ] Card Owners ] Service Configuration ] ADOC ]
[V Add
[v Delete
[v Edit
Prokee
[V Encode
[V Reissue
[V Authorize/Unauthorize
Select Al | Deselect Al |
Delete | Select All | Deselect Al | Set Password | oK | Cancel
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Set permissions to manage the AIM Programmer section including Prokee/Smart Cards.
AlIM Installation controls installing AIM modules in Vehicle records. Also controls the
ability to send and receive the AIM Programming List to the FMU(s).

E Operator Name: ADMIN b
Site Transactions ] Superviser & Manual lssue ] Vehicle ] User ]
General Operator & Security System & Operations
Tanker Truck AlM Card Owners ] Service Configuration ] ADOC ]
[V Add
[v Delete
[V Edit
Prokee
[¥ Encode
[V Reissue
[V Authorize/Unauthorize
v AIM Installation
[+ Send/Receive Programming and Update List
Select Al | Deselect Al |
Delete | Select Al | Deselect Al | Set Password | oK | Cancel

Card Owners Tab

If you have purchased the Local Authorization or Discount and Prepaid Card features,
you may set permissions for Card Owners, Discount CC, Prepaid, and Local
Authorization. For Prepaid keys you can also restrict the ability for the operator to

encode a Prokee /Smart Card.

E_‘ Operator Name: ADMIN X
Site ] Transactions ] Superviser & Manual lssue ] Vehicle ] User ]
General Operator & Security System & Operations

Tanker Truck ] AlM Card Owners l Service Configuration ] ADOC ]
v Card Owners [+ Discount CC [V Prepaid

v Bdd I+ Add ¥ Add ¥ Encode

[v Delete v Delete v Delete

v Edit I+ Edit v Edit
¥ Local Authorization

v Add Accourt [+ Add Lock List Entry

v Edit Account [v Edit Lock List Entry

[+ Delete Account [+ Delete Lock List Entry

Select Al | Deselect Al |

Delete | Select Al | Deselect Al | Set Password | oK | Cancel

01/08/2024
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Provides the ability to authorize interaction with various Services through the Service
Configuration tab. The FM Download Service requires the Download permission.

ADOC Tab

i Operator Name: ADMIN x
Site ] Transactions ] Superviser & Manual lssus ] Vehicle ] User ]
General Operator & Security System & Operations
TarkerTuck |  AIM | Card Owners Service Corfiguration | ADOC |
Iv Services
I
r
r
¥ Download
™ FM Socket Proxy
{Belect Al Deselect Al |
Delete | Select All | Deselect Al | Set Password | oK | Cancel

Set permissions to Add, Delete, and Edit Agency, Department, Organization, and

Customer data.

01/08/2024

E; Operator Name: ADMIN 4
Site ] Transactions ] Superviser & Manual lssue ] Vehicle ] User ]
General ] Operator & Security ] System & Operations ]
Tanker Truck ] AlM ] Card Owners ] Service Configuration ADOC
| Agencies, Depatments, Organizations, and Customers
[¥ Customer
v Add [v Add
[V Delete [v Delete
v Edit v Edit
[+ Department [+ Organization
[V Add [v Add
[V Delete [v Delete
v Edit v Edit
Select Al_| Desslect Al |
Delete | Select Al | Deselect Al | Set Password | oK | Cancel
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New Operator Login

New operators can be selected from the Operator Name dropdown list.

Welcome to Syn-Tech Systems Fuelmaster® Plus ? x

<>
S EUELMASTER

EMOIMEERED BY w cect

Login Fuelmaster® Plus Databaze Mame: OHDOT
Operatar Mame: |.-'1'-.DMIN j

Paszword: |

ok | Cancel | Switch... |

Copyright @ 1997-2021 by Syn-Tech Systemsz, Inc.
Thig computer program iz protected by U5, and Intermational copyright law.

A password is not entered for a first-time login. Prompts guide the operator to set the
password, which is then used to login.

01/08/2024

Legin Mame: ADMINZ >
A_. Please enter the NEW passward here: oK
(=
| Cancel

Please confirm the MEW passward here:
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Chapter 14 FuelMaster Tools

FMPIlus includes a set of tools to assist in managing your database and handling

abnormal situations. There are options for manual entry of transactions and inventory

data, database backup and recovery options, transaction importing, and exported

transaction recovery. These tools are provided to help fix any issues that may occur,

but FuelMaster also provides easy access to the CSC, where a technician can help
quickly resolve any issue you encounter.

FMU Console

The FMU Console allows the Central Controller to communicate directly with the
FMU to perform a limited series of diagnostic and configuration commands. The
console communicates with the FMU in the same manner as the other online FMU
functions (via network or phone line).

To access this feature, use the Console icon found on the FMPIlus Toolbar.

T FMU Console =
Ste 1. I ~ | ;. 1.\

NOTE The Download Service does not have to be stopped prior to running the
FMU Console Interface. However, there should be no active upload or
download sessions while logged on to the Console.

This feature can shut down or re-enable a specific hose position, authorize a
transaction, or configure the header and footer for your receipts.

From the FMU Console, select the Site ID or the Site Name from the dropdown
boxes and click Dial (even if you are using a network interface).

Once you have connected to the FMU, a menu appears in the main part of the FMU
console interface. Each option provided is accessed by entering the number of the
commands and pressing ‘Enter’.
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You can view the commands shown below and send commands via pass-through to

a Satellite.

R i Bt B U B TR S

98 .

REHOTE COMMAND MEHO — (MASTER FHI)

Show Pump Status

Feenable a Pump

Shutdown a Pump

Start a Tran=zaction

Set Time (Haster)

Set Date (Haster)

Receipt Header-Footer Menu
Dizplay Accepted Froducts

Hesa (Credit Card Henu not available for this build)

Connect to a Satellite

Enter the command to run (ESC exits):

Polling Report Query

Check on the results of any historical download process by regenerating the Polling

Report. This tool is accessed through the Operations menu.

01/08/2024

3
B
(2N

Operations

System Reports
Go Online with FMUs...
Polling Report Query...
FMU Console

Batch Encoding...
Display a PROKEE Contents

Manual Entry Transaction...
Inventory Editor...
Archive And Restore Transactions...

Transaction Export...

Archive Transactions History Cluery...

Adjust Price Level for Transactions...

FMU Diagnostics..,
Update Dash Odometer Data Sets

View Windows Help

Ctrl+L
Ctrl+Q
Ctrl+F

Ctrl+B
Ctrl+K
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Polling Report Query Engine

Use the engine to select the criteria for the polling report you would like regenerated.
Select 7 Days or 30 Days to narrow your search.

& Polling Report Query Engine = (=]
Download Time Selected Show
|03n 6/2020 08:00:26
C Al
03/19/2020 08:00:26
03/18/2020 08:00:27 C Last7 Days
03/17/2020 08:00:26
03/16/2020 08:00:26 @ Last30 Days

03/15/2020 08:00:26
03/14/2020 08:00:26

— o]

Batch Encoding

Encodes many keys in one sitting without having to open each Vehicle record
individually.

IOperations System Reports View Windows Help

g Go Online with FMUs. . Ctrl+L
Polling Report Query... Ctrl+Q
® FMU Console Chrl+F
Batch Encoding... Ctrl+B
%, Display a PROKEE Contents Ctrl+K

Manual Entry Transaction...
Inventory Editor...

Archive And Restore Transactions...
Transaction Export...

Archive Transactions History Query...
Adjust Price Level for Transactions...

FMU Diagnostics...
Update Dash Odometer Data Sets

FiLink Export

For example, if importing Vehicle or User data from another spreadsheet or database
to FMPIlus, use Batch Encoding to create the large number of keys.

Access the Batch Encoding Tool from Batch Encoding under the Operations menu.
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Batch Encoding Tool

Chapter 14 FuelMaster Tools

Includes four sections: Prokee/Smart Card Type, Vehicle or User Grouping, Records
List, and Encode Status Information.

I@Batch Encoder =G -
Prokee Type Vehicle 1D Description Encode
00000003 2008 FORD F-660 (AIM Trte & -
@ |Vehicle o 00000004 2009 FORD F-760 (AIM Tt Seloct Al
€ TakerTuck ) 00000005 2010 FORD F-650 (AIM Titz
e e Y LE SV
H L
€ Manual Issue 00000008 2010 BUICK LACROSSE (2 s
00000009 2011 CADILLAC DTS (AIM ot
10000000C  Third Vehicle Print Info
WEHED (e 7 00000010 2012 CHEVROLET CAMAF
@ 00000011 2013 CHEVROLET SILVEF
® All Keys 00000012 2014 GMC YLIKON (AIM Tit Qlose
" By Agency | 00000013 2015 CHEVROLET CRUZE
00000014 2016 GMC ACADIA [AIM Ti
 ByOrg | | |200000015 2008 CHEVROLET SILVEF w
ANNANNRT & AANG AUCV/DAL CT CVRn G
Encode Status Information
User Grouping
@
o =]
c =l

Select the type of keys to create and the groupings to encode. The list of records
that match your criteria displays in the list.

Once the matching records display, select the individual records by checking the box
next to the desired record. As records are encoded, the status information changes.
When Encode has been clicked, you have 30 seconds to insert the Prokee/Smart
Card. Once the first key has encoded successfully, the encode process will
automatically start again after you click OK to confirm the encoding of the previous

key.

Manual Entry Transactions

Transactions run in Manual Mode due to dispenser, FuelMaster issues, or possibly
emergency situations, can be entered in FMPlus.

Operations System Reports View Windows Help

o )

®

Q

Go Online with FMUs... Ctrl+L
Polling Report Query... Crl+Q
FMU Console Ctrl+F
Batch Encoding... Ctrl+B
Display a PROKEE Contents Ctri+K

Manual Entry Transaction...
Inventory Editor...

Archive And Restore Transactions...
Transaction Export...

Archive Transactions History Query...

Adjust Price Level for Transactions...

FMU Diagnostics...

Manual Entry transactions contain the same information as a transaction recorded by
the FMU. However, this option cannot be used for Credit Card transactions.
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Access this option via Manual Entry Transaction from the Operations menu.

Manual Entry Transaction List

Chapter 14 FuelMaster Tools

Manage transactions that have not been recorded by an FMU.

Click To MainDB to move the entered transactions into the database. Once
completed, the transactions can be exported and viewed in reports. Manual Entry

ﬁ Manual Entry Transaction List

b= B )

Transaction(s) |

Transaction ID | Site ID | MainDB Saved | TC | Trantime

Add

o

> Close

transactions are only used for Sale transactions.

Manual Entry

The interface contains all the fields required for a manual entry transaction. It is
important to understand that the OK button saves the transaction in a temporary

location.

To move it to the database, you must use Save to MainDB or To MainDB from the
Transactions List.

Trans. ID

A unique number that identifies this transaction while in temporary storage.

01/08/2024

ﬁ Manual Entry Transaction ID: '00001" [NEW]

Trans. ID: 00001

Trans. Code:* l—;l
Vehicle ID:* [ﬁl
Vehicle Desc.: I—
TailNumber: [—
Agency: [—
Odometer: [0—
Job Number:

User ID:* %

Site Information

Site ID:* hd

Site Name: |

Hose: ~ | Grade Pos: ’_LI
Product: ,07 Tank No: ’0_

Prod. Desc. |

Customer ID: hd

-

User Name: |
Quantity: ﬁ
unitCost:  §[0
Total Cost:  $|0.00

Tran. Date: | 4/ 7/2020 ~ P

Tran. 2:09:19 PM —
Record Status: MainDB Unsaved %
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Trans. Code

Defines the type of transaction.

Vehicle ID

Select an existing record in the Vehicle List from a dropdown list.
Vehicle Desc. and Agency

Populated from the selected vehicle record.

Odometer

Current odometer reading of the vehicle that was fueled.

User ID

Can be selected to identify the user who fueled the vehicle.

Site Information

Used to identify site, hose, product and tank from which the fuel was dispensed.
Customer ID

Can be selected to identify the customer.

Update Inventory

Check to set this transaction as one to be deducted from the tank's inventory. This
feature must be used with caution when using TMUs since it can lead to multiple
deductions of the same fuel.

Quantity
Amount of fuel dispensed in the transaction.
Unit Cost

This field is automatically filled when the site and hose fields are selected. It can be
changed if the price has changed since the transaction has taken place.

Total Cost
Calculation is generated automatically based on the Quantity and Unit Cost.
Trans Date & Date

Date/Time the transaction occurred.

Inventory Editor

Allows for the entry and correction of Adjustments, Deliveries, and other tank
inventory data. This is useful for entry of inventory records that occurred in the past
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where other inventory transactions have occurred since. This ability is key to the

Chapter 14 FuelMaster Tools

proper operation of the Fuel Costing and History Ledger reports.

Operations System Reports View Windows Help

3 Go Online with FMUs...
Polling Report Query...
B FMU Console

Batch Encoding...
@, Display a PROKEE Contents

Manual Entry Transaction...

Inventory Editor...

Archive And Restore Transactions...

Transaction Export...

Ctrl+L
Ctrl+Q
Ctrl+F

Ctrl+B
Ctrl+K

Archive Transactions History Query...

Adjust Price Level for Transactions...

FMU Diagnostics...

M
Link Exp

Odometer Data Set

ort

The Inventory Editor is accessed via the Operations menu. This feature is explained
in detail in the Tank Configuration section of Chapter 5.

Inventory Editor Interface

Select the Site and Tank to edit.

To add a delivery or adjustment, refer to Chapter 5, Inventory Editor Section.

ﬁ Inventory Editor

= B

Site:

Start Date:

- Tank:

~| [ Show Running Balances

[3/8/2020 | EndDate: | 4/ 7/2020 |

| Type
Please choose a site

Add...

| Site | Tank

Edit...

| Date & Time | Quantity |

Delete

Closeout | Balance |

Print l

Close

Archive Records

Customers with large quantities of transactions can improve the performance of

FMPIlus by archiving historical transaction information. Archived records are written

to a backup database and are no longer available for reports or exporting.

01/08/2024
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Only archive records no longer needed for reporting or accounting. FuelMaster
recommends records be archived on a yearly basis.

v ® Plus

Operations  System Reports View Windows Help

f2 Go Online with FMUSs. Culel
Poling Report Query CrleQ
» MU Console CrleF
Batch Encoding Cul+8
& Disploy a PROKEE Contents CuleX

Marwsal Entry ransaction
ventory Editor

Archiee Records

Transaction Export

Aschive Transactions History Query
Adpsst Price Leved for Transactions.

FMU DRagnostics

Archive Records Tool

Select the table of transactions to be archived out of the main database from the
dropdown menu.

Using the options below, select criteria to archive by selecting Archive All, Download
Time, or Date and then Archive.

'ﬂﬁ Archive Records EI [=] IEI
Select a table to archive: MainTrans j
Archive:
Earligst Date: 05/20/2015 Latest Drate: 09/16/2022
" Archive Al " Daownload Time

|ogrese0zz 251856 P <

Begin Date: | 5/20/2015 -
End Date: | 941672022 -

Total Records: 15520

Calculate # Hecolds| Archive | Close
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Restore Records

Records may be restored to the main database from an archive database using the

Restore Records Tool.

Chapter 14 FuelMaster Tools

e
B
Q

Operations = System Reports View Windows Help

Go Online with FMUs... Ctrl+L
Polling Report Query... Ctrl+Q
FMU Console Ctrl+F
Batch Encoding... Ctrl+B
Display a Smart Card Contents Ctrl+K

Manual Entry Transaction...
Inventory Editor...

Archive Records...

Restore Records...

Transaction Export...

Archive Transactions History Query...

Adjust Price Level for Transactions...
FMU Diagnostics...

Update Dash Odometer Data Sets
FMLink Export...

Install AIMs on Fleet...

Restore Records Tool

Select the table of records to be restored to the main database from the dropdown

menu.

Using the options below, select criteria to restore by selecting Restore All, Download
Time, or Date and then Restore.

[iﬂ Restore Archived Records

E=RECE =

Restore

Earliest Date: 06/05/2010

Select a table to restore: ID BDStat _:_j

Latest Date: 04/30/5985

" Restore Al $=
I ¥
« Date
BeginDate: | 6/ 5/2010 ~
EndDate: | 4/30/5385 ~
Total Records: 2581846
Calculate # Recmdsl [Tlotel Close
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Archive Transactions History Query

Shows the status of previous transaction archiving activities. Access Archive

Transaction History Query from the Operations Menu.

Chapter 14 FuelMaster Tools

Polling Report Query...

FMU Console

Batch Encoding...

Display a PROKEE Contents

Manual Entry Transaction...
Inventory Editor...

Archive And Restore Transactions...
Transaction Export...

Archive Transactions History Query...

Adjust Price Level for Transactions...

FMU Diagnostics...

Update Dash Odometer Data Sets

Operations System Reports View Windows Help
3 Go Online with FMUs...

Ctrl+L
Ctrl+Q
Ctrl+F

Ctrl+B
Ctrl+K

Archive Transaction Query Engine

Select the Operation Type and choose All History or Last # Operations, or use

Select History Period to specify a range. After clicking View, the history information

appears in the Archive/Restore Transaction History window.

iﬁ.ﬁrcf‘ti\re Transactions History Query Engine

=] B e

Select History To View
(" Select History Period
Operation Type:  |All v Y
® [ Hiton o
- To: 120e
" Last |5 Operations

Archive/Restore Transactions History

INSTRUCTION

** Please Click "View" Button After Making Selection **

01/08/2024
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Adjust Price Level for Transactions

Chapter 14 FuelMaster Tools

Pricing on a particular transaction can change if, for example, an operator forgets to

update the pricing when a delivery has been received or there is an incorrect price

level,

Access Adjust Price Level for Transactions from the Operations Menu.

u

2

aQ

Go Online with FMUs...

Polling Report Query...

FMU Console

Batch Encoding...

Display a PROKEE Contents
Manual Entry Transaction...
Inventory Editor...

Archive And Restore Transactions...

Transaction Export...

Archive Transactions History Query...
Adjust Price Level for Transactions...

FMU Diagnostics...
Update Dash Odometer Data Sets

FMLink Export...

Operations System Reports View Windows Help

Ctri+L
Ctrl+Q
Ctrl+F
Ctrl+B
Ctrl+K

Adjust Transaction Price

Select the Transaction Code from the dropdown box. Set the date range of the
transaction. Choose Tank or Product for Transaction Type. Click View Selected
Transaction. Highlight the desired transactions and click Modify.

T Adjust Transaction Price = B
Transaction Code Transaction Date
Select Code  [00-Vehicle Fuel ~]| Fromr[ 4/ 1/2020 L‘ To: [ 4/ 7/2020 L]
Transaction Type
@ Tank " Product
SitelD Site Name Tank | Pr... | Descript | BaseCost| 1D Descript BaseCost
0001 |Main Fuel Depot 1 1 Unleaded | 1.000
0001 |Main Fuel Depot 2 Diesel 2.000
0001 |Main Fuel Depot 3 63 OilCheck 1.000
0003  |PIE Depot 1 1 Unleaded | 1.000
0003 IPIF Nenot 2 2 Diesel 2.000 M
View Selected Transactions
INSTRUCTION
** please Click "View Selected Transactions" Button After Making Selection **
Update Export
C None
C Al
@ Only pending
Close
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Command Line Setup & Helper

Chapter 14 FuelMaster Tools

One of the FMPlus legacy systems was a DOS-based application that had the ability

to open FMPlus and perform program operations via scripting in DOS. This option

allows customers who had that system maintain their historical operational structure.

Access Command Line Setup & Helper from the System menu.

System Reports View Windows Help
~ Configuration... Ctrl+G

Reconnect to Dial-Up Server...
APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...
Service Configuration...
Operator Options >
Database Utilities >
Database Manager...
Command Line Setup & Helper...
Customizations
Polling Report Configuration
Reset Download Path...

% Command Line Setup & Helper X

[~ [Enable Fuelmaster® Plus Auto Logon without| OK
[Password from Command Line {(-n "OpName")i

Operator Name: | LI Close

Password: ‘

Fuelmaster® Plus Command Line Helper

[¥" Auto Logon with Password {-p "OpName", "Password")
[ Auto Go Online with FMU (-0)
[ Exit Fuelmaster® Plus after Finishing (-e)

Cormmand Line:  |C\ProgramDatalSyntech\FuelMasterPlusiFmPlus exe p '

You can copy the command line above and paste it to Window Task
Scheduler to set a scheduled task for Fuelmaster® Plus.

Command Line Setup Options

Command Line Setup & Helper offers options you can use in Windows Task
Scheduler. Options in the Command Line Helper configure the operations that the

command line will execute.

Auto Logon with Password is used to logon with a specific operator name and

password.

01/08/2024
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Auto Go Online automatically downloads the FMU based on the options configured
and saved in the software.

Database Manager

FMPIlus uses Microsoft SQL Server to store all transaction and configuration data. A
database can be located on the local PC, a shared PC, or on a server. FMPlus can be
configured to point to one database from multiple PCs.

MS Access is only supported for the purpose of conversion to MS SQL Server.

Access Database Manager from the System menu.

System  Reports  View  Windows Help

Configuration... Ctrl+G

Reconnect to Dial-Up Server...

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...

Operator Options ]
Database Utilities ]
Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...

Database Manager Interface

Contains a list of configured databases, their database type, and database path. The
flag icon denotes the current database.

01/08/2024

i Database Manager *
Fuelmaster® Plus Database Mamss
Entry Mame | D atabase Type | D atabase Path | Cert k]
P
& Fuelmaster_Te... MSSEL ENG_TEST12vPMPLUSSAL2014 [ —
A 515 Keyless MSSEL ENG_TEST12vPMPLUSSAL2014 [ Edit>>
Mave Ta s
< 3> Delete
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Creating a new or editing an existing database will expand the current window to
show the database configuration options. For instructions on creating, editing, and
adding a database, see the Fuel/Master Installation Guide.

ﬁ Database Manager 4
Fuelmaster® Plus Database
Entry Name | D atabaze Type | D atabaze Path | Cent
@Fuelmaster_Te... MSSEL ENG_TEST12vMPLUSSOLZo14 [ 4
ENG_TesTizenPLUssoLz01s [l RO
Move Toz»
L4 >

| Cloze

Fuelmaster Fluz DB Type
Fuelmaster® Flus DB Path:

" “windows Auth
S0OL Server Login:
SOL Server Mame

Entry Comnent:

[ Central Ga Orline

Fuelmaster® Plus DB Entry Name:

|51 B Kevless
~

1k

| Browsze. .

{* SOLAuth

|FM_D WHET Pazsward:

[ENG_TEST12\FMPLUSSOL20T4  ODBC DSN: [515_Keyless ODBC

| Operator Password:

[EI

Cancel Edit <<
Save Edit <<

Online Operator: |

Browse allows you to select from all available SQL Servers and databases.

01/08/2024

© Syntech Systems, Inc. 2014-2023

134



FMPlus User Manual
Document Version: 9.0

Reset Download Path

Chapter 14 FuelMaster Tools

The Download Path is typically set up when the database is initially configured. But it
can be changed from this menu or from System > Configuration > DL Service. Stop
the Download Service(s) before changing the Download Path.

:;\“.—

Systern | Reports

View Windows Help

Configuration... Ctrl+G

Reconnect to Dial-Up Server...

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...

Service Configuration...
Operator Options »

Database Utilities »

Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...

The Download Path should be a shared network location accessible to all Download

Services.

System Diagnostics

The System Diagnostics utility detects whether your network is properly configured

for Syntech’s products.

System Reports View Windows Help
¥ Configuration..

Ctrl+G

APM Product Config
Export Configuration...
Report Configuration...
Security Configuration...
Service Configuration...

Operator Options >

Database Utilities >

Database Manager...

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path...

System Diagnostics

Zip Status Files

Among the items checked are servers, |IP addresses, UNC paths, and necessary ports.
If desired, running the utility and sharing the results with CSC may help to

troubleshoot certain issues.
01/08/2024
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i Systern Diagnostics

Fuelmaster® Plus System Diagnoshic Repart

INSTALLED SOL SERVERS:
HHUGHESSOL2019

NUMBER OF RUNNING SOL SERVERS OM THIS MACHINE:1

PING RESULTS FOR SOL SERVER:
Sent ping message to 17216,85.37
Received from 172.16.65.37

Status = 0K

Roundtrip time = 0 milkzeconds

DE Connection 0K,

SOL SERVERS DM THE NETWORK:
D-COSTOJICHYWFMPLUSSOL2013
D-HHUGHES\HHUGHE SSQL2019
D-RCHERRY-TEST2
D-RCHERRY-TEST2\FMPLUSSGL2014
D-RCHERRY-TEST2\FMPLUS50L2013
D-RCHERRY-TEST2ASOL2013
D-RCHERRY-TESTI\FMPLUS5GL2013
D-RCHERRY-TESTAFMPLUSSAL20MS
D-SLOLLAR

D-SRATLEDGENSQL2013
D-TESTINGA/IMNTFMPLUSSAL2014
EMG-DEVSHANE\FMPLUSSOL2019
ENG-TEST30

o

Fink
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Chapter 15 Database Utilities

FMPIlus provides a set of tools to help manage your database size, performance,
record sets, and backups. These tools are collectively known as Database Utilities
and cover a large range of operations and needs. The goal is to make sure the
software performs at the best possible level while at the same time protecting
current and historical data loss or corruption. As a protective measure, FMPlus elicits
a notification upon startup that displays the number of days since the latest backup
and encourages users to backup information soon.

Database Maintenance

Access Database Maintenance from the System > Database Utilities menu.

System Reports View Windows Melp

The following actions can only be performed on the database the software is
currently pointed to in Database Manager. The process box at the bottom of each
dialog displays current progress and messages.
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Delete Records

Some database records have a limited shelf life. For example, a message transaction
from two years ago may not be much use today. Some databases may have
performance issues due to large amounts of data.

Once records are deleted, they cannot be recovered. Deleting is not recommended
without consultation with CSC. Complete record deletion before shrinking the
database.

[ Database Maintenance (=S Ec)

Delete Records | Shink Database | Backup and Restore | Backup and Restore Archive |

Select Records to Delete
Manual Record Count Oldest Record Newest Record
I~ Message Table! 174 12152021 137202143340 Retantast: 105 =] Doys
[~ Zero Trans Table 1 1022022155741 1022022155741 Retanlast: [1055 = Days
¥ Ste Poling Table: 877 21002135308 11/10/2022 Retan Last: 1095 j Days
I Inventory Table: 318175 10152019 1102022 Retanlast: [105 | Doy
™ TMU Nams Table 0 No Record No Record Retan Last: | = o
¥ Orine History Tables 2098 2107202155716 1/10/2022 Retantas: [105 = pays

(& 1
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Shrink Database

After deleting records, database performance may be improved by shrinking the
database and rebuilding indexes. Verify the database to shrink and re-index shows in
the Current Database Information box. Select the checkbox and click Go.

Chapter 15 Database Utilities

a4 Database Maintenance

=] & |

Delete Records | Shnk Database || Backup and Restore | Backup and Restore Archive
Cumrent Database Information

DB Path D-HHUGHES\HHUGHESSQL2019

Size 13377.69 MB

Size Used:  5641.01 MB

Log Size 6656.49 MB

Log Used 1.85"

Operations
¥ Shank Database and Rebuid Indexes
¥ Shrnk Database Transaction Log

Copy Info

Print Info.

Backup and Restore

Verify the database to be backed up or restored shows in the Current Database
Information box. Select the radio button for the appropriate option and enter a

backup file name. Including the type (full, differential) and date in the backup file
name helps select the correct file for restore. Click Go.

01/08/2024

'@ Database Maintenance

=5 ES

Delete Records | Shrink Database | Backip and Restore | Backup and Restore Archive
Current Database Information
Fhhughes-new\fmplussql2022 DB Size: 734331 MB

Type FULL

Server Name:
Database Name:  fuelmaster_ohdot

LastFull Backup:  9/22/2023 13:48:11 LastBackup: 9/22/2023 13:48:11

Configuration

[~ Remote Server r
5 r
Backup/Restore
@ Full Backup (* Diferential Backup ~ (* Differential Restore  ( Full Restore
Backup File Name: ‘ =
Previous Backups:  [53300_TEST2_FULL_20230922BAK
KNIFE_RIVER_FULL_20230802 BAK
Delete

Copynfo

Print Info.
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Backup and Restore Archive

Chapter 15 Database Utilities

Complete the form to restore the archive database. See Backup and Restore for

more information.

@ Database Maintenance

Current Database Information
Server Name
Database Name:  fuelmaster_ohdot ARCHIVE
Last Full Backup

Configuration
[~ Remote Server I

= =]
Backup/Restore

@ Full Backup (" Differential Backup

Fhhughes-new\fmplussql2022

Delete Records | Shrink Database | Backup and Restore |Backup and Restore Archive |

DB Size:
Type

LastBackup:

EETE

(" Differential Restore " Full Restore

Backup File Name: ‘

-

Previous Backups

Delete

2783 MB
UNKNOWN

Copy Info PrintInfo.

Customers with large databases should consider scheduling Shrink Database and

Backup maintenance quarterly.
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Recover Transactions

Chapter 15 Database Utilities

When transactions are downloaded from the FMU, they are copied into a transaction
file before being written to the database. If transactions cannot be found in the
database, they can be recovered from these transaction files.

Access Recover Transactions from the Database Utilities menu.

APM Product Config
Export Confgue stion
Repont Corfiguraton
Security Configuration
Service Configuration
Operatoe Opions
Databurie Uity

Database Manager

Cumionmizations
Poling Repert Conliguration

Reset Download Path

Systemn Reports View Windows Help
N Confguation
Reconnect 10 Dial-Up Server

Comemand Line Setop & Helper

CvieG

>

3
i)

Cormcte

Databane Mantenance
P " :
Fasaaction Lockap.
Moddy Fanactont

Pacover [xport Tarnacton

B0 Trouble Codes
Recover OBD Extended Dota

Recaluiate Lecper Table

Recalouate Floating Ledger Tabie

Recover Transaction

Recover Transaction from Temp File is used to select the file and display the status.
Check Include Inventory Operations to include inventory updates.

% Recover Transactions From Temp File X

Please select a temp file to rescue data from|

Select Temp File

Browse
| Cancel |

[ Include Inventory Operations

The Temp files are stored in a subfolder in the FMPlus download path directory.

Select files using the Browse button.
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Once you have selected the appropriate files, click Open to begin. The status window
will display the progress of the operation and any problems encountered.

Browse for transaction files X

« v P « 51701_New > downloadFiles v ©  Search downloadFile L

New folder = m @O

Organize =

51701_New A Name Date modified
52104_New
52105_new

52200 New

SITECDD1_20181115_111254.tmp 11/15/2018 11:1

| SITEODD1_20181115_120439.tmp 11/15/2018 12:04
SITE0001_20181115_130437.tmp 11/15/201¢
SITE00D1_20181115_140438.tmp 11/15/2018 2:04 P

DO3_59010
v ENG_TEST26
v | 51701_New
downloadFiles
SITE00O1
unprocessed
52104_New
52105_new
52200_New

nAY Ean4n

File name: ~ | Transaction files (*.tmp) ~

TMP filenames include date/time, so you can choose files based on the timeframe
desired. This will recover all transactions from a given online session, so if you are
only missing one transaction out of a download, you may get duplicates. Duplicates
can be cleaned up using several of the tools discussed in the previous chapter.

Transaction Lookup

Transaction Lookup allows you to search for specific manual entry transaction data
that you think is missing.

Access Transaction Lookup from the Database Utilities sub menu.

Symemn  Beperts Veew  Windows Hep
T Confapuron [« L0 -] T
Recomnect by Dail-Up farom ] el

F

AP Product Config
Eapert Configuitan
Fapget Conlsgumamn
St ity O et

Sorvien Conlguet=sn

01/08/2024

Reset Downlcad Path

DR Dt

Blatabase Lilities Oatsbsts Misrtenance
Eanptase Manspts Facower Tiardactiont
Comemgnd Ling Setup & Helpa Tramaction Leckep—
AR AT e Maddy Traraactsn.
Pudlrng Ftpirt Conlagra slszn Fotewis Expeet Tridtideiteons

Ingenit [ltn
Rcower DBD Treubls Codei
Faoover DB Ddended Dats

Facpiculaie Leckper Table
Faocabculae Flaating Ladge Table
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Transaction Lookup Tool

Transactions can be searched by a variety of criteria: Trans Code type, Transaction
Period, last X number of transactions, all transactions, or duplicates only. For

Chapter 15 Database Utilities

duplicates, you can check the High Threshold box to make requirements more easily

met.

Click View Selected Transactions to populate the list box with records matching the

search criteria.

ﬁTransaction Lookup

=] o el

® Select Transactions Period

From: | 4/ 712020 -
To: 4f 712020 -

Select Manual Entry/Duplicated Transactions To View

. . |10-ehiclefUser Fuel -
Man. Trans Code / Tl Last ﬁ

5 Transactions
(" All Transactions

(" Duplicated Trans. [+

View Selected Transactions ‘

INSTRUCTION

** Please Click "View Selected Transactions” Button After Making Selection ™

i -

Transactions in the list box can be selected and deleted using Select All and Delete.

Modify Transactions

Sometimes transaction records can contain incorrect data. The feature is accessed
using the Modify Transactions option under the Database Utilities sub menu.

Systeen Reports View Wiadows Help
N Configuation
Reconnect 10 Dial-Up Sorver
APM Product Conlig
Eaport Configueation
Report Configuration.
Security Configuration
Service Configurstion
Operator Options
Databuse Manager
Comenand Line Setup & Helper
Cumoenizations
Poling Report Conliguration
Reset Downrload Path,

w6 §

Cormote

Databane Mantenance
Farsaction Lookup.
Modty Famacton

Rocove Export Tarsaction.

lerpoat Dats

Recover OBD Trouble Coden
Recover OBD Extended Dota
Recalouiate Ledoer Table
Recalaudate Floating Ledger Tabie

NOTE You can only modify Fleet Only transactions. Credit Card or Prepaid records

are final once they run at the FMU, and cannot be modified using FMPlus.

01/08/2024

© Syntech Systems, Inc. 2014-2023

143



FMPlus User Manual
Document Version: 9.0

Modify Transaction Engine

Chapter 15 Database Utilities

To modify a transaction, define the selection criteria using the Modify Transaction
Engine. Once the list is populated with matching transactions, click Modify to open

the record for editing.

Be very careful using this feature.

E Modify Transaction Engine

= o |

Select Transactions To View

Transaction Code: |00 - Vehicle Fuel

@ Selsct Transactions Period

4112020 - |-
To: 472020 w |

From:

Al Transactions

Wiew Selected Transactions ‘

ﬂ C Last 5 Transactions
,7

Al Modified Transactions

Total
Transactions

__toay |
_ gese |

Close

INSTRUCTION

** Please Click "View Selected Transactions”

Button After Making Selection ™

Modify Transaction

Once a transaction has been chosen for modification, it can be edited using the

modification tool.

Record Status shows whether it has been modified or not. The Modify Critical
Fields and Add/Update to Export Table checkboxes control what can be changed
and where to save the changes when done. However, if the transaction’s agency
does not match the vehicle’s agency, a dialog will appear noting the discrepancy.

Modify Transaction

Trans. Code: W
Vehicle ID:  [00000001 ]
“ehicle Desc lm
Taiurber: [

Agency: l—
Odometer: [0
Job Number: I—
User ID [ccooooo2s  +|
User Name: IW
Quantity: lwi GL
UnitCost: 3 [1.40000009536743

TotalCost: $[eo2

[ Modify Critical Fields

X
Site Information
Site 1D: 0005 v
Site Name: |Rooster
Hose: 1 ¥ | Tank No: [1—
Product: ’17
Prod. Desc ‘Unleaded
Customer 000000001 v
Tran. Date: [107 3201¢ » |~ Record Status:
Trans. Time: IWAM—_ Unmodifisd

Download Date: |10/ 3/201¢ w |—
Download Time: 8:00:32 AM —=—

|v Add/Update to Export Table

01/08/2024
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NOTE A new dialog appears when the Modify Transaction Utility is opened if the
Agency in the Transaction does not match the Agency associated with the
Vehicle record, allowing the Operator to choose the correct Agency.

Certain fields are not normally allowed to be modified for inventory maintenance
reasons. If you decide you would like to edit these fields then you will need to check
the Modify Critical Fields checkbox. However, when modifying these extra fields, the
inventory will not be updated. This allows editing all the information of the
transaction such as the Date/Time, Site ID, and Hose.

Fuelmaster® Plus X

We DON'T recommend that you modify fields related to the
l . site's inventory. Modifying those fields will NOT update the
inventory!

]
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Recover Export Transactions

Chapter 15 Database Utilities

If transactions are misplaced between export from FMPlus and import to another
program, you can recover them from the main transaction table. This re-populates

the export table from the main transaction table. The transactions can then be
manually exported as discussed in Chapter 12.

Systen Reports View Windows Help
R Configusation
E  Reconnect 1o Dial-Up Server

CurieG

Mg G

APM Product Conlig
Expont Configuration,
Repont Conkgurataon
Security Configuration.
Service Configraaton

Operator Options

mm »
Databare Marager

Comenand Line Setup & Helper.

Datatase Martenance

Recover Tansactions

Tansaction Lockup.

Cuttornizations Moddy Tansactions
Poling Report Configra ston Racover Export Tansactions.
Reset Downioad Pk bet .

Impont Dista

Recover 080 Troubde Codes
Recover OBD Extendied Dats
Purc skcrdate Lectger Table
Recakudate Floatng (edger Labke

Access Recover Export Transaction from the Database Utilities sub menu.

Recover Export Transactions Engine

P .
@ Recover Export Transactions From MainDB Engine = \ =) \ﬁ

Close |

Select Transactions to Recover from MainDB to ExportDB
@® Online Time to Specify;

Online Time:

6/10/2016 4:17:48 PM A
6/13/201612:22:34 PM

6/13/2016 1:69:68 PM

6/13/2016 4:48.46 PM

6/14/2016 8:44:27 AM he

(" Range for Online Time

Start Day | 4] 7/2020

End Day: | 4 7/2020

(" Range for Transaction Time

Start Day: | 47 7/2020 .

End Day: 4f 712020 -

" All Transactions
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Recover Export Transactions identifies the transactions to be recovered by
selecting one option:

e Online Time Click the radio button and select an online time by double-
clicking the date and time.

e Range for Online Time Click the radio button and set the beginning and
ending dates.

e Range for Transaction Time Click the radio button and set the beginning
and ending dates.

e All Transactions Click the radio button.

Click Recover to perform the recovery.

01/08/2024 © Syntech Systems, Inc. 2014-2023 147



FMPlus User Manual Appendices
Document Version: 9.0

Appendix A ODBC Connections for Reports

Overview

Due to Microsoft’s depreciation of older security protocols, including those used in
database drivers to connect Crystal Reports to SQL Server, the reports now use
ODBC connectivity. This allows the Crystal Reports used in FuelMaster Plus (FMPIlus)
to utilize a driver that supports Transport Layer Security (TLS) 1.2, the currently
shipping version, and future iterations.

To run the Crystal Reports provided with FMPlus, an ODBC Data Source Name (DSN)
configured to connect to the FMPlus database must be created on each machine
running FMPlus. The DSN must also be set correctly for each corresponding entry in
FMPIlus > System > Database Manager.

Compatibility

This change occurs in SW 5.15.3.0 and greater. It is required for all client platforms.

Configuration

Creating an ODBC DSN for FMPlus on a SQL Server

After installing or upgrading to FMPIlus v5.15.3.0, or greater, create an ODBC DSN
using the ODBC Data Source Administrator utility. To locate, type “ODBC” in the
operating system search field:

Best match

; ODBC Data Sources (64-bit)
»
Apps
PP ODBC Data Sources (64-bit)
% ODBC Data Sources (32-bit) > pe
Search the web
£ ODBC - See web results > = Open
53 Run as administrator
I3 Open file location

5 Pin to Start

= Pin to taskbar

£ obed

Select the Data Sources (ODBC) program, and Run as administrator.
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Click Add...

; ODBC Data Source Administrator (64-bit) X

User DSN  System DSN File DSN Drivers Tracing Connection Pooling  About

User Data Sources:

Name Platform

32/645i
52105_new 32/64bit
52108_New 32/64bit
52200_New 32/64bit
DO3_59010 32/64bit

FMP_Test7_522 32/64bit
Fuelmaster_Test2 32/64bit
Fuelmaster_Test3 32/64bit

An ODBC User data source stores information about how to connect to the indicated data provider. A
User data source is only visible to you and can only be used on this computer.

Driver Add...

SQL Server Native Client 11.0

SQL Server Native Client 11.0 Remove
SQL Server Native Client 11.0

SQL Server Native Client 11.0 Configure...

SQL Server Native Client 11.0
SQL Server Native Client 11.0
SQL Server Native Client 11.0
SQL Server Native Client 11.0

oo | [ [

Appendices

On the Create New Data Source dialog, select ODBC Driver 18 for SQL Server.

Click Finish.

Create Mew Data Source

Select a driver for which you want to set up a data source.

>

Mame

Microsoft Test Driver (*tat; “.csv)
Microsoft Text-Treiber (" tat; *.cav)
QDBC Driver 11 for SQAL Server
QDBC Driver 17 for SAL Server

QDBC Driver 18 for SAL Server
SQL Server
SQL Server Native Client 11.0

B R R R A

<

£ >

< Back

Cancel

01/08/2024
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On the Create a New Data Source to SQL Server dialog, enter the name for your
ODBC DSN, enter Description if desired, and specify the SQL Server by machine

name\SQL instance:

Create a New Data Source to SQL Server

Do SQL Server.
P

SOL Server 2012

This wizard will help you create an ODBC data source that you can use to connect to

What name do you want to use to refer to the data source?

X

Name: [52202_New

How do you want to describe the data source?

Description: I

Which SQL Server do you want to connect to?

Server: IENG_TESTZG\FMPLUSSQLZOHI v I

Next > Cancel Help

database.

NOTE The ODBC DSN can be any name, but if there are multiple databases on a
machine, it may be helpful to give the ODBC DSN the same name as the

Use the ODBC Microsoft SQL Server Setup to test the new connection by clicking

Test Data Source....

ODBC Microsoft SQL Server Setup

A new ODBC data source will be created with the following configuration:

X

Microsoft SQL Server Native Client Version 11.00.5643

Data Source Name: 52202_New

Data Source Description:

Server: ENG_TEST26\FMPLUSSQL2014
Use Integrated Security: Yes

Database: (Default)

Language: (Default)

Data Encryption: No

Trust Server Certificate: No

Muttiple Active Result Sets(MARS): No
Translate Character Data: Yes

Log Long Running Queries: No

Log Driver Statistics: No

Use Regional Settings: No

Use ANSI Quoted Identifiers: Yes

Use ANSI Null, Paddings and Wamings: Yes
Server Service Principle Name(SPN):
Mirror Server Service Principle Name(SPN):

i Test Data Source... 1| oK Cancel

SQL Server ODBC Data Source Test

Test Results

Microsoft SQL Server Native Client Version 11.00.5643

Running connectivity tests...

Attempting connection

Connection established

Verifying option settings

Disconnecting from server

TESTS COMPLETED SUCCESSFULLY!

If the tests fail, check your SQL server machine and instance names. Correct as

needed, and retry connection.
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Setting the ODBC DSN in FMPlus

Before launching Database Manager, if running, stop the Download Service.

[ 4 FM Service Controlle

Service Name Status
FM Download Service Paused

. InstallService i Uninstal Ser\rioel

Options. .. |

Run Service | Stop Service

Launch Database Manager via System > Database Manager. Select the database,
and click Edit>>. On the Edit dialog, enter the ODBC DSN. The dialog Successfully
Edited a FuelMaster Plus Entry! appears when the edits are saved.

Restart the FMPIlus client. Reports may now be run successfully.

01/08/2024

| Fusknaster® Pius Database

Eniry Nasms | Databass Type | Datshase Path [ Carta
L) FMe_514 MESOL ENG-TESTRFMPLUSSOLZMS [ M

Fuemnaster® Plus DB Erty Home:  [FMP_S14

Fuseimastes Phuz DB Type C M5 A
Fusimasber® Phus DB Pathc |

T Windows &uth  SOLAuth

SOL Server Log IFH_DW
SOL Server N |EHI3-T ESTEFMPLUSSGLAM4  ODEC DSH: |FMP_ODEC

Opesshor Paspwond
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Creating an ODBC DSN for FMPlus Remote from SQL Server

When the Client is on a machine remote from the SQL server, there are several
additional steps in the ODBC Data Source utility.

The following steps for creating an ODBC data source are the same as above:

e Launch ODBC Data Source Administrator > Click Add...
e Select SQL Server Native Client 11.0 > Click Finish
e Enter the Data Source Name and Server > Click Next

Additional steps:

Select the authentication type to verify authenticity of the login ID:

Create a New Data Source to SQL Server X

How should SQL Server verify the authenticity of the login ID?

B
)

Bl se (O With Integrated Windows authentication
rver20l.

® With SQL Server authentication using a login ID and password entered by the
~ user.

Login ID: |[FM_Owner

Password: ‘oo'oooo|

T

If using Windows Authentication, the computers must be in the same NT domain.

If using SQL Server authentication, enter the same Login ID and Password as
specified in Database Manager for the database.
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In the dropdown for Change the default database to, select your database name.
Leave other options as defaulted.

Create a New Data Source to SQL Server X
Change the default database to:
2 (52202_New] v]
SOL Server2012 [Mi'm' server: |
SPN for miror server (Optional):
[[] Attach database filename:
Use ANSI quoted identifiers.
Use ANSI nulls, paddings and wamings.
Application intent:
READWRITE v
[[] Mutti-subnet failover.
<o s | | Hor
Click Next.
Accept the defaults on the next screen, and click Finish.
Create a New Data Source to SQL Server X
o [(]Change the language of SQL Server system messages to:
.
aogtr (Default)
L Server 201z

01/08/2024

[[] Use strong encryption for data
Perform translation for character data

[[] Use regional settings when outputting cumency, numbers, dates and times.

[[] save long running queries to the log file:

C:A\Users\Tester'\AppData‘\Local\Temp \QUERY.LO

[[] Log ODBC driver statistics to the log file:

C:\Users\Tester\AppData‘\Local\Temp\STATS.LOC

<Bock || Fnish |

Cancel

Browse

Browse
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At this point, the additional steps are complete, and the ODBC Microsoft SQL Server
Setup dialog presents the summary with the Test Data Source button.

ODBC Microsoft SQL Server Setup

X

A new ODBC data source will be created with the following configuration:

|Data Source Name: 52202_New

|Data Source Description:

|Server: ENG_TEST26\FMPLUSSQL2014
|Use Integrated Security: No

|Database: 52202_New

|Language: (Default)

|Data Encryption: No

| Trust Server Certificate: No

|Muttiple Active Result Sets(MARS): No

| Miror Server:

| Translate Character Data: Yes

|Log Long Running Queries: No

|Log Driver Statistics: No

|Use Regional Settings: No

|Use ANSI Quoted Identifiers: Yes

|Use ANSI Null, Paddings and Wamings: Yes

i Test Data Source... i

[Microsoft SQL Server Native Client Version 11.00.5643

OK

SQL Server ODBC Data Source Test

Test Results

Microsoft SQL Server Native Client Version 11.00.5643
Running connectivity tests...

Attempting connection

Connection established

Verifying option settings

Disconnecting from server

TESTS COMPLETED SUCCESSFULLY!

If the tests fail, check your SQL server machine and instance names. Correct as
needed and retry connection.

Resume with the steps above to set the ODBC DNS in Database Manager:

e If running, stop the Download Service
e Launch System > Database Manager
e Highlight the database > click Edit>>

e Enter the ODBC DSN > click Save Edit<< > click OK on success dialog
e Restart FMPlus > Run Reports

Additional information

Several checks and reminder messages have been provided.

If you launch FMPIlus after installing or upgrading but before adding the ODBC DSN
to Database Manager, this dialog displays:

Fuelmaster® Plus

9' No ODBC DSN has been set. For reports to function in this
’ version, an ODBC DSN must be setup. Would you like to go to
Database Manager to set the DSN now?

01/08/2024
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Clicking Yes will launch Database Manager. The ODBC DSN must be created in the
ODBC Data Source Administrator before the Reports will work.

Clicking No will allow normal client functions except for running Reports. This
message will appear each time you launch FMPIus until the ODBC DSN is set.

This dialog is displayed if the ODBC DSN has not been set and you attempt to launch
a Report:

Fuelmaster® Plus X

o  ERROR: ODBC DSN has not been set. Please set the ODBC
& DSN in Database Manager and please restart your FMPlus

client.

OK |

01/08/2024 © Syntech Systems, Inc. 2014-2023 155



FMPlus User Manual Appendices
Document Version: 9.0

Appendix B Communication Timeouts

Overview

FMPIlus supports configuration of communication timeouts. This feature was added
to support Satellite Cellular Modems, most often used with Passive Mobile Units, but
impacts all communication timeouts. The software has default timeouts for
communication between the SW and the FMU that typically range from 2 to 4
seconds. These default timeouts may be extended up to 6 seconds using the
Configuration > System > Add Comm Timeouts feature.

Compatibility

Communication Timeout configuration requires FuelMaster Plus SW 5.11.3.2 or
greater. For best performance and reliability, FMU FW 3.85a or greater is
recommended.

Configuration

Communication Timeout Configuration

Access the Timeout Configuration via:

e Menus - System > Configuration > System tab, or
e Config Icon - Config > System

ﬁ Configuration E\E@

Infa System ] Hardware I Encoder] DL Service I Firmware I AIM ]

Misc 1: ||— Vehicle Prokee Options Defaults
Misc 2: l— Odometer r [ Cancel
Misc 3: — PIN [ Receipt r
Misc 4: l— User Prokee Options Defaults

oK

) o o
Misc 5: - -
System Key Information:
o 7 Digit Odometer Passive Sys Type
|VEHICLE KEY |

Enabled [ AlM -

System Type: WMN
Allow transaction export v Patch List Timeout |30 (10-1000) Sec.
Require Customer ID i~ Added Comm timeout |5 {0:6) Sec.
Enable Ste Specific Local Authorization [
Allow TMU Deliveries [ Retry Transaction Files |2 (1-10) Times.

Allow TMU Quantities i~

A value of “O” indicates that the SW default timings are sufficient, and no additional

timeout extension is needed.
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Values from “1” to “6” extend the communication timeout up to the specified number
of seconds. A timeout extension of 2 or greater is recommended for Satellite Cellular
Modem communications.

The communication timeout value is applied by clicking OK.
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Appendix C SW Configuration of AIM

Options

Overview

All AIM Options are configured through the software instead of on individual AlMs.

AIM Options

Require User

ID

Fuel with
Engine On

Use Metric
Units

Enable Analog

Counter

Enable FOSS

Disable SVT

Disable
Timeouts

01/08/2024

When the Enable user ID option is active on the FMU, and
Require User ID is enabled on the AIM, user must enter a
user ID at the FMU (either at the keypad or with a user
Prokee) before a transaction can start.

When set, AIM can detect that a fueling tag or
programming hose tag (PHT) is inserted when the engine is
running.

When set, the odometer value is sent to the Central
Controller in kilometers.

When set, counts the low to high transitions on Analog
Channel 1.

Force OBD Sleep Silence. When set, the AIM does not send
any OBD requests to the vehicle when the AIM is asleep.

NOTE Enabling this option without a brown wake up wire
could cause fueling issues

Switch Vehicle Test. When ticked, the switch vehicle test
will not be performed.

NOTE This feature is only supported in AIM2.4s. For more
information see Addendum DEVOI1166_
DEVOI1169_Switch Vehicle.PDF.

When set, sleep timeouts are disabled. The AIM never goes
to sleep.
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Enable FOIOS Force OBD Ignition Off Silence. When set, this prevents the
AIM from sending any OBD requests to the vehicle when
the wakeup wire input is low.

NOTE Enabling this option without a brown wake up wire
could cause fueling issues

Enable GCM Gateway Compatibility Mode. Set to enable compatibility
with certain Intermotive third party devices. This option
cannot be defaulted and is only available via Vehicle
Record. GCM must be set up and configured by Syntech

Systems, Inc.’s CSC.

Configuration

In the software, the AIM Options configurations may be set in two places:

Configuration > AIM > AIM Options Defaults. Settings in Configuration are
applied when new Vehicle records are created with the option automatically
selected on the Vehicle > AIM tab. This Configuration setting does not affect any

existing vehicles.

& Configuration

=)o

Info | System | Hardware | Encoder | DL Senvice | Fimware AIM

AIM Options Defaults

I~ |Require User ID [ Disable Timeouts
[ Fuel With Engine On [~ Enable FOIOS
[~ Use Metric Units

[ Enable Analog Counter

[ Enable FOSS

[ Disable SVT

[~ Print Receipt

[~ Mandatory AIM Completed List Download

[+ Retrieve AIM Vehicle Interface Info Log during oniine session
[*" Retrieve OBD Data Logs during online session

oK
Cancel
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Vehicle List > Vehicle > AIM > Options. The settings in the Vehicle record are sent
via the AIM Programming List to the FMU. When changed in the Vehicle Record,
after the AIM Programming List is resent, Vehicles enumerating at the FMU have
updates to the configuration applied through auto record update.

%si Vehicle ID 00000002 [o] = |
Chrono2 | Chrono3 | OBD Trouble Codes | OBD Statistics | Interface |
General | Products | PROKEE | Mise | Odometer AIM ] Chrona 1 |
Infa Q
AIM 1D: FW Version: |3.18 [V Print Receipt B
Authorized: No Dateln/24/2016 12:06:42 PM
Options Qgpdate
I~ Fuel With Engine On ¥ Use Metric Units Beraa
[ Disable Timeouts [~ Enable FOIOS
[V Disable SVT
[~ Enable FOSS futhorized
Notes ¥ Prokee
1 - Pending verification (4IM FW version not recieved) 2 - Option not supported [~ Al

Status
AIM Program Pending - The AIM vehicle record is enabled and ready to be
programmed .

Additional information

Changes to the AIM’s Advanced Options (AOPT) Command

AOPT options are: Force OBD Sleep Silence (FOSS) and Gateway Compatibility
Mode (GCM). The Allow Firmware Update AOPT option is now permanently
enabled and always allows firmware update even if it was disabled in a previous
version.

AOPT command options are now software-configurable only.

Any options set in AOPT prior to AIM2.4 v2.19 and AIM Titanium v3.21 can no
longer be disabled through the AOPT command, but the AIM can be cleaned to
clear these.

The AIM will grandfather in any already-enabled AOPT options. For example, if
GCM is enabled on a v2.10 AIM2.4 and is then updated to v2.19, the GCM
functionality will be preserved because even though it's not enabled in the
software, it's still enabled in the AOPT command. Since GCM cannot be disabled in
AOPT, the AIM must be cleaned to clear the option.
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Appendix D Dash Odometer for AIM2.4° &
AIM Titanium™

SW v5.19.3.0 / FMU FW v4.04 / AIM2.4 FW v2.18 & AIM Titanium FW v3.19

Overview

Dash Odometer support began in AIM2.4 FW v2.13 & AIM Titanium FW v3.16, with
FMU FW v3.93 and FuelMaster Plus SW v5.9.3.0 for light duty CAN vehicles. This
premium feature detects and automatically captures Dash Odometer for
supported Ford, Chrysler, and GM vehicles in model years 2008 to 2016.

Data Set updates provided with FMU FW v3.98 and FuelMaster Plus SW v5.13.3.0,
add supported vehicles for model year 2017. Some 2018 vehicles will be supported
using model year 2017 data. Future Data Sets will be provided to add newly
supported vehicles and as needed for new model years.

FMU FW v4.04 adds the ability to automatically apply new Data Sets without
having to manually retry at the FMU front panel.

When a vehicle is not supported, standard steps for Derived Odometer calibration
must still be implemented. The Supervisor has the ability on a vehicle by vehicle
basis at the FMU to:

e Reject the Dash Odometer captured and manually calibrate the Derived
Odometer or

e Retry the Dash Odometer detection on a vehicle that is using Derived
Odometer.

The FuelMaster Plus SW shows the Dash Odometer status and odometer method
in the Vehicle record and generates reports on the odometer information.

Compatibility

Dash Odometer requires a minimum of AIM2.4 FW v2.13 or AIM Titanium FW v3.16
with FMU FW v3.93 or greater and FuelMaster Plus SW v5.9.3.0 or greater.

Application of updated Data Set files requires FMU FW v3.98 or greater and
FuelMaster Plus SW v5.13.3.0 or greater.

Automatic retry to apply new Data Sets requires FMU FW v4.04 or greater.
Recommended SW version for FMU FW v4.04 is SW v5.19.3.0.
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Configuration

Installation

Install the software on all Central Controllers. Customers request the Dash
Odometer license key and Dash Odometer Data Set files from Syntech Systems,
Inc., before updating FMUs. The license is generated with KeyGen 5.9.0.3 or
greater.

Upon receipt of the Dash Odometer license, copy the license to a location
accessible from FuelMaster Plus, such as the \\Program Files
(x86)\Syntech\FuelMasterPlus directory.

Copy the Dash Odometer files to a location accessible from FuelMaster Plus. You
will be asked to browse to the data set file location when the license is applied in
System > Customizations in FMPlus or when data set updates are applied via
Operations > Update Dash Odometer Data Sets.

B4 Fodmaster® Plus

Fde Tables Operstions System Reports View Windows Hep

-> 22  Go Onfine with FMUs Carlel
Vervoe Pollng Report Query CuieQ |

R MU Comsole Cerdef

Batch Encoding Cvi+B

€, Duplay » PROKEE Contents CideX

Manual Entry Transaction
Inventory EdRoe

Archive And Restore Transactions
Tansaction Expont

Archive Teansactions Hastoey Query
Adpust Price Level for Transactions

FMU Diagnostics
Card Defintion Impont
Update Dash Odometer Data Sets

Dash Odometer Set Up

The FMU uses the Vehicle VIN to determine whether the Vehicle supports Dash
Odometer. If the VIN indicates Dash Odometer is supported, the vehicle’s dash
odometer capture is attempted. At any time, from the FMU front panel, the
Supervisor can reject Dash Odometer and use Derived Odometer. Odometer
information is passed through the AIM to the FMU which passes the information to
the SW.

If the Dash Odometer capture is unsuccessful, the Vehicle uses Derived Odometer
and requires manual calibration. If Dash Odometer is supported for this vehicle in
the future, using the Supervisor Key at the FMU front panel, the Dash Odometer
detection can be run again.

After FMUs are updated, update AIM2.4s and AIM Titaniums. Automatic FW
Updates are supported.
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Software Support for Dash Odometer

The FuelMaster Plus SW manages the Data Sets for Dash Odometer, tracking when
to send or update them to the FMUs. The Vehicle Record > Odometer tab displays
the Dash Odometer status and odometer method. The SW also supports
generating reports to show vehicle odometer Information.

Data Set File Management

The Data Set files provide information to determine if the VIN is supported for
Dash Odometer and are provided to the customer with the Dash Odometer license
and when Data Set updates occur.

Initial Implementation

On initial implementation, when the license is added in System > Customizations,
the Data Set files may be sent automatically to each FMU in the system. Click Add
File...,, browse to the location where the Dash Odometer Data Set files were saved,
and click Select Folder.

Select Directory With Data Set Files... X
<« “ 4 = » ThisPC » Documents » v O Search Documents 2
Organize « New folder S
J 3D Objects 2 Mame : Date modified Type

Con V-ENGT12 SOL Server Management Studie  4/15/2020 11:41 AM  File falder

I Desktop Visual Studio 2010 8/28/2018 3:44 PM File folder

= Documents
4 Downloads
EonV-ENGT18
H on V-ENGT18
J’! Music
&=/ Pictures
TonV-ENGT18
m Videos
Y on V-ENGT18
‘i Local Disk (C:)

- Local Disk (D) v £ >

Folder: | Documents

Select Folder Cancel

NOTE Always browse to the location where the Data Set files were saved by the
customer, even if the “dataset” folder in the download path already exists.
Pointing to the “dataset” folder in the download path results in an error
and does not provide the ability to automatically send the Dash Odometer
data set files to the FMUs.

A dialog opens to select the location of the Dash Odometer Data Set files.

If the selected location does not contain the files, a dialog allows a second try.
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Fuelmaster® Plus

{ v , Unable to find the dash odometer files. Do you want to try
again?

When the Dash Odometer Data Set files are found, SW copies them to the
Download Path in a folder named “datasets”. The next dialog offers to go online
and update all FMUs.

Fuelmaster® Plus

. Would you like to automatically go online with all your FMUs
to update them for Dash Odometer support?

If Yes is selected, an Online session is initiated and the three Dash Odometer Data
Set files are transferred to each FMU and placed on the compact flash card in the
“aim_dash_odom?” folder.

If No is selected, focus returns to the Customizations dialog and shows the Dash
Odometer license. Site Configuration updates and Online sessions verify the Dash
Odometer Data Set files existence and version and, when necessary, transfer
appropriate Dash Odometer Data Set files to the FMUs.

The SW verifies the Dash Odometer Data Set files exist and are the correct
version:

¢ When a Site Configuration is uploaded
e When a Manual Download is initiated and
e When an Auto Download is run.

Polling Report Summary Site details and Status Logs indicate when Dash
Odometer Data Set files are current or have been uploaded successfully and
verified.

When Dash Odometer Data Set files exist on the FMU, but Dash Odometer
customization is not enabled for the database, SW removes the Data Set files from
the FMU.
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Data Set Updates

When updated data sets are provided, copy the files to a location accessible from
FuelMaster Plus; for example, the PC’s Documents folder.

To access Operations > Update Dash Odometer Data Sets, the Dash Odometer
customization must be enabled, and the operator must have the permission for
“Send/Receive Programming and Update List” under System > Operator Options >
List Management > [User] > AIM.

When selected, the Dash Odometer Data Sets dialog displays showing the three
Data Set files and their package version.

B Dash Odometer Data Sets =N =R
—Current Versions
OEM Lookup File: 1
Data Set ID Lookup File: 1
Data Set List File: 1

Close |

Click Update to browse to the folder where the Data Set files reside.
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Select Directory With Data Set Files.., X
4+ |5 » ThisPC » Documents » v O Search Documents o

Organize « New folder = - o

4 Downloads A Name Date modified Type

+
5] Documents + datasets File folder
o+

&= Pictures SQL Server Management Studio File folder

51701_New Visual Studio 2010
52105_new

Fhoward

File folder

FuelMasterPlus
@ OneDrive

[ This PC
B 30 Objects
Con V-ENGT18
I Desktop

|=] Documents e =

Folder: | datasets

Appendices

If the selected location does not contain the files, a dialog allows a second try.
When the Dash Odometer Data Set files are found, SW updates the files in the
Download Path folder named “datasets”. The next dialog offers to go online and

update all FMUs.

Fuelmaster® Plus

to update them for Dash Odometer support?

................................

.................................

Would you like to automatically go online with all your FMUs

No

If No is selected, focus returns to the Dash Odometer Data Set dialog. Site

Configuration updates and Online sessions verify the Dash Odometer Data Set files
existence and version and, when necessary, transfer appropriate Dash Odometer

Data Set files to the FMUs.
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Dash Odometer Status in the Vehicle Record

For AIM vehicles, the Dash Odometer latest status and odometer method displays
on the Vehicle > Odometer tab.

G5 Vehicle ID 00000669 o] & ==
Chrono2 | Chrono3 | OBD Trouble Codes | OBD Statistics | Intedface |
General | Products” | PROKEE | Msc ~ Odometer | AM | Chvono1 | Lo |
Encode
Current Odometer: 0]
Date Odometer Read:  5/20/2019 11:54:53 _Beissue |
AM
Fuel Range 350 Expected Efficiency  [50
Dash Odometer:  Dash odometer cumently being captured Cancel
Odometer Method: Absolute
[” Preventive Maintenance Authorized
PM Range: 3000 PM Netfication [250 : :::‘ee
Next PM Reading |0

Dash Odometer Reports

Reports > Vehicle > Vehicle report has been extended to show the history of
Dash Odometer status when the AIM info box is checked on the report dialog.

B Vehicle Reports by Vehicle Information E\ =l @

D lﬂ.gency] Crganization I |Jsage I

Vehicle 1D ~ | [ Select Al View Report
DODDO0O01
DO00000Z Prirt Report
LELLLLTE]

DOD00004

DO00000S Save Az

2 """""" > Cloze

~S.n-Nsn J—

12:00:00 AM
I” Page Breaks
W AIM Info.
-
=
W Cost Information
-

|

Select vehicles individually or check the Select All box to View Report, Print
Report or Save the report.
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The report may also be run by Agency, Organization, or Usage using the
appropriate report tabs.

Fuel Depot
Canton, NC 28716

Fuelmaster Vehicle Report by Vehicle ID

Pagz 1 of 2

Date: 6222016 Time: $:12:25AM

Vehicle ID: 00000054

Vehicle ID: 00000054

Description 2013 JEEP CHER.OKEE (AIM 2.4) Upgrade

Customer ID Q00000001 Testers R Us

:\gmc;,-‘ i Encoded Falze
Organization

Usage Authorized  True

Vehicle Year 2013 Kev Option

Reports > Vehicle > Vehicle Odometer Status Report categorizes vehicles by
Dash Odometer status.

Fuel Depot
Canton, NC 28716

Fuelmaster Vehicle Odometer Status Report

Page 1 of 2

Date: 6222016 Time: 8:17:00AM

Vehicle ID: Description Status Data Odom Year Make Model
Dash odometer currently being captured

00000066 2016 JEEP PATRIOT & 6/13/2016 9:24:25AM 18,227 2016 JEEP PATRIOT
00000067 2016 JEEP PATRIOT T 6162016 E:19:07AM 19,571 2016  JEEP PATRIOT

[

Total Vehicles with Dash odometer currently being captured

This report covers all Dash Odometer statuses:

e Dash odometer currently being captured

e Couldn’t find dash odometer using specified data

e Couldn’t find dash odometer on new model year vehicle
¢ No dash odometer data set for vehicle

e Dash odometer capture not tried yet

e User Rejected dash odometer
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Dash Odometer Status

Status TRANTIME

Dash odometer currently being captured 6/6/2016 10:23:12AM
Dash edometer currently being captursd 6/32016 9:01:43AM
Dash edometer currently being captursd 6/8/2016 11:18:24AM
Dash edometer currently being captursd 682016 2:33:34PM

Select vehicles individually or check the Select All box to View Report, Print
Report or Save the report.

The report may also be run by Agency, Organization, or Usage using the
appropriate report tabs.
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FMU Operations for Dash Odometer

AIM Record Programming with Supported VINs

The FMU allows record programming of the AIM unless a Dash Odometer attempt
is pending.

Clean as

r_ normal

AIM CONFIG MENU:
1=PROGRAM, 2=CLEAN

\

1-Program Record

AIM w/ PHT
found?

ERROR: CANNOT PROGRAM AIM RECORD. N Criteria met to allow AIM
DASH ODOMETER CAPTURE ATTEMPT PENDING. [ NO programming?

T
5 second delay

TURN VEHICLE ON, WAIT 30s, THEN TURN
VEHICLE OFF. TRY PROGRAMMING AIM AGAIN.

Yes

v

AIM programming AIM record
allows proceeding to next programming proceeds
menu? as normal

D - Exit or timeout Yis

VID: 12345678
1=0DOMETER 2=CHRONOMETER D=EXIT

If a Dash Odometer supported VIN fails to meet the programming criteria, the FMU
notifies the Supervisor that the AIM record cannot be programmed because a
Dash Odometer capture attempt is pending. After 5 seconds, the FMU prompts
the Supervisor to turn the vehicle on, wait 30 seconds, turn the vehicle off, and
then try programming the AIM again.

Accepting Dash Odometer

Dash Odometer functionality is found on the Vehicle Record screen. To get to this
screen, insert the Supervisor Prokee at the FMU, navigate to the AIM Configuration
Menu, and select PROGRAM. Enter a new Vehicle ID or confirm that the Vehicle ID
is correct and currently assigned to the AIM. Once an AIM with a Dash Odometer
supported VIN is programmed successfully, the FMU displays the Vehicle Record
screen, as seen below:
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VID:12345678
1=0DOMETER 2=CHRONOMETER D=EXIT

The Vehicle Record screen for a Dash Odometer supported VIN shows the
standard options: I=ODOMETER, 2=CHRONOMETER, and D=EXIT. Selecting the
ODOMETER option shows the Vehicle ID and an Odometer number in miles
labeled as *DASH* (denoting the odometer is a Dash Odometer) with the options
to 1=ACCEPT ODOM or 2=REJECT ODOM as seen below:

VID:12345678 1=ACCEPT ODOM
ODOM:123456789.1mi *DASH* 2=REJECT ODOM

If ACCEPT ODOM is selected, the vehicle is configured for Dash Odometer and the
FMU returns to the Vehicle Record screen.
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Rejecting Dash Odometer

If the Supervisor selects REJECT ODOM, the Reject Dash Odometer workflow
commences:

VID:12345678 1=ACCEPT ODOM
ODOM:123456789.1m1 *DASH* 2=REJECT ODOM

|
2 - Reject Odom

N - User cancels or timeout
|

A SMALL VARIATION FROM VEHICLE DASH IS
NORMAL. PROCEED ONLY IF NECESSARY!

5-second delay

[ODOM:123456789.1mi] - IF REJECTED, ODOM
MUST BE MANUALLY CALIBRATED. REJECT Y/N?

1
User selects 'N'

DASH ODOMETER VALUE WILL BE RETAINED

User selects 'Y’

D - Cancel or timeout

PLEASE START ENGINE. D=CANCEL
PRESS 'Y' WHEN ENGINE IS ON.

Y - Engine is on

ATTEMPTING TO SWITCH TO A DERIVED ODOM:
COMMUNICATING WITH AIM...

ENGINE NOT RUNNING.
UNABLE TO SWITCH TO DERIVED ODOMETER.

Done

UNABLE TO SWITCH TO DERIVED ODOMETER. No Force derived
DASH ODOMETER VALUE WILL BE RETAINED. < succesful?

Yes, odom is now derived

SUCCESSFULLY SWITCHED TO DERIVED ODOM.
PLEASE CALIBRATE ODOMETER NOW.

In the REJECT ODOM workflow, the Supervisor confirms the intention to revert
back to Derived Odometer by pressing Y or continues with Dash Odometer by
pressing N. Next, the Supervisor is asked to start the engine and press Y when it is
on. Once the FMU is aware that the engine is on, it communicates with the AIM
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and attempts to switch to a Derived Odometer. If the engine is not running during
the attempt to switch to Derived Odometer, the Supervisor is prompted to start
the engine and notify the FMU by pressing Y. If the attempt to switch to Derived
Odometer is unsuccessful, the Dash Odometer method and value remain
unchanged on the AIM. Once the attempt to switch to Derived Odometer is
successful, the Supervisor is notified by the FMU and asked to calibrate the
odometer. At this point, the Supervisor follows the normal odometer calibration
process. After the odometer is calibrated, the FMU returns to the Vehicle Record
screen.

Manual Option to Retry Dash Odometer

For AIMs on light duty OBD CAN vehicles currently using Derived Odometer, the
Supervisor has the option to retry capturing the Dash Odometer. Navigate to the
Derived Odom screen by selecting ODOMETER on the Vehicle Record screen. The
FMU shows a Derived Odometer screen as seen below:

VID:12345678 1=ACCEPT ODOM
ODOM:10645.3mi *DERIVED* 2=CFG ODOM

On the Derived Odometer screen, the Supervisor can select ACCEPT ODOM to
accept the current odometer number and return to the Vehicle Record screen. To
retry Dash Odometer, the Supervisor selects the CFG ODOM option to go to the
Configure Odom screen as seen below:

VID:12345678 ODOM:10645.3mi
1=CALIBRATE, 2=RETRY DASH ODOM D=EXIT
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If the Supervisor selects RETRY DASH ODOM, the manual Retry Dash Odometer
workflow commences as seen below:

VID: 12345678 1=ACCEPT ODOM
ODOM:10645.3mi *DERIVED* 2=CFG ODOM

2 - Configure Odom D - Exit or timeout

VID: 12345678 ODOM: 10645.3mi
1=CALIBRATE, 2=RETRY DASH ODOM D=EXIT

2 - Retry dash odom

Is VIN
Yes available?

No

v

VIN NOT REPORTED FROM VEHICLE
UNABLE TO RETRY DASH ODOMETER CAPTURE.

D - Cancel
or timeout

PLEASE START ENGINE. D=CANCEL
PRESS 'Y' WHEN ENGINE IS ON.

Y - Engine is on

ATTEMPTING DASH ODOMETER CAPTURE:
COMMUNICATING WITH AIM...

Data set found? No J»| NO DATA SET FOUND FOR VEHICLE.
UNABLE TO RETRY DASH ODOMETER CAPTURE.

—> ENGINE NOT RUNNING.
i UNABLE TO RETRY DASH ODOMETER CAPTURE.

Done

Retry No P» DASH ODOMETER RETRY FAILED.
successful? ODOMETER WILL REMAIN DERIVED.

SUCCESSFULLY SWITCHED TO DASH ODOMETER.
PLEASE CONFIRM ODOM VALUE IS CORRECT.

Yei\\\\*~__________________—f”/"
In the manual Retry Dash Odom workflow, the FMU confirms the availability of the
VIN. If the VIN is not available, the FMU notifies the Supervisor that the dash
odometer cannot be captured and returns to the Configure Odom screen. Once
the availability of the VIN is confirmed by the FMU, the Supervisor is prompted to
start the engine and press Y to confirm when the engine is on. When the
Supervisor confirms that the engine is running, the FMU communicates with the
AIM and attempts to capture the Dash Odometer. If the engine is not running
during the attempt to switch to Dash Odometer, the Supervisor is prompted to
start the engine and notify the FMU by pressing Y. If the data set for the vehicle is

not found, the FMU notifies the Supervisor and returns to the Configure Odom
screen. If the Dash Odometer retry fails, the FMU notifies the Supervisor that the
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Dash Odometer retry failed, retains the current derived odometer value, and
returns to the Configure Odom screen. When the Dash Odometer retry is
successful, the FMU notifies the Supervisor that the Derived Odometer has
switched to Dash Odometer and that the odometer value should be confirmed.
After a few seconds, the FMU returns to the Vehicle Record screen.

Automatic Option to Retry Dash Odometer

Beginning with FMU FW v4.04, the FMU can automatically retry implementation of
Dash Odometer. The following conditions must be met:

e The Dash Odometer Status indicates the FMU previously did a VIN lookup
for Dash Odometer, but the vehicle is using derived
e The AIM’s dash odometer package version is lower than the FMU’s package

version
e The updated data set must be different from the previous data set that was
rejected
NOTE If Dash Odometer was rejected in a previous FMU version,

automatic retry will not occur.

If the above conditions are met, the FMU performs a VIN lookup and attempts to
retrieve a data set. If the data set is found, and is different from the data set
already tried on the AIM, the FMU sends the new data set files to the AIM. The next
time the vehicle engine starts the AIM attempts the retry. Results of the retry are
reported the next time the AIM enumerates. If a data set is not found, the AIM’s
dash odometer package version is updated, and the odometer will remain derived.
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Appendix E MultiPoint Download Service

Overview

The Multipoint Download Service (MPDS) runs as an application and supports
multiple services on different machines. Only one service can be installed per
Central Controller. With MPDS, a regular user can start manual and automatic
downloads as part of the FMPIlus software application.

The date and timestamp on servers and clients must be synchronized to prevent
issues with launching scheduled downloads, Archived Messages, and Polling
Reports.

Compatibility
e SQL Server 2008 R2 and greater, including Windows 10 workstations

Installation

MPDS Installation

After the software and database are installed, FMPlus prompts the user to start the
Download Service. Select Yes to install and start the download service.

If the user selects No, the Download Service Is Not Running dialog shows at
every start-up, unless the Never ask me again box is checked.

Download Service Is Mot Running

FM Download Service is not running.  Would you like to try starting it now?

[ Newver ask me again
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At any point in the program, the user can start the FM Download Service by
selecting Service Configuration from the System menu.

s System Reports View Windows Help

r " Configuration. Cul+G &
. Reconnect to Dial-Up Server ’_‘.

APM Product Config

Export Configuration...

Report Configuration...

Security Configuration...

Service Configuration...

Operator Options >
Database Utilities

Database Manager

Command Line Setup & Helper...
Customizations

Polling Report Configuration
Reset Download Path

FM Service Controller has multiple Service Controls:

e Install Service

e Uninstall Service
e Run Service

e Stop Service

#i FM Service Controller X
Service Name [ Status |
FM Download Service Not Installed

Install Service ‘ . Uninstall Service |

Options...
Run Service ‘ Stop Service
NOTE The Options button does not affect the Download Service functions.

Configuration
The System > Configuration > DL Service tab provides the following options:

e Always start FM Download Service when loading FuelMaster -Starts the
download service automatically on each login to FMPIlus.

e Display autodownload polling report on this computer - Displays the
Polling Report after each auto-download if the report is set to launch
automatically in the Polling Report Configuration.

01/08/2024 © Syntech Systems, Inc. 2014-2023 177



FMPIlus User Manual Appendices
Document Version: 9.0

To verify the Show on Screen setting, select Polling Report Configuration from the
System menu.

Eﬁ Polling Report Configuration E' [=] @
Select the Save as ...Polling Report File Type
File Type : [Text for ASCII ~|
Iv ShowonSaeen [ Auto Print [V Message Transaction Report
¥ Print Header v Cdometer High/Low Messages
Normal Report ¥ Hose into Auto/Manual Messages

[V Fuel Site Summary Report v Odometer Update Message
IV Costing Errars Report [V PM Warning Messages
[¥ Transaction with No Vehide Number [¥ Gate Messages
Iv Semi4vanual Transaction Report ¥ SemiManual Enabled/Disabled
IV Zero Quantity Transaction Report ¥ Mabile Transaction Markers
IV Pawer Fail Report ¥ Hose Shutdown/Re-Enabled
[V TMU Alarm Report ¥ Door Messages
¥ Pump Prices Report |v Car Wash Messages

v Terminal shutdown

W Daily Quantity Limit

Cancel

NOTE If Show on Screen is unchecked, the Polling Report does not
launch automatically even if Display auto download polling report
on this computer is checked. Selecting the Show on Screen for
periodic downloads with a high frequency is not recommended as
this will consume system resources.

e Force starting Download Service as normal.exe - Runs the
FM Download Service as an executable. When checked, the
‘Start.exe now’ and ‘Stop .exe now’ controls become active.
This mode should only be used if recommended by Syntech
Systems, Inc.’s CSC.

e Data Logger Options - Location a user selects to store the
Data Logger files after download.

NOTE If the data logger files have not been downloaded in quite a while, the
card may contain too much data for the system to download. It may be
necessary to power down the FMU and replace the SD card.

Operations

MPDS Operations

Launch the Online client by clicking the Online icon on the FMPlus toolbar, or
select Go Online with FMUs from the Operations menu.

There are four tabs on the FuelMaster® Plus Download Service Client:

e Archived Messages
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e Service Requests
e Auto Download
e Manual Download

Manual Download - select different sites by checking the box next to the site or
select all sites by checking the Select All box. Each manual download request is
shown on the Service Requests tab.

S - =

S EFUELMAS TER

enoinEERED BY SUNEECH
Archived Messages Service Requests  Auto Download

Configure Download Options For Sites

[ select

Denwnlaad Optisns
[#] Download Passive Mabile Transactions (¥ Download Transactions
o] THAL Tnterface [¥] Send Pricing
[7] Batch Report [¥] Download OBD Data Logs
|#| Download Data Logger Files |o] Vehicle Lockeout List
[#] User Lockin List [¥] Prepaid List
|#| Discount Credit Card List o] Kyless List

- [¥] Local Auth Accepted Account List ¥ Local &uth Lockin List

Elo0L2  Middle Left [#] Local Auth Lockeut List | Butten Config List
0003 Bottom Left 9] AIM2 Brogramming List 9] AIMZ Lock List

EiO0ML Top Middle
Elpom2  Middle Middle
DOM3  Bottom Middle

Eigopm  Passive Mabile
["J00R1  Right Top
Elo0R2  Middle Right .

Connect

Review and set the download options. Click Connect.

Cancel a Manual Download by clicking Disconnect or by clicking Stop on the
Service Requests tab.
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Auto Download - Schedule a download for a future date and time by setting the
Schedule Auto Download options.

 FuelMaster(R) Plus Download Service Client

o>
S EUELMASTER

enoiNEERED BY SUNEECH

Archived Messages Service Requests [EWGEMSUNIERE Manual Download

[ o |

Configure Download Options For Sites

Schedule not set

Schedule

[ select Al

[Fooc1  Chris' first desk site = Download Options

[#ooC2 Chris’ second desk site Download Passive Mobile Transactions Download Transactions

R TMU Interface Send Pricing

[7100D1  Desk Site 1 [T Batch Report Download OBD Data Logs
|¥l00D2  Desk Site 2 Download Data Logger Files Vehicle Lockout List
o0/ Jeannie Pie Box = User Lockin List Prepaid List

Discount Credit Card List Keyless List

00L1 Top Left Local Auth Accepted Account List Local Auth Lockin List

ooz Middle Left Lacal Auth Lockout List [7] Butten Config List

Fi AIM2 Programming List AIM2 Lock List

[#looL3  Bottom Left g 9

[#oom1 Top Middle

[Floomz  Middle Middle

[¥loom3  Bottom Middle

[¥looPM  Passive Mabile

[#loor1  Right Top

[#loorz  Middle Right .

Schedule Auto Download ;

Frequency |OneTime | Start Date | 5/15/2014 StartTime | 1:10 PM %3

Frequency

e One time - Select start date and time for single download.

e Daily - Select start time for downloads.

e Weekly - Select start time and days of the week for downloads to occur.

e Periodically - Select start time and frequency for recurring downloads.

NOTE

The frequency of periodic download determines when a download occurs
in relation to the start of the previous download. If the first download is
scheduled for 1:00 and the frequency is set to 1 hour, the next download
will be scheduled for 2:00. If the duration of a single download exceeds
the download frequency, the next download still begins immediately.

Click the Schedule button.

The Auto Download screen stays read-only until the download schedule is
completed. The Remove Schedule option completely removes the current auto

download schedule.

NOTE Daily, Weekly and Periodic Downloads continue until the scheduled
download is removed.
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Selecting Disconnect or Remove Schedule may not immediately halt the
download. The download service needs to perform post processing on each site
that was being processed and this may take more than a few moments depending
on the current stage of the download.

The STOP button is not available for recurring Auto Downloads, i.e., Daily, Weekly,
and Periodically. It works for Manual and One Time Downloads.

Review the download in progress with the Status Logger. The Status Logger
reflects downloads processing for the Manual and Auto Downloads. To open the
Status Logger, from the View menu, select Show Log DB Data. The Status
Logger automatically launches when a Manual Download starts.

' Status Logger [F=3 =R =X
Select Sites To Filter [ Select All - = ‘ [ %

Timestamp Site Id Status

5/15/2014 5:03:24 PM 00c1 Creating Equipment Usage Exception DB...

5/15/2014 5:03:24 PM 00C1 Trying to mark equipment usage exceptions...

5/15/2014 5:03:24 PM 00C1 Generating AIM PM Warnings

5/15/2014 5:03:24 PM 0oci Completed generating AIM PM Warnings

5/15/2014 5:03:24 PM ooc1 Done processing data...

5/15/2014 5:03:24 PM 0oct Trying to delete temp transactions...

5/15/2014 5:03:24 PM 0oci Done deleting temp transactions.

5/15/2014 5:03:24 PM 0oci Deleting DOME Inventoryload items

5/15/2014 5:03:24 PM 00C1 Deleted Completed InventoryLoad items

5/15/2014 5:03:24 PM 00C1 Moving Message Transactions

5/15/2014 5:03:24 PM 00c1 Finished Moving Message Transactions

5/15/2014 5:03:24 PM 0oci **POST PROCESSING COMPLETED FOR SITE ID 00C1 - End Time 17:03:24 05/15/14

5/15/2014 5:03:25 PM 0oci FIMAL time:17:03:24 05/15/14

5/15/2014 5:03:25 PM 00C1 “*7END OF STATUS REPORT™**

m L3 :

The top bar of the Status Logger provides a filter for sites to display, as well as,
the ability to export the content of the logger to a file or clear the screen.

The Status Log DB Data logs all messages from every download and should not
be left open unless it is being actively monitored.
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Service Requests - This option reflects the pending download information.

4
S EUELMASTER

enoINEERED BY SUNEECH
Archived Messages Auto Download  Manual Download

7 5 Sort B
Pending Download Service Reguests
Reguest Date Message Type Site Information Status

5/15/2014 45429 PM  MANUAL DOWNLOAD INPROCESS

Archived Messages - the Archived Message tab reflects the status of the Service
Requests.

COMPLETED View Log File 5/15/2014 5:03:.24 PM
COMPLETED View Log File 5/15/2014 5:03:.24 PM

Double-clicking on a Download Service Request will launch the Detailed Message
Status for Message for the selected request.
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j Download_00C1.sta - Motepad EI@

File Edit Format View Help

Creating Transload table -
Creating Inventory Load table

Creating TransMessage table

Creating TransZero table

Creating Gradeconfig table
populating Gradeconfig table

Creating PPCCreditBackLoad table

#%SESSTON FOR DATABASE ENTRY: [FMP_Keyless]
DB Path: wvml'sglexpress

Database Custom Type:

System Type

Discount Credit Cards

Prepaid Cards

Local authorization Accounts

Local authorization Lock

single Button Dispenser Configuration
Try1ng to delete temp transactions...

pone deleting temp transactions.
Pregenerating lists...

successfully Created Required Patch Lists
Done trying to build lists

m

Trying to connect to: Site: Chris' first desk site '00C1' attempt:1l
Local time at this attempt:17:39:39 05,/12/14

LAN Connection

IP:

connect to site 00C1 on 05/12/14 17:39:39 connection type LAN
Trying to initialize sockets for networked communications...
sockets initialized ok

Setup

setup

Connecting to ip:

Trying to LOGIN...

LOGIN successful

starting FTP session...

Trying To start Active FTP session...

Started Active FTP session successfully

CONNECTED

Trying to match Site Names...

4 3

To view the status log files for the selected download, click the View Log Files.
This opens in a text file that contains the download information for the selected
site.
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Download Service Status

To view the Download Service status, click View > List Download Services.

5 View Windows Help
v Toolbar

ad Status Bar -

v Search Bar

v

Flat Toolbar
Tree View
Status Output

Show Log DB Data
List Download Services

This displays the download services registered with the database and their current
status. The Master Service is noted in the Comments column.

The Status column displays if a service is RUNNING or STOPPED.

i) » t B
I Service ID I Service Name I Workstation Name | Status l Last Updated Version Comments
1 1lefccalf-7f82-4eec... C:\Program Files (x86... ENG_TEST12 RUNNING 09/17/2019 14:59:22  5.20.0.16 Master Service,
2 3649b16-26ca-4f0... C:\Program Files (x86... ENG-TEST6 RUNNING 09/17/2019 14:59:23  5.20.0.16
3 ef6ff2b6-ccf7-40f2-... C:\Program Files (x86... ENG_TEST26 RUNNING 09/17/2019 14:59:12  5.20.0.16
< >
Global Purge | View Comments | l Close |

If the Status is listed as RUNNING, but has not responded for 10 minutes it will be
highlighted in yellow; the Status will change to INDETERMINATE and turn red.

e Yellow - means the service was not shut down properly or is not
communicating with the database.

¢ Red - means the service has not been communicating with the database
for more than 2 days.

[E=H[ROE|— >

Comments |

Timestamp not updated in the last 10 minutes. Status could not be determined
Master Service,

—

If any of the above occurs, you should:

e Check to see if the workstation crashed or rebooted.
e Go to System > Service Configuration and check the status of the
service.
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e If the service is RUNNING, check to see if the workstation has network
access and is communicating with the database.

e |If the service is not RUNNING, restart the Service from the Service
Configuration dialog.

e A system reboot might be necessary if the service does not restart.

The Last Updated column displays the last time the service registered with the
database.

The Remove Service button (bottom right of screen) can be used to remove the
service from the Download Service List, unless the service is running.

NOTE Remove Service does not uninstall the selected service; it removes
the listing. If the service restarts or reconnects, it displays in the
Download Service List.

Global Purge requires the operator permission Edit Communication Queue. Use
this function when both the Connect and Disconnect buttons are grayed out on
the Manual Download tab.

Troubleshooting

Connection Lost:

e |If FMPIlus losses connection with the database at any point during the
download, the Download Service Client and Status Logger should be restarted
after the database connection is restored. If not, the download may appear to
be in progress or stalled even after it has continued or completed processing.

e |f the services appear to be running slowly or not at all, check the following:

o Make sure that the SQL Service is running on the server.
o Make sure the Download Path is accessible or that it is not full.

e Check FMPIlus, under View > List Download Service:

o If a Download Service Status is RUNNING and the timestamp is within the
last minute, the service is still active and available for processing.

o If a Download Service Status is STOPPED, then the service has been
correctly stopped from its workstation. This occurs if the service was
stopped through the FMPIlus Service Configuration, Windows Services, or if
the machine has been properly shut down. You can start the Download
Service from the appropriate workstation.

o |If a Download Service Status is INDETERMINATE, that service’s status is
unknown. It means the service was not shut down properly or is not
communicating with the database. This may be due to:
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=  The workstation unexpectedly crashing
= A loss of network communication

. If the service is listed as RUNNING in FMPlus System > Service
Configuration, check whether the workstation has network access and can
communicate with the database. If the service is not RUNNING, restart it

from Service Configuration.

e A system reboot may be necessary if the service does not restart.
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Appendix F Managing FMU Settings

Overview

FuelMaster Plus® software (FMPIlus) now supports managing many of the FMU Settings
via the Site Configuration uploads and downloads. The feature is accessed on the Site
dialog. Granting Site permissions to “Manage FMU FW” activates the Advanced
button. The FMU Settings dialog shows tabs for the Master FMU and each of its
Satellites. Settings may be reviewed and changed on these tabs. Once the site
configuration is uploaded to the FMU, these settings are applied each time the FMU
reboots.

Compatibility

Managing FMU Settings via SW requires FMPlus SW v5.21.3.0 and FMU FW 3.95 or
greater.

FMPIlus SW v5.21.3.0 and FMU FW v3.98 or greater are recommended for automated
FMPIlus updates, which may be used in conjunction with this feature. Contact Syntech
Systems, Inc.’s CSC for information on automated upgrades.

E Operator Name: ADMIN b
Tanker Truck ] AlM ] Card Owners ] Service Corfiguration ] ADOC ]
General ] Operator & Security ] System & Operations
Site l Transactions ] Superviser & Manual lssue ] Vehicle ] User ]
[ Ste [v Tank W Unit
v Add v Add WV Add
[v Delete [v Delete [V Delete
¥ Edit [v Delivery W Edit
V¥ TMU I Adjustment v Upload/Download Corfig
[~ Manage FMU FW [V Invertory Transfer

[v Stick Reading
[V Set Closeout
[v¥ Enable Pricing Per Tank

Select Al | Deselect Al |

Delete | Select Al | Deselect Al Set Password | oK | Cancel

Configuration

Installation

The Managing FMU Settings feature installs with FMPlus. Upgrade the SW on all Central
Controllers.
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Permissions

The Advanced button on the Site dialog is grayed out until an operator is granted
“Manage FMU FW” permission in System > List Maintenance > Operator List >
[select operator] > Site. This permission is not defaulted for any user.

NOTE Do not enable the Advanced button until all FMU’s have at least FMU
FW v3.95.

Managing FMU Settings Via SW

Once the permission is applied, on the Site dialog, click the Advanced button to launch
the FMU Settings dialog.

Populating FMU Settings

If FMU Settings is opened before FMUs have been added to the site, a message says
“No FMUs have been created for this site.” Create the site before returning to FMU
Settings.

Fuelmaster® Plus >
l L Mo FiUs have been created for this site.

For existing units, a Configuration download is required to retrieve current FMU
settings. If the feature has not been activated, the first tab says, “You must download
the FMU Configuration before editing Firmware settings.”

If the Master FMU has Satellites, there will also be a tab for each satellite. Each tab will
show this message until the configuration is download for the Master and each
Satellite.

NOTE When CSC has done automatic upgrading, the FMU Settings are
populated and the initial site configuration download is not needed.
The dialog will open ready to use.
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All FMU Settings upload with the site configuration which takes effect on the next FMU
reboot.

ﬁUmr?L" ) Site 0001 i_'_él_;' 2

Site Name: | Main Fue! Depot
FMU: [Master -0 _v| FMU Name: [ Main Fuel Depot

Hose(s) I
ol @ = |
Pu..
A MECHAl _. oo
B 2 [mecnd| St 0001
R MECHA| Site Name: |Main Fuel Depot
D |4  |MECHA Selected FMUs —
E |5 |MECHA
% [V Master -0 UPLOAD: 10/08/19 14:27:49 DOWNLOAD: Never Synched

Ad I I satelite-1 NO UNIT

I satelite-2 NO UNIT

~ModemHours | To ™ Satellite-3 NO UNIT

aegin:|0 valid [T Satelite-4 NO UNIT
L E"d,:,,l, 24 |Messagll | ™ satelite-5 NO UNIT
LastUpload: | 10/8/2019|| | [ Satelite-6 NOUNIT
I Satelite-7 nO UNIT

_oniee ||
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Editing FMU Settings

After permissions have been set and FMU Settings have been downloaded,
click the Advanced button to open the dialog:

FMU Settings: SITE: 0001
MASTER FMU |
Settings VYalue
E [22_main_prompt_message] -
** FuelMaster FUELS ACCOUNTING SYSTEM **
line2 ** INSERT KEY, HOLD 1 SECOND TO BEGIM =
E [38_site_signature]
SITE SIGNATURE FFFE
B [42_misc_id_prompt]
MISC ID PROMPT ENTER USER ID —>
B [44 receipt_header message]
line1 FUELMASTER

line2
line3
line4
E [46_receipt_footer_message]
line1 THANK YOU! HAVE A NICE DAY!
line2
line3
line4
= [48_wehicle_id_prompt]
VEHICLE ID PROMPT ENTER VEHICLE ID —> ﬂ

Main Prompt Line 1 (Max 40 characters)

Once uploaded to the FMU, these settings wil be applied each time the FMU reboots. | oK Cancel

Values are changed in a variety of ways: prompts may be edited, dropdowns provide
ENABLED/DISABLED or other valid selections for many values, and some values are
not available until the associated feature is enabled. The description box at the bottom
of the settings list gives additional information about the highlighted setting.

Some settings, like System Type and Site Signature, are restricted and cannot be
enabled or changed. Some settings are only enabled for certain system types.
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When a setting changes, it is bolded to make it easy to find changes during the

current session. However, if you leave the dialog and don’t send the changes, changes

for those values are retained but not bolded when the FMU Setting dialog reopens.

FMU Settings: SITE: 0001
MASTER FMU |
Settings Value
E [22_main_prompt_message] -
line1 ** FuelMaster FUELS ACCOUNTING SYSTEM **
line2 * INSERT KEY, HOLD 1 SECOND TO BEGIN **
E [38_site_signature]
SITE SIGNATURE FFFE
E [42_misc_id_prompt]
MISC ID PROMPT ENTER DRIVER ID
B [44_receipt_header_message]
line1 FLIELMASTER
line2
lined
E [46_receipt_footer message]
line 1 THANK YOU! HAVE A NICE DAY!
line2
line3
lined
= [48_wehicle_id_prompt]
VEHICLE ID PROMPT ENTER BUS ID LI
line3
Receipt Header Line 3 (Max 27 characters)
IOm:e uploaded to the FMU, these settings wil be applied each time the FMU reboots. | ok | cancl
NOTE Section 54, pump mode and status, have values for each pump but unused

pump locations are empty (blank). When changing a pump location from a
valid value to empty, there is no visible indication of the change.
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If a value has a dropdown, it must be used to set the value. Some drop-downs have

multiple choices.

ﬁ Site Lint S Féﬂ:t,g_l
sﬁmmr-x-:! [aT e

MASTER FMU |

- Setings | Value
PUMP G 1.00 ;,
PUMP H 1.00

{8 [59_system_options_1)
AUTO ACTIVATE SINGLE PUMP DISABLED

— CONFIRM PROKEE/SMARTCARD 10 DISABLED

DISPLAY PUMP PRICING DISABLED

EIU PROKEE/SMARTCARD WHICH KEYS VEH & USER KEY
ENTERED USER IDs ARE
ENTERED VEHICLE IDs ARE

MODEM CONNECT UPPER SPEED LIMIT

REAL GATE TXN DISABLED
SEMI MANUAL MODE DISABLED
SHOW PROKEE/SMARTCARD ID DISABLED
SYSTEM INPUT TYPE VMN - VEH KEY
TWO RELAYS PER PUMP DISABLED
8 [Sa_tank_monitor_options]
DAILY TMU INVENTORY DISABLED
TANK MONITOR INTERFACE ENABLED
TMU BAUDRATE 9600 ~l
EIU PROKEE/SMARTCARD WHICH KEYS
What type of key to accept for EIU?
lOnce uploaded to the FMU, these settings wil be appled each time the FMU reboots. | o< |  caxe |
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Other sections, like Tank Monitor, must be enabled before related values can be set.

-

FMU Settings: SITE: 000

+

MASTER FMU |

Settings Walue
EIU PROKEE/SMARTCARD WHICH KEYS WEH & USER KEY ;I
ENTERED USER IDs ARE NUMERIC
ENTERED VEHICLE IDg ARE NUMERIC
MODEM COMMECT UPPER SPEED LIMIT MAXIMUM
REAL GATE TxN DISABLED
SEMI MANUAL MODE DISABLED
SHOW PROKEE/SMARTCARD ID DISABLED
SYSTEM INPUT TYPE WYMN - VEH.KEY
TWO RELAYS PER PUMP DISABLED J
[5a_tank_monitor_options]
DAILY TMU INVENTORY DISABLED
TANK MONITOR INTERFACE EMNABLED -
TMU BAUDRATE 5600
TMU DATA FORMAT TE1
TMU MANUFACTURER WR TLS-300
[5b_receipt_printer_options]
ALLOW 20.00 FOR FLEET PRICING DISABLED
PEDESTAL RCPT PAPER CUT FULL
PRINT DOLLAR FOR FLEET RECEIPTS DISABLED

TANK MONITOR INTERFACE
Enable Tank Monitor

Once uploaded to the FMU, these settings wil be appled each time the FMU reboots. |

OK

Cancel

Sending FMU Settings

When all settings have been adjusted, select Site > Site List > [select Site] > FMU >

Online > [select Master and Satellites] > Upload.

The uploaded settings take effect on FMUs reboots.
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Appendix G MPDS Online Client Permissions

Overview

The Multipoint Download Service (MPDS) Online client supports role-based rights for
Auto Downloads beginning with FMPlus SW v5.20.3.0. Manual Download functions
are controlled by the individual operator’s permissions. This expands FMPIlus’
permission capabilities. For example, it allows giving operators the ability to upload
lists when they don’t have permissions to download transactions.

Compatibility
This feature is supported in FMPlus SW v5.20.3.0 and greater. It was tested with FMU

FW v4.05 and v4.06 but does not have firmware dependencies.

Configuration

Installation

Install SW v5.20.3.0 or greater on all FMPlus Central Controllers.

Permissions and Location

Operators with System > Operator Options > List Maintenance > se/ect Operator >
Operator & Security > Edit rights can modify permissions for the Auto Download
role and set permissions for Manual Download by individual operator.

E Operator Mame: TESTER

Site ] Transactions
Tanker Tuck | AIM
General

[ Operator

[~ Add

[v Edi

[~ Delete

[ Unlock

[ Authorize/Unauthorize

] Superviser & Manual Issue ] Wehicle ] |ser
] Card Owners ] Service Corfiguration ] ADOC
Operator & Security System & Operations

[ Securty Corfiguration

Pt

l
l
l
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With Edit rights, click System > Operator Options > Auto Download Options.

B4 Fueimaster® Plus
Fille EdtTet Tables Opersticns System Reports View Windows Help

- o ® o S Configuration... Ctrle G b4
Vehicle  User Ste Track Reconnect to Dial-Up Server. Aot

b

APM Product Config
Export Configuration...
Report Configuration...
Secunty Configuration..

Service Configuration...
Operator Options > List Maintenance..

Change Password.

Database Utiitres >
Database Manager.. Re-login...

Auto Downdoad Options...
Command Line Setup & Melper.

Customezatsons
Polling Report Configuration
Reset Download Path.

Auto Download Roles

Launch Auto Download Options to set Auto Download roles for all Operators.

Auto Download Options >

Select options for Auto Download operators
¥ Download Transactions
I+ Send Pricing
[+ Send Authorization Lists
I+ Credit Card Batch Report

I Send Discount List
[+ Send Prepaid List

¥ TMU Interface
I Download Data Logger

Iv Send Firmware

Deselect Al oK Cancel

These permissions supersede those set for individual operators and apply to all
automatic downloads.
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Every time you leave the Auto Download Options dialog, you are reminded that Auto
Download needs to be rescheduled for changes to take effect.

Fuelmaster® Plus hod

For changes to take effect, autodownload needs to be
! . rescheduled,

When a role is unchecked, even when previously selected, the option on the Online
client is unchecked and grayed out.

Auto Download Options >
Select options for Auto Download operators
[ Download Transactions
Iv¥ Send Pricing
Iv Send Authorization Lists
[ Credit Card Batch Report
Iv Send Discount List

Iv¥ Send Prepaid List

[ TMU Interface
| Download Data Logger

Select all Deselect All QK | Cancel
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“ FuelMaster(R) Plus Download Service Client

45
S UELMASTER

enoiINEERED BY SUNEECH

Archived Messages Service Requests ENGEBGITGIGEGE Manual Download

{1 Select All
[¥looo
Cloooz
[looo3
Clooos
[Jooos  PIE
["looos

Main Fuel Depot
Auxiliary Fuel Depot
Master of Satellites

Passive Maobile Site

Four Key

Schedule Auto Download

Frequency | One Time h

Schedule not set
Schedule

Configure Download Options For Sites

53]

Start Date | 9/6/2019

Download Options
Download Passive Mobile Transactions
TMU Interface
Batch Report
[[] Vehicle Lockout List
[] Prepaid List
[] Local Auth Accepted Account List
[[] Local Auth Lockout List
[] AIM Lock List
Upload AIM Firmware Image File

Stert Time | 240 AM [~

Download Transactions
[] Send Pricing
Download Data Logger Files
[] User Lockin List
[] Discount Credit Card List
[] Local Auth Lockin List
[] AIM Programming List
Upload Firmware Image File

Remove Schedule

These changes take effect on the next online session.

Operators without Edit rights see the menu option grayed out.

Fa Fuelmaster® Plus

File EdaTet Tobles Operstions System Reports View Windows Help

- @ % Configuation ?  ®
Vehide  User e Inack Reconnect to Dial-Up Server... oot Ext

APM Product Config
Export Configuratior
Operator Optsons > t Mante ¢
D se Utilities > Change Passwoed...
Database Manage Re-login...
Customzations
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These operators can launch the Online client and see the Auto Download tab. All
functions are grayed out, but the Site list can be scrolled to see selected Sites.

! FuelMaster(R) Plus Download Service Client -

4
S EUELMASTER

eNnciNEERED BY SUNEECH
Archived Messages Service Requests ENGEBGTUNGESLE Manual Download

[m]

X

Configure Download Options For Sites

Upload AIM Firmware Image File
0007  Park Avenue

0008 Cumberland Pass

0002  Imaginary Way

0010  Four Paints Way

0011  Sisowtobell Lane

0012 Long & Winding Road -

Schedule Auto Download

Frequency Weekly Start Time | 11:10 AM : E‘

Recurring Download scheduled

Select Days

/| Monday | Tuesday | Wednesday | Thursday | Friday Saturday Sunday
Schedule Stop Remowve Schedule

Select All
Y0001 Main Fuel Depot 2 Download Options
- | Download Passive Mobile Transactions |+ Download Transactions

0002  Auxiliary Fuel Depot TMU Interface Send Pricing

P - § Batch Report Download Data Logger Files
0003 Master of Satellites Vehicle Lockout List User Lockin List
0004 Passive Mobile Site Prepaid List Discount Credit Card List

~ Local Auth Accepted Account List Local Auth Lockin List

0005 PIE Local Auth Lockout List AIM Programming List
0006 Four Key AIM Lock List Upload Firmware Image File
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Manual Download Operations

Appendices

Operators with Operator > Edit rights can modify the permissions for individual

operators.

E Operator Mame: TESTER

Site ] Transactions ] Superviser & Manual lssue ] Wehicle ] Iser
Tanker Truck ] AlM ] Card Owners ] Service Configuration ] ADOC
General ] Operator & Security System & Operations

[ Configuration v Cnline [ Products

[ System [ Saye Onling Settings: [ Add

[ Modem [ Nomal Download F Delete

[ Encoder [ Auto Download 7 gﬁ Piics

||: 'E'lm [+ Send Pricing it Pricing

port .
™ Auto Export [v Send Authorzation [ Add Features
l_ Report [ Credit Card Batch Report I Delete Features

i [v Send Discount List
[ Poling Report
e [+ Send Prepaid List
| Fead Keys [ TMU Interface
[ FMU Console [ Session Status Options

[ Polling Report Gue
- Hepu?ts P o [ Download Data Logger

[ Command Line Setup & He|per|_ Edit Communication Cusue
[ Import Data [ Send Firmware
[ Import Card Definitions

Select Al | Deselect.ﬁ.ll|

Delete | Select Al | Deselect Al Set Password | QK | Cancel
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When permissions are removed, the permission box is unchecked and grayed out.

' FuelMaster(R) Plus Download Service Client _ 0 X

a»
TS ELUELMASTER

e~noiNEsrEo sy SUNEECH
Archived Messages Service Requests Auto Download JEERUERRGITGES]

Configure Download Options For Sites

[ Select All
[+]0001  Main Fuel Depot Downlaad Options
Download Passive Mobile Transactions Download Transactions

[CJoooz Auxiliary Fuel Depot TMU Interface Send Pricing

. Batch Report Download Data Logger Files
(0003 Master of Satellites Vehicle Lockout List [+#] User Lockin List
[[Jo004  Passive Mobile Site [] Prepaid List ["] Discount Credit Card List

[] Local Auth Accepted Account List [[] Local Auth Lockin List

[Cooos  PiE [ Local Auth Lockout List [] AIM Programming List
[10006 Four Key [J AIM Lock List Upload Firmware Image File

Upload AlIM Firmware Image File

i

Changes take effect on the next online session.

Prior to SW v5.20.3.0, download options were handled globally based on system

ces

type. Now, except for modified permissions, each operator’s Online client selections
are maintained separately and are selected when that operator logs on and accesses

the Online client.
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Appendix | Glossary of Terms, Abbreviations
& Acronyms

The following are definitions for the terms and acronyms used in FMPIlus. This list is
meant to provide explanation for the most common terms referenced and referred to
in this manual.

Administrator: Computer network profile with full permissions/rights; needed to
install or uninstall the FMPlus software.

Agency (User Record): Code identifying the agency the user belongs to. Can be up
to seven alphanumeric characters (lower level than Department).

Agency (Vehicle Record): Code identifying the agency the vehicle belongs to. Can
be up to five alphanumeric characters (higher level than Organization).

Automotive Mode: FMU operational mode that requires an authorized Prokee
/Smart Card and/or verifiable ID, or AIM for dispensing fuel.

Automotive Information Module (AIM): The FMPlus 3000 System component
mounted in a vehicle. It contains vehicle specific information, captures vehicle
odometer information; integrated dispenser-nozzle mounted RF/ID Tags. Transmits
this information to an FMU.

Batch Report: Downloads a report containing credit card end of day settlement
information.

Blended Tanks: Virtual tank created in FMPlus database by withdrawing specified
percentage from two real tanks.

Central Controller: A Windows-compatible PC set-up for operation of FMPlus. Also
references the main operator of the software.

Com Port: Serial port on PC used for connecting peripheral devices such as modems.

Customer ID: Up to nine alphanumeric characters entered to identify a specific
customer.

Deauthorize: Removes vehicle/user/customer authorization to access dispenser with
Prokee, but maintains vehicle/user/customer record in database (see also Delete).

Delete (vehicle/user/customer/site): Deletes vehicle/user/customer/site record
from database (see also Deauthorize). Not recommended as all record history is lost.

Delivery: Fuel drop into a designated tank recorded in FMPlus database.

Department (User Record): Code identifying the department the user belongs to.
Can be up to six alphanumeric characters (higher level than Agency).

Discount Card: Credit card that receives a specific discounted price level.

01/08/2024 © Syntech Systems, Inc. 2014-2023 201



FMPlus User Manual Appendices
Document Version: 9.0

Dispenser: Fuel or oil dispensing unit located on a service island and possessing one
or more dispensing hoses.

Div/Ratio: Setting (1:1 - 9999:1) programmed into the FMU that determines the
number of pulses required to count one product unit (i.e.,, 10:1 pulser produces 10
pulses for every unit).

Dynamic IP address: Utilizing the Dynamic Host Configuration Protocol (DHCP) IP
addresses are assigned by the computer. Dynamic IP addresses can be different each
time you log onto the network and can even change while logged on. FuelMaster
recommends utilizing Static IP’s.

Either Key: Describes an operation requiring use of either a Vehicle Key, user key or
both keys to access an FMU. Part of the COM system key type.

Electronic Dispenser: Dispenser controlled by an electronic computer as opposed to
a mechanical dispenser which has no on-board processor.

Encoding: Process by which information is transferred to memory in a Prokee/Smart
Card.

Encryption: Process whereby data, such as credit card numbers, are translated into a
secure format. Encryption key is needed to translate data back into the original data
format.

Equipment Interface Unit (EIU): FMPlus equipment used with a Master FMU for
remote access to gates, car washes and doors.

Export: Procedure for transferring transaction database data to an ASCI| file.
Exported transaction data is removed from transaction database.

Fixed site: Site with one or more ground-mounted FMUs.

Fuel Island: Location where FMUs and dispensers are positioned for easy access by a
vehicle. See Service Island.

FuelMaster® Plus (FMPIlus): Registered name of the Syntech Systems, Inc., Fuel
Management System.

Fuel Management Unit (FMU): System component located on the service or fuel
island that receives key inputs and activates dispensers. Performs other functions
dependent upon whether FMU is a Master or a Satellite (See MFMU and SFMU).

Grade Position: Electronic dispenser setting per pump for grade positions.

Internal Key Number: Sequential number assigned to each encoded Prokee/Smart
Card.

IP Address (Internet Protocol): 32-bit numeric address of a computer on a TCP/IP
network. Used for routing data packets on a network.

Inventory: Quantity of product in a storage tank at any given time.
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Julian Date Rollover Hour: Hour of day (0-24) programmed into the FMU that
determines when the next accounting day begins.

Key: Prokee or Smart Card.

Manual Mode: FMU Operational mode that bypasses FMU control. Used to test the
operational status of the dispenser independently of the FMU. When the FMU is in
this mode, no fueling or accounting data is recorded.

Manual Issue Key: Utility Prokee used to issue products to non-key holders. Key
contains no restrictions on product types, and has a default transaction limit of 250
gallons.

Master Fuel Management Unit (MFMU): System component located on service
island that receives key inputs, activates dispensers, and communicates with Satellite
FMUs. Sends Master and Satellite data to the Central Controller.

Max Prod Allot: Maximum product allowed to be dispensed in a 24-hour period.
Exceeding this amount can be reported on the Polling Report as an exception.

Mechanical Dispenser: Dispenser with a mechanical meter reset.

Message Duration Time Out: Time limit (1-10 seconds) sets length of time messages
display on the LCD. Does not apply to all messages/displays.

Mobile Automated Site (M site): Mobile Tanker Trucks equipped with FMU for
recording transaction data; can download transaction data to a fixed FMU.

Mobile Non-Automated Site (L site): Mobile Tanker Trucks not equipped with an
FMU. Transaction data must be manually recorded for later manual entry.

MPD: Multi-Product Dispenser, an electronic dispenser capable of dispensing more
than one product type from a single hose.

NIC: Network Interface Controller

No-Pulse Timeout Setting (NPT): (5-255 seconds) programmed into the FMU to
determine when a transaction terminates if a product is not dispensed after a
dispenser hose is activated.

OBD: On Board Diagnostic computer installed in most automobiles and trucks since
1996. The AIM is able to interface to the OBD computer via the OBD port on almost
all vehicle types outfitted with an OBD computer. Most on-board computers use one
of several communications protocols which can be read by the AIM.

Onsite printer: Serial communication printer that is hardwired into the FMU and
prints FMU transactions and activity.

Organization (Vehicle Record): Code identifying the organization the vehicle
belongs to. Can be up to three alphanumeric characters (lower level than Agency).

PHL: Pump handle setting
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PIN: Last four digits of Prokee Internal Number

PIE Address: Fuel pump number designated in the dispenser, FMU and FMPlus
database for use with electronic dispenser operation.

PIE Box: Equipment used for data communication between the FMU and electronic
dispenser.

PM: Preventive maintenance
Polling Report: Configurable report that shows status of downloaded transactions.

Port number: Logical endpoint to a connection in a computer network for
client/server communication.

Prepaid Card: Encoded Prokee\Smart Card with a Prepaid amount that is
recalculated each time it is used at the FMU.

Price Level: Level of pricing per unit or product. Set by customer, tank or product.

Prokee: Registered name for access keys to the FMU, which come in six types: AIM
Programmer, Vehicle, User, Truck, Manual Issue and Supervisor.

PTO: Power Take Off - the ability of certain vehicles to power auxiliary devices from
the vehicle's engine, often used with the vehicle not in motion.

Pulser: Dispenser device that transmits cost and volume of product dispensed to
FMU.

Pump: Dispenser.

Pump Finish Time Out (PFT): Time period (5-800 seconds) programmed into the
FMU that determines when a dispenser hose is automatically turned off after product
is dispensed. Timer begins once FMU stops registering pulses.

Pump Handle: Switch located on dispenser; also referred to as Pump Reset Switch.
Setting in FMU configuration, which tells FMU when to look for pulses; if Start or
Start/End is selected, pump handle switch must be activated before FMU looks for
pulses.

Receipt printer: Optional device added to FMU that prints a receipt after dispensing
transactions.

Re-Encode: Procedure for encoding a re-issued key.

Re-lIssue: Procedure for re-authorizing a key record that was previously de-
authorized. Permits a key to be encoded with the same key record information.

RF: Radio Frequency - the ability to communicate without wires using radio waves of
various frequencies.

Restore: Procedure for returning archived data to a database.
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Satellite Fuel Management Unit (SFMU): System component located on service
island that receives key inputs, activates dispensers, and relays transaction data
through the MFMU(s).

Server computer: A machine that runs a service available on the network.

Service Island: Location where FMUs and dispensers are positioned for easy access
by a vehicle.

Servicing Site: Term to describe the location of the service island(s) and station
house.

Site Signature: Computer generated security number that is unigue to an
organization’s FMU, database and all associated Prokee/Smart Cards and/or AIMs.

Smart Card: Access card for fueling at an FMU which uses a smart chip programmed
with customer specific information. May be used instead of Prokees.

Static IP Address: Fixed IP addresses assigned by the network administrator.
STS: Abbreviation for Syntech Systems, Inc.

Supervisor Key: Utility Prokee used to configure FMUs, perform servicing site
troubleshooting and system diagnostic tests, to issue products to non-key holders, to
update product quantity in FMU memory, and to extract on-site reports.

Syntech: Syntech Systems, Inc.

System Key Type: FMPlus and FMU mode of operation. Each type explained in detail
in Chapter 1.

Tanker Truck Key: Utility Prokee used by a mobile Tanker Truck driver to fill a
Tanker Truck from an FMU-controlled dispenser.

Tanker Truck: Truck with fuel storage tank for taking fuel to remote fueling locations;
may be automated with attached FMU, or non-automated which requires manual
entry of each transaction.

TMU: Tank Monitor Unit.

Transaction: Action that updates FMU memory either as the result of product
dispensing or through manual entry of information.

Transaction Limit: Amount of fuel that is allowable per transaction. Cannot exceed
this limit.

Transaction Code (TC): 2-character code used to distinguish types of transactions.

Two Key: Describes operation-requiring use of both a Vehicle Key and user key to
access an FMU.

Unit of Issue (UD): Unit of measure for products; designated by two letters (i.e., GL
for gallons, QT for quarts, etc.).

01/08/2024 © Syntech Systems, Inc. 2014-2023 205



FMPlus User Manual Appendices
Document Version: 9.0

Update (Prokee): Requires key to perform update. Changes information contained
on the key; not necessary to upload information to FMU after update.

USB Port: Universal Serial Bus port on the computer.

User ID: Up to 9 alphanumeric characters entered to identify a specific user.
User Key: Prokee assigned to a User.

Utility Key: A Supervisor, a Manual Issue, or a Tanker Truck key.

Valid Key Time Out: Time limit (5-255 seconds). Time allowed before terminating a
transaction if no dispenser hose is selected after Prokee insertion.

Vehicle Key: Prokee assigned to a vehicle and used to fuel through an FMU.
Vehicle ID: Up to 8 alphanumeric characters entered to identify a specific vehicle.

Zero Quantity Shutdown No: Setting (1-50) determines the number of zero-quantity
transactions that may be recorded before shutting down a dispenser. Prevents
continued use of system if FMU is not recording transaction information (i.e.,
defective pulser or other issues).
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